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About This Guide

This volume of the i2 Analyst’s Notebook 8 User Guide introduces you to some of 
the basic features of Analyst’s Notebook.

Intended audience

This guide is intended for users who have a basic knowledge of computers 
including the Microsoft Windows interface and use of the mouse. If you are not 
familiar with the Microsoft Windows environment, we recommend that you read the 
documentation relevant to that environment.

License and installation

This guide assumes that you have a licensed copy of Analyst’s Notebook installed 
on your computer.

Book structure

This guide contains the following chapters:

Getting Started

Provides a brief overview of Analyst’s Notebook. It also describes how to use the 
documentation and how to work through the examples in this guide.

Chapter 1, Introducing Some Basic Features

Introduces the basic features of Analyst’s Notebook.

Chapter 2, Handling Chart Items

Contains a worked example that describes further features that can be used when 
adding information to a chart.
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Chapter 3, Adding Cards and Attributes

Describes how to add cards and attributes to chart items.

Chapter 4, Combining Charts and OLE Objects

Shows how you can incorporate one chart into another and add OLE objects to a 
chart.

Chapter 5, Merging and Navigating Charts

Shows how you can merge more than one chart into one chart and explains how to 
navigate through large charts.

Chapter 6, Introducing Theme Lines

Describes some of the basic features of theme lines.

Chapter 7, Working with Theme Lines

Describes some of the more advanced features of theme lines.

Chapter 8, Ordered and Controlling Items

Describes how to add items to your chart that contain dates and times and order.

Chapter 9, Changing the Emphasis of a Chart

Describes how to change the representation of your chart.

Chapter 10, Working with Time Zones

Describes how Analyst’s Notebook works with different time zones.

Appendix A, Features used in the Examples

Contains tables listing where various Analyst’s Notebook features are 
demonstrated in the examples. These can be used to find the examples that best 
illustrate a specific feature.

Glossary 

A glossary of terms to help you understand the terminology used within Analyst’s 
Notebook.
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Conventions

Throughout this guide the following conventions are used:

Dates and 
times

When entering dates and times, the format you use will depend on your computer’s 
settings.

Dates throughout this guide are in the format dd MMM yyyy, for example 18 Oct 
2006. You should enter the date corresponding to your computer’s settings.

Times in this guide are all in the 24 hour clock, for example, 13:00. If your 
computer’s settings are different then you should enter the time corresponding to 
your settings. For example 13:10 in the 24 hour clock equates to 1:10 PM.

Unless otherwise stated, all of the charts used in these examples are in Greenwich 
Mean Time (GMT).

i2 Services

Technical support is available to anyone whose organization has opted for our 
annual support program. If you have a question and cannot find a solution in the 
online help, you can send an e-mail to the i2 Technical Support team.

For customers in North and South America, e-mail support@i2inc.com.

For customers in the UK or the Rest of the World, e-mail support@i2.co.uk.

Note: If your i2 software was purchased from one of our distributors, please contact your 
supplier for technical support.

Style Used for Examples

Bold Button names and options on 
dialogs.

Open command; File 
menu; Options button; 
Label check box.

Initial Capitals Window names and dialog box 
names.

Tool window; Chart 
Properties dialog.

Italic For emphasis, i2 product names 
and references to other i2 
guides.

Start Analyst’s Notebook.

Courier User entered text. Enter the name SMITH.
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i2 International and Government Services Americas Consulting services work with 
customers to understand specific requirements and then determine the best 
methods to get these requirements met through custom development, on-site 
training, or alignment with the right system integrator or product vendor.

For further information, contact your i2 supplier, or visit the i2 Web site at: 
www.i2group.com.

Other i2 Publications

Analyst’s Notebook 8

• i2 Analyst’s Notebook 8 Quick Start Guide

• i2 Analyst’s Notebook 8 User Guide: Importing

• i2 Analyst’s Notebook 8 User Guide: Customizing and Analyzing

Chart Reader 8

• i2 ChartReader 8 User Guide

• i2 ChartReader 8 Embedding in a Web Page
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Getting Started

This chapter introduces Analyst’s Notebook and describes how to use the product 
documentation.

Contents

Using the Documentation 12
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Using the Documentation 0.1

We recommend that before you start to use the documentation provided with 
Analyst’s Notebook you familiarize yourself with the product by reading the 
Analyst’s Notebook 8 Quick Start Guide, which introduces the basic concepts of 
creating charts.

Product documentation

The Analyst’s Notebook 8 User Guides do not cover all of the features of the 
product. Instead, they comprise a series of worked examples to demonstrate how 
the features may be used in real situations. These guides are aimed at providing 
information about which features best suit different situations and how you might 
use them to approach specific problems.

The online help covers all of the features of Analyst’s Notebook. It contains 
information on how to use the facilities. It also provides context specific help for all 
of the fields and options in each of the dialogs. It does not include any worked 
examples as these are provided in the Analyst’s Notebook 8 User Guides.

The Analyst’s Notebook product documentation comprises:

• Analyst’s Notebook 8 Quick Start Guide

This is a short guide that introduces the basic concepts of Analyst’s Notebook. 
It is advisable to read this guide before you start to work through the examples 
in the Analyst’s Notebook User Guide.

• i2 Analyst’s Notebook 8 User Guide: Creating Charts

The Analyst’s Notebook 8 User Guide comprises three volumes. This volume 
is devoted to producing charts manually. It provides the building blocks for 
understanding the fundamentals of Analyst’s Notebook and it would be 
beneficial for you to work through it regardless of whether you intend to create 
charts manually or import most of your data.

• i2 Analyst’s Notebook 8 User Guide: Importing

This volume describes how to import data from text files, including how to 
create import specifications.

• i2 Analyst’s Notebook 8 User Guide: Customizing and Analyzing

In this volume, you are introduced to more advanced features of the software. It 
describes how to create and maintain templates, including the ability to define 
new types and set other chart properties. This volume also covers the features 
that allow you to tidy up your chart for presentation purposes and allows you to 
learn all about the analysis tools available in Analyst’s Notebook.
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• i2 Analyst’s Notebook Online Help

For more information on using the online help, refer to Using the online help on 
page 15.

Using this guide

The examples in this guide are designed to help you use Analyst’s Notebook in 
your work. In working through the examples, you will use many of the Analyst’s 
Notebook features. The examples will be most useful to you if you work through 
them in the order in which they appear in the guide.

Structure of the examples

The main chapters of this guide consist of a series of worked examples that 
gradually introduce you to Analyst’s Notebook.

In some examples, the first thing you are asked to do is open an existing chart that 
we have provided for you. To access these charts, double-click on the User Guide 
Example Material shortcut in the My Documents\i 2\i 2 Analyst’s 
Notebook 8 folder, and double-click on the Creating Charts folder.

We have also provided you with a set of finished charts that can be accessed from 
the folder location described above. The charts reflect how your initial charts 
should look once you have worked through and completed each example. You may 
want to refer to these while you are working through the examples or at the end of 
a completed section. 

Each example comprises several sections. The start of each section describes the 
concepts behind the feature that is being introduced. The remainder of each 
section consists of a series of steps.To complete a worked example you must 
follow each of these steps in order, without skipping any of the sections.
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If at a later date you wish to work through an example without re-reading the 
conceptual information, just move from shaded heading to shaded heading in the 
chapter. Working through these headings will lead you through all of the steps in 
the example.

If at any time, you need more help with a feature, refer to the online help. How to 
use the online help is described on page 15.

Storing the charts created in the worked examples

Analyst’s Notebook saves charts to the My Documents\i2\i2 Analyst’s 
Notebook 8\Charts folder as standard. We recommend that you create a 
subfolder within this folder to store the charts you create with this guide. If you 
need to refer to them at a later date, it will be easy to find them.

To create a subfolder in which to store your charts:

1. Double-click on the My Documents shortcut on your Windows desktop, and 
navigate to the i2\i2 Analyst’s Notebook 8\Charts folder.

2. Right-click in the My Documents window, and from the shortcut menu, select 
New ➧ Folder. 

3. Edit the name of this folder to be Analyst’s Notebook 8 User Guide - 
Creating Charts.

Main section

Shaded 
heading
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Using the online help

We recommend that you familiarize yourself with the Analyst’s Notebook online 
help and use it extensively in conjunction with this guide.

Viewing the help

You can view the Analyst’s Notebook online help in the following ways:

• click the Help toolbar button

• from the Help menu, select Contents

• press the F1 key

You can display a help topic about a specific item by:

• clicking the What’s This? Help toolbar button, then clicking a menu command 
or toolbar button

• holding your mouse over a toolbar button or menu command and pressing the 
F1 key to display help information relevant to the item you highlighted

In dialogs, you can display a help topic about a specific item by:

• clicking the Help button on a dialog to display information about that dialog 

• clicking the What’s This? Help button in the top right of the dialog and clicking 
on a dialog option

• clicking with the left mouse button on a dialog option and pressing the F1 key

Tooltips and the Search Bar

To see the name of a toolbar button, hold the mouse over it. A pop-up hint, referred 
to as a tooltip, appears. 

Note also that Analyst’s Notebook displays a short description of the feature in the 
Status bar, which is located along the bottom of the application.

For further information on how to use the online help, refer to the online help topic 
Using Analyst’s Notebook Help.
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1
Introducing Some Basic Features

This chapter introduces some of the basic Analyst’s Notebook features and how 
you can use them when creating charts.
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Viewing Page Boundaries and Printing a Chart 65

Summary 72
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Introduction 1.1

The features covered in detail in this example are:

• creating charts

• using event frames to represent happenings, usually over a period of time

• saving your charts, and completing a Cover Sheet to record information about 
your charts

• aligning and spacing items in your chart

• zooming in and out of the chart to see specific details more clearly or to obtain 
an overall view of the entire chart

• changing the event frame display to customize what parts of the information 
contained in an event frame are displayed on your chart

• using palettes to locate types easily, such as icon types or link types

• adding icons and links

• using the spelling checker

• fitting your chart within page boundaries for printing purposes

• printing your chart

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished chart (Example 1 finished.anb) at any time while 
you are working through this example. To access the folder in which this chart is 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.



 Chapter 1: Introducing Some Basic Features

i2 Analyst’s Notebook 8 User Guide: Creating Charts 19

Scenario

Gary SPARKES has been suspected of drug supply for a number of years but it 
has not been possible to prove anything against him in the past. FARMER is 
believed to be one of SPARKES’ dealers and the investigating team has decided to 
use undercover officers in an attempt to make a test purchase from FARMER.

An undercover officer makes initial contact with FARMER by telephone at 10:12 on 
29 September 2006 and arranges a meeting for 12:00 the same day. The officer 
tells FARMER that he requires 25 grams of heroin and FARMER says he will 
contact his main supplier. He promises to have the drugs available the following 
day. This telephone conversation is recorded.

The meeting takes place around 12:00 on 29 September 2006, as arranged. When 
FARMER arrives at the meeting he does not have the drugs with him. He calls his 
supplier from a payphone at the local station. A few minutes after this call a 
package is delivered to him by an unknown male on a motorcycle. The license 
plate of this motorcycle is only partly visible but the officer notes that the partial 
license plate is 2*9WF*. The package (apparently containing 25 grams of heroin) is 
handed to the officer, shortly after which the meeting ends. 

The officer returns to his office after the meeting where he bags up the drugs and 
sends them to a forensic laboratory for analysis.

The happenings that took place during this meeting have been recorded by the 
undercover officer and all of the details have been taken from his notebook.
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Creating Charts 1.2

A chart is created using a template. A template contains properties such as entity 
and link types that you often use. Templates can be used to provide consistency 
across charts.

There are three different types of template that you can use when you create a new 
chart:

Standard template The Standard template, provided with Analyst’s Notebook, 
contains chart properties, such as entities, links and 
attributes. These properties are specified in palettes, each 
palette contains associated chart properties. For example, 
the Individuals palette contains all of the properties relating to 
people.

User template You can create a user template that contains all of the types 
and styles that are regularly used by your organization. This 
provides consistency across all of your charts. You can 
create as many user templates as you wish, each containing 
different types and styles.

Empty template An empty template does not contain any properties and will 
not contain any palettes. This is a good starting point if you 
want to set up a new template.

You can also open a chart that has already been created.

You have received information about the happenings relating to an undercover 
drugs operation involving Gary SPARKES and FARMER which you now want to 
chart. Create a new chart based on the User Guide Examples template. To do this:

1. Start Analyst’s Notebook.

How do I create a new chart based on a template?
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2. From the File menu, select New From Template. This displays the New From 
Template dialog:

3. From the list of Analyst’s Notebook Local Templates, select User Guide 
Examples and click OK to close the New From Template dialog.

A new empty chart is created based on the User Guide Examples template:
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Representing Happenings Using Event Frames 1.3

Entities can represent, for example, individuals, locations, organizations or objects. 
When you start building your chart, you select an entity type (such as Male, 
Female) from a palette and drag it onto the chart. When you add it to the chart the 
entity type becomes an entity, for example:

You can define your own entity types in charts and palettes, as you add information 
to the chart.

There are several representations of an entity in Analyst’s Notebook:

• Icons

• Boxes

• Circles

• OLE objects

• Text blocks

• Event frames

• Theme lines

An event frame can be used to represent a happening, typically something that 
took place at a moment in time. 

You can display all of the information that you added to an event frame or just parts 
of the information that is useful for your particular chart. 

Entity TypeEntity

(in palette)(on chart)

Anonymous 1

g
Drag an entity type
from the palette
and drop it onto
the chart, 
it becomes an
entity
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An example event frame, together with some of the information that you may wish 
to add to it, is shown below:

You can choose which fields in an event frame to display on your chart:

Note: You can display the formatted date and time, or a description of the date and time, 
but you cannot display both at the same time.

Label

Type Icon

Source Type

Description

Grades

Source

Date & Time

Reference

Pin

Type Name A 1 5

15 Jan 2006 15:30

TR 150102Record

SMITH and JONES met in
a hotel bar in London.

Meeting in hotel bar

Label Short description of the event.

Description Detailed description of the event.

Type Icon Icon used to represent the type of the event.

Type Name Entity type of the event.

Grades The grading information for the event.

Source Type A description of the source of the information. 
Examples of source types are Officer, Witness, 
Record.

Source Reference A reference for the information. An example of a 
source reference is a document reference number.

Date & Time The date and time that a happening took place. This 
can be the formatted date and time, for example 15 
Jan 2006 15:30, or a description of the date and 
time, for example, when a happening took place, 
such as “in the afternoon”.
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On 29 September 2006 at 10:12, an undercover officer called FARMER and 
arranged a meeting for around 12:00 noon on the same day. The meeting was 
arranged to set up the controlled purchase of drugs in order to gather evidence 
against FARMER. Create two event frames to show the meeting being arranged by 
the undercover officer and the officer leaving for the meeting at 11:00 on 
29 September 2006. To do this:

1. Click the drop-down arrow on the Insert Event Frame toolbar button and select 
Telecoms ➧ Telephone to select the Telephone type from the Telecoms 
palette.

The pointer changes to be an event frame:

2. Click on the chart to add the event frame.

Add information to this event frame that shows the undercover officer calling 
FARMER on 29 September 2006 at 10:12 to arrange a meeting for the following 
day. To do this:

1. Double-click on the event frame that you have just added to the chart to display 
the Edit Event Frame dialog. 

How do I add an event frame?

ungraded ungraded ungraded

Telephone 1

How do I edit the contents of an event frame?
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2. Select Data\Identity to display the Identity page:

3. In the Identity box, replace the text Telephone 1 with Meeting arranged. 
This will be the name of the event frame that is shown on the chart.

Do not close the Edit Event Frame dialog.
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4. Select Date & Time to display the Date & Time page:

5. Turn on the Date check box so that you can enter the date that the meeting was 
arranged.

Note: The format that you use when you enter the date will depend on your 
computer’s settings. The date format used throughout this guide is in 
the format dd MMM yyyy, for example 24 Jun 2006.

6. Edit the date to be 29 Sep 2006. To do this:

a. Click in the first section of the Date box.

b. Use the up/down arrows to increase or decrease the value to be 29.

c. Press the right arrow key on your keyboard to move to the next section of 
the Date box. Using the up/down arrows, increase or decrease the value to 
be Sep.

d. Press the right arrow key on your keyboard to move to the final section of 
the Date box. Once again, use the up/down arrows to set the year to be 
2006.
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Note: You can also specify the date by clicking the drop-down arrow to the 
right of the Date box and selecting the appropriate date from the 
calendar.

7. Turn on the Time check box so that you can enter the time that the meeting 
was arranged.

8. In the same way that you added the date, edit the time to be 10:12. 

Note: The format that you use when you enter the time will depend on your 
computer’s settings. The time format used throughout this guide is in the 
24 hour clock, for example 13:10 is the same as 1:10 PM.

9. Select Description & Grades to display the Description & Grades page:

10. In the Description box type the following:

An undercover officer contacted FARMER (a local drug 
supplier) to arrange a meeting. The officer was to set up 
the controlled purchase of drugs in order to gather 
evidence against FARMER.
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11. Add grading information to this event frame. To do this:

a. From the Grade 1 drop-down list, select A.

b. From the Grade 2 drop-down list, select 1. 

c. From the Grade 3 drop-down list, select 5.

d. From the Type drop-down list, select Officer.

e. In the Reference box type DS 453/01.

12. Click OK to close the Edit Event Frame dialog.

The event frame is displayed on your chart containing all of the information that 
you added:

Note: The date and time format displayed depends on your own computer’s settings

A 1 5

29 Sep 2006 10:12

DS 453/01Officer

An undercover officer contacted
FARMER (a local drug supplier) to

arrange a meeting. The officer was to
set up the controlled purchase of drugs

in order to gather evidence against
FARMER.

Meeting arranged
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You want all dates and times in event frames to be displayed with the long date and 
time format, for example 10 September 2006 18:25. The date and time that you 
entered in the Meeting arranged event frame is not displayed in this format. 
Change the date and time format in this event frame and for all subsequent event 
frames that you will add to the chart. To do this:

1. Double-click on the Meeting arranged event frame to display the Edit Event 
Frame dialog and select Style\Display to display the Display page:

2. In the Displayed Date & Time area, make sure Formatted is selected and 
select dd MMMM yyyy HH:mm from the drop-down list.

3. Turn on the Set Default Style check box. Each event frame that you add to this 
chart from now on will use the same date and time format. This means that you 
will not have to set it each time you add an event frame. 

4. Click OK to close the Edit Event Frame dialog.

How do I change the format of the date and time?
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The event frame is now displayed on your chart with the required date and time 
format:

On 29 September at 11:00, the undercover officer left for the meeting with 
FARMER. Add an event frame to show this information. To do this:

1. Click the drop-down arrow on the Insert Event Frame toolbar button and select 
Transport ➧ Car to select the Car type from the Transport palette.

2. Place the event frame to the right of the Meeting arranged event frame and add 
the following information to it:

A 1 5

29 September 2006 10:12

DS 453/01Officer

An undercover officer contacted FARMER
(a local drug supplier) to arrange a

meeting. The officer was to set up the
controlled purchase of drugs in order to

gather evidence against FARMER.

Meeting arranged

Adding more event frames

Identity Leave for meeting

Date & Time 29 Sep 2006 11:00

Description Undercover officer leaves for meeting.

Grades A 1 5

Source Type Officer

Source Reference DS 453/02
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The two event frames are displayed on the chart:

A 1 5

29 September 2006 10:12

DS 453/01Officer

An undercover officer contacted FARMER
(a local drug supplier) to arrange a

meeting. The officer was to set up the
controlled purchase of drugs in order to

gather evidence against FARMER.

Meeting arranged

A 1 5

29 September 2006 11:00

DS 453/02Officer

Undercover officer leaves
for meeting.

Leave for meeting
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Saving Charts and the Cover Sheet 1.4

It is good working practice to save your charts at regular intervals as you add 
information to them. If there is a power failure or a problem with your computer you 
risk losing your work if you have not saved the chart. 

If you have made changes to charts that have not been saved, you will be 
prompted to save these changes when you exit Analyst’s Notebook or close the 
chart. If you have an existing chart that you want to use as the starting point for 
another chart, you can save it as another name so that you can add more 
information to it but not change the original chart.

When you save a chart, all of the information that you have defined, such as 
entities, links, attributes, cards, and descriptions, are saved. The next time you 
open the chart it will contain all of the information that you added to it.

You can also choose to save your charts automatically as you are working. 
Analyst’s Notebook will save your chart after a specified interval of time, for 
example every 5 minutes. It is still good practice, however, to save your charts 
manually at regular intervals.

Cover Sheet When you save a chart, you can provide details about the chart in the form of a 
Cover Sheet. For example, you can include details about its subject matter and its 
confidentiality. Once you have completed the Cover Sheet details, you can decide 
to display the Cover Sheet every time an analyst starts to open a chart. Analysts 
can then view the details about the chart before they decide whether to open it or 
not. See the topic Working with the Cover Sheet in the Online Help.

The Cover Sheet contains a set of six summary properties which you can use to 
provide a full description of the chart. These file properties are the six Windows 
Explorer summary properties, which you can view by right-clicking on a file, 
selecting Properties, and selecting the Summary tab. These are:

• Title

• Subject

• Author

• Category

• Keywords

• Comments

When you complete the Cover Sheet for a new chart, you are providing additional 
details about the file that other Windows users can view.
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If your organization or team uses specific classifications for your charts, such as 
document statuses, operational codes, and so on, these can be created on the 
Cover Sheet as custom properties and also saved with the chart. These can be 
viewed alongside the summary properties on the Cover Sheet when an analyst 
opens a chart.

The summary and custom properties that you enter on the Cover Sheet can also 
be printed in the headers and footers of your chart. See the section How do I print 
headers and footers on my chart? in the i2 Analyst’s Notebook 8 User Guide: 
Customizing and Analyzing.

Before you add further information to your chart it is a good idea to save it. To do 
this:

1. From the File menu, select Save.

This is the first time that you have saved your chart, and so you are prompted to 
complete a Cover Sheet. Complete the Cover Sheet properties to help other 
analysts determine what the chart contains, and to make the details available 
for printing in the headers and footers of your chart.

2. Add the following information:

Note: You can press the Tab key to move between the boxes on the Cover 
Sheet.

How do I save a chart for the first time?

Title Meeting with FARMER on 29 September 2006

Subject SPARKES Drugs Supply Investigation

Author <your name>

Keywords FARMER, drugs, "test purchase"

Category Undercover Operation

Comments A series of event frames showing the test purchase of 
drugs from FARMER on 29 September 2006.
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The summary properties should look like this when completed:

When you create a new chart from the User Guide Examples template, custom 
properties called Case and Classification are created for you. You can choose to 
add values to these custom properties, or create your own custom properties. Add 
the text value SPARKES to the existing Case custom property, and Restricted to 
the existing Classification custom property. 

1. In the Custom area of the Cover Sheet dialog, select the Case custom property 
and click Edit to display the Edit Case Property dialog.

2. Type SPARKES in the Value box, and click OK.

3. Select the Classification custom property and click Edit to display the Edit 
Classification Property dialog.

4. Type Restricted in the Value box, and click OK.

The Case and Classification custom properties have now been edited. 

How do I edit custom properties?
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You want to create a new custom property to record the police operation to which 
the chart relates, which is called CREST. You also want to display the Cover Sheet 
when the chart is opened.

1. Click New to display the New Custom Property dialog.

2. Delete the text in the Name box and type Operation.

3. Delete the text in the Value box and type CREST.

4. Click OK to close the New Custom Property dialog.

5. In the Prompt area of the Cover Sheet dialog, turn on the On Open check box.

6. Click OK to close the Cover Sheet dialog and to display the Save As dialog.

How do I create a custom property?
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7. Save your chart to the folder that you created in the My Documents\i 2\i 2 
Analyst’s Notebook 8\Charts folder. How to create this folder is 
described in Storing the charts created in the worked examples on page 14. 

8. Type a name for your file in the File name box, call it Example 1 creating 
charts.anb.

Note: We recommend that you give your charts meaningful names.

9. Click Save to save your chart and the Cover Sheet details.

Notice that the title bar displays the name that you saved your chart as:

Once you have saved a chart for the first time, the next time you save the chart the 
Save As dialog and Cover Sheet will not be displayed. Any changes that you have 
made to the chart will be automatically saved.

Note: You can view and edit the Cover Sheet at any time by selecting Cover Sheet from 
the File menu.

If you have made changes to your chart, but not saved them, the Save toolbar 
button will be colored to indicate that you have unsaved changes. Click the Save 
toolbar button to save the changes.

When you have saved your changes, the Save toolbar button will become 
unavailable.

How do I save changes to a chart that has already been saved?
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Aligning and Spacing Chart Items 1.5

It is important to construct and present your charts as clearly as possible so that 
trends and associations are easy to see. In Analyst’s Notebook you can move pre-
selected chart items automatically around your chart so that they can be aligned 
with each other or be evenly spaced. Aligning and spacing items on a chart can 
make it easier to read and is better for presentation purposes.

In Analyst’s Notebook you can align or space items horizontally or vertically.

In the example chart below, the items on the chart are not aligned or evenly 
spaced:

In the example chart below, however, the items have been aligned and spaced 
horizontally:

The toolbar can align or space any number of selected items from a minimum of 
two chart items.

Traveled to
meeting

Package
delivered

Meeting starts
Meeting
arranged

Package
delivered

Meeting startsTraveled to
meeting

Meeting
arranged
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Align the event frames that you have added to your chart. To do this: 

1. Select the event frames on your chart; select the first chart item, hold down the 
Ctrl key and click on each additional chart item.

2. Click the Align Horizontally toolbar button.

Notice that as soon as you click the Align Horizontally toolbar button, the 
event frames align themselves. Event frames are aligned by the top edge of the 
event frame.

How do I align chart items?

A 1 5

29 September 2006 10:12

DS 453/01Off icer

An undercover off icer contacted FARMER
(a local drug supplier) to arrange a meeting.

The off icer w as to set up the controlled
purchase of drugs in order to gather

evidence against FARMER.

Meeting arranged

A 1 5

29 September 2006 11:00

DS 453/02Officer

Undercover off icer leaves
for meeting.

Leave for meeting
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The meeting between the undercover officer and FARMER started at 12:00 on 29 
September 2006. During this meeting, the undercover officer recorded several 
happenings. Add the following information to your chart as event frames. To do 
this:

1. Click the drop-down arrow on the Insert Event Frame toolbar button and select 
Standard ➧ More Types to display the Select Type to Insert dialog:

2. Scroll down the list of event frame types and select Meeting.

Note: You can use the keyboard to search quickly for an entity type. For 
example, pressing the M key will take you to the first entity type that 
starts with the letter M. You can press the M key to cycle through these 
entity types in turn.

3. Click OK to close the dialog.

Adding further event frames
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4. Place this event frame to the right of the Leave for meeting event frame and 
add the following information to it:

Note: The chart window does not have enough space to place any further 
event frames. Before you add the next event frame click with the left 
mouse button on the scrollbar button at the bottom right of the 
application window to move to the right of the chart window.

5. During the meeting FARMER called his supplier from a public payphone.

Add an event frame of type Payphone, from the Telecoms palette. Place it to 
the right of the Meeting starts event frame and add the following information to 
it:

6. Shortly after FARMER called his supplier, an unknown person arrived on a 
motorcycle and handed a package to him before leaving the scene. 

Identity Meeting starts

Date & Time 29 Sep 2006 12:00

Description Meeting between the undercover officer and 
FARMER starts. FARMER informs the officer that 
he will call his supplier and ask him to deliver a 
'sample' of drugs.

Grades A 1 5

Source Type Officer

Source Reference DS 453/03

Identity Supplier contacted

Date & Time 29 Sep 2006 12:55

Description FARMER states that he will contact his supplier 
and uses the payphone situated in the station 
lobby.

Grades A 1 5

Source Type Officer

Source Reference DS 453/04
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Add an event frame of type Commodity, from the Commodities palette. Place it 
to the right of the Supplier contacted event frame and add the following 
information to it:

7. Shortly after FARMER received the package he handed it to the undercover 
officer. The undercover officer told him that he would get back to him when he 
had checked the drugs out. 

Add an event frame of type Drugs, from the Commodities palette, to show the 
undercover officer receiving the drugs. Place it to the right of the FARMER 
receives package event frame and add the following information to it:

Identity FARMER receives package

Date & Time 29 Sep 2006 13:10

Description An unknown person arrives on a motorcycle (only 
part of the license plate is visible). Talks to 
FARMER and hands him a package before leaving 
the scene.

Grades A 1 5

Source Type Officer

Source Reference DS 453/05

Identity Drugs supplied

Date & Time 29 Sep 2006 13:15

Description FARMER gives the package to the undercover 
officer, who says that he will get back to FARMER 
when he has 'checked it out'.

Grades A 1 5

Source Type Officer

Source Reference DS 453/06
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8. The meeting ended at 13:30, after the undercover officer received the package 
from FARMER. 

Add an event frame of type Meeting, from the Standard palette. Place it to the 
right of the Drugs supplied event frame and add the following information to it:

9. The undercover officer returned to his office at 14:30, bagged up the drugs and 
forwarded them to a forensic laboratory for analysis. 

Add an event frame of type Car, from the Transport palette, place it to the right 
of the Meeting ends event frame and add the following information to it:

Note: As you click on the drop-down arrow on the Insert Event Frame toolbar 
button, notice that the Meeting type also appears near the top of the list. 
Analyst’s Notebook remembers the last 10 most recently used types 
that you have added to the chart and lists them here. You can select 
these types and add them to the chart in the same way as choosing a 
type from a palette.

Identity Meeting ends

Date & Time 29 Sep 2006 13:30

Description After a successful meeting, FARMER and the 
officer leave separately.

Grades A 1 5

Source Type Officer

Source Reference DS 453/07

Identity Return from meeting

Date & Time 29 Sep 2006 14:30

Description Having returned from the meeting, the officer bags 
up the drugs to forward onto a forensic laboratory 
for testing.

Grades A 1 5

Source Type Officer

Source Reference DS 453/08
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Zooming to See Parts of a Chart 1.6

When you open a chart it is displayed in its actual size but you can, for example, 
zoom out to see more of a chart and then zoom in on part of the chart. You can 
also view all of the chart or fit the height of the chart in the current window or in a 
set of four sub windows. Scroll bars on each of these windows or the arrow keys on 
your keyboard allow you to scroll horizontally or vertically to display the areas of 
your choice.

You may not be able to see the entire chart as the event frames that you have 
added do not all fit in one window. You are now going to see how you can use the 
zoom tools.

1. Click the Zoom Out toolbar button until you can see the whole chart in the 
current window.

2. Click the Zoom In toolbar button until the chart no longer fits in the window.

3. Click the Fit Chart in Window toolbar button. This will display the whole chart 
in the current window.

There are other zooming tools that are available on the toolbar:

Zoom to Area Click the Zoom to Area toolbar button and then drag 
a rectangle around the part of the chart that you want 
to zoom in on. The chart zooms in on the part of the 
chart that you click on.

Actual Size Click the Actual Size toolbar button. The chart 
displays the items on the chart at their actual size, 
enabling you to see their contents more clearly.

Fit Selection in Window Select the items that you want to zoom in on and click 
the Fit Selection in Window toolbar button. The 
selected items are displayed within the chart window.

Fit Height in Window Click the Fit Height in Window toolbar button. The 
items on your chart are displayed so that the height of 
the chart fits in the chart window.

Experiment with each of the toolbar buttons to see the effect they have on your 
chart, then click the Fit Chart in Window toolbar button so that you can see all of 
the event frames.

How do I zoom in and out of a chart?

How do I use the other zooming tools?
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

A 1 5

29 September 2006 11:00

DS 453/02Officer

Undercover officer leaves
for meeting.

Leave for meeting

A 1 5

29 September 2006 12:00

DS 453/03Officer

Meeting between the undercover officer
and FARMER starts. FARMER informs
the officer that he will call his supplier
and ask him to deliver a 'sample' of

drugs.

Meeting starts

A 1 5

29 September 2006 12:55

DS 453/04Officer

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

A 1 5

29 September 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 September 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

A 1 5

29 September 2006 13:30

DS 453/07Officer

After a successful meeting,
FARMER and the officer leave

separately.

Meeting ends

A 1 5

29 September 2006 14:30

DS 453/08Officer

Having returned from the meeting,
the officer bags up the drugs to

forward onto a forensic laboratory
for testing.

Return from meeting

A 1 5

29 September 2006 10:12

DS 453/01Officer

An undercover officer contacted FARMER
(a local drug supplier) to arrange a

meeting. The officer was to set up the
controlled purchase of drugs in order to

gather evidence against FARMER.

Meeting arranged
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Changing Event Frame Display 1.7

When you add an item to a chart you can add additional information to it, such as a 
date and time, description and grades. To make a chart more readable you can 
choose which parts of this additional information to display. If you choose not to 
display parts of the information, the information that you have added is still 
retained in the chart item but is not displayed on the chart. 

This is particularly useful for event frames, for example you may only want to see 
the label and date and time of an event.

When you added the Meeting arranged event frame to the chart you added 
information that gave more detail about the happening, such as a description, date 
and time, and grades. You only want to display the label of the event frame and the 
icon that is used to represent the telephone call from the undercover officer to 
FARMER. To do this:

1. Double-click on the Meeting arranged event frame to display the Edit Event 
Frame dialog and select Style\Display to display the Display page:

How do I change the display of an event frame?
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2. In the Display area, leave the Label, Pin, and Type Icon check boxes turned 
on, but turn off all of the remaining check boxes:

3. Click OK to close the Edit Event Frame dialog.

The Meeting arranged event frame is resized and displayed with just its pin, 
label, and type icon:

4. You only want to display four parts of the information that you added to the 
Leave for meeting event frame: the label, date and time, the type icon, and the 
pin. 

Change the display properties of the Leave for meeting event frame so that 
only these elements are displayed:

Meeting
arranged

29 September 2006
11:00

Leave for meeting
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5. Change the display properties of the following event frames so that they match 
the picture below:

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Return from
meeting

29 September 2006 13:30

After a successful
meeting, FARMER and the
officer leave separately.

Meeting ends

29 September 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

29 September 2006 12:00

Meeting between the undercover
officer and FARMER starts. FARMER

informs the officer that he will call
his supplier and ask him to deliver a

'sample' of drugs.

Meeting starts

Return from
meeting

29 September 2006 13:30

After a successful
meeting, FARMER and the
officer leave separately.

Meeting ends

29 September 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

29 September 2006 12:00

Meeting between the undercover
officer and FARMER starts. FARMER

informs the officer that he will call
his supplier and ask him to deliver a

'sample' of drugs.

Meeting starts

A 1 5

29 September 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

A 1 5

29 September 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives packageMeeting
arranged

29 September 2006
11:00

Leave for meeting
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Linking Chart Items 1.8

A link represents an association between two entities on your chart. Relationships, 
meetings, and commodity transfers are all examples of links.

As with entity types, you can edit the properties of link types to make them more 
meaningful on your charts.

You can choose which parts of information about the link to display on your chart:

You can specify the line strength of your link, for example, you can indicate the 
reliability of the link information using dashed or solid lines.

You can also edit the line width, color, and the font used for the link label.

Label Short description of the link, for example Married.

Formatted Date & Time A specific description of the time that the link 
between two entities was recorded, for example 28 
April 2006 13:03:22.

Description of Date & Time A non-specific description of the time that the link 
between two entities was recorded, for example “in 
the afternoon”. 

Description A longer description of the link.

Source Type A description of the source of the information. 
Examples of source types are Officer, Witness, 
Record.

Source Reference A reference for the information. An example of a 
source reference is a document reference number.

Grades The grading information for the link.
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The event frames that you have charted so far have all concerned happenings that 
took place in sequence, flowing from the left of the chart to the right. Link all of the 
event frames and add an arrowhead to indicate the direction of the flow. To do this:

1. Click the drop-down arrow on the Insert Link toolbar button and select  
Standard ➧ General to select the General link type from the Standard palette.

The pointer changes to be a cross:

2. While holding down the left mouse button, drag the link from the Meeting 
arranged event frame to the Leave for meeting event frame. 

Note: As you drag the link near to the Leave for meeting event frame the 
pointer changes to a cross with a small cross on the top right. This 
indicates that the link will be added to this event frame.

3. Release the left mouse button. A link is drawn between the Meeting arranged 
event frame and the Leave for meeting event frame: 

Add an arrowhead to the link to indicate that the flow is from the Meeting arranged 
event frame to the Leave for meeting event frame. To do this:

1. Right-click on the link between the Meeting arranged event frame and the 
Leave for meeting event frame.

2. From the shortcut menu, select Add Arrow.

How do I link items?

General

Meeting
arranged

29 September 2006
11:00

Leave for meeting

How do I add an arrowhead to show the direction of a link?
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The link is now displayed on the chart showing the direction of the flow from the 
Meeting arranged event frame to the Leave for meeting event frame:

Note: If the arrowhead is drawn at the wrong end of the link, you can reverse it 
so that it is drawn at the other end. To do this, right-click on the link, and 
from the shortcut menu, select Reverse Arrow.

Link labels display the name of a link. You can edit or delete link labels. Delete the 
link label on the link that you have just added between the Meeting arranged and 
Leave for meeting event frames. To do this:

1. Double-click on the link to display the Edit Link dialog.

2. Select Data\Identity to display the Identity page:

General

Meeting
arranged

29 September 2006
11:00

Leave for meeting

How do I remove a link label?
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3. Click at the beginning of the text in the Label box with your left mouse button, 
and while still holding down the left mouse button, drag the mouse to the right 
to select the text.

4. Release the mouse button and with the text still selected, press the Delete key 
to delete the link label text.

5. Click OK to close the Edit Link dialog.

The link is displayed on the chart with an arrowhead showing the flow of 
happenings but with no label:

When you have added a link type to your chart, that link type remains the selected 
link type until you change it. This means that the General link type you added 
between the Meeting arranged and Leave for meeting event frames is still the 
selected link type. Add a General link type between all of the remaining event 
frames so that it looks similar to that below. To do this:

1. Double-click the Insert Link toolbar button. This will put Analyst’s Notebook 
into Insert mode.

2. Add links between all of the event frames.

3. Click the Select/Move toolbar button to exit Insert mode.

4. Delete all of the link labels and add an arrowhead to show the order in which 
the happenings occurred, so that your chart looks similar to that below:

5. Click the Save toolbar button to save your chart.

Meeting
arranged

29 September 2006
11:00

Leave for meeting

Adding more links

A 1 5

29 September 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 September 2006 13:15

DS 453/06Officer
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he has 'checked it out'.

Drugs supplied
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officer leave separately.

Meeting ends Return from
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29 September 2006 12:55

DS 453/04
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29 September 2006 12:00
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officer and FARMER starts. FARMER
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his supplier and ask him to deliver a
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Meeting starts

29 September 2006
11:00

Leave for meetingMeeting
arranged
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Adding Chart Items Using Palettes 1.9

A palette contains the types that relate to an investigation, such as entities, links 
and attributes. Analyst’s Notebook is supplied with a range of predefined palettes, 
but you can also define your own palettes. 

The Standard palette contains all of the types that are used by your organization. 
When you specify a type it will always appear in the Standard palette but you can 
create subsets of the Standard palette. For example, you can create a palette 
called Drugs that contains the different types that you use during an investigation 
into drug smuggling. You can add the same type to any number of palettes.

There are a number of different ways that you can add an item to your chart from a 
palette:

• Click the drop-down arrow on a toolbar button and choose the type from the 
appropriate palette drop-down list:
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• Select an item from the palette bar and drag it onto the chart:

In addition to the event frames that you have added to your chart, you also want to 
add further items to your chart to show that FARMER and the undercover officer 
attended the meeting on 29 September 2006. To do this:

1. Click the drop-down arrow on the Insert Icon toolbar button and select 
Individuals ➧ Male to select the Male type from the Individuals palette.

The pointer changes to show the Male icon that you are about to add to the 
chart:

2. Click on the chart above the Meeting starts event frame. A Male icon is placed 
on the chart.

3. Edit the name of the icon to be FARMER. To do this:

a. Press the F2 key.

b. Type FARMER followed by the Enter key.

c. Click on the chart background to deselect FARMER.

4. In the same way, drag another Male icon onto the chart to represent the 
undercover officer.

5. Edit the name of this icon to be Undercover officer.

Anonymous 1

Drag and drop

How do I add an icon to my chart?
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The two icons are displayed on the chart above the Meeting starts event frame:

Click the Save toolbar button to save your chart.

You also want to add an icon to represent the motorcycle that was used for the 
delivery of the parcel to FARMER. To do this:

1. Click the drop-down arrow on the palette bar and select the Transport palette:

2. The palette bar area displays the icons specified in the Transport palette:

Undercover officerFARMER

29 September 2006 12:00

Meeting between the undercover
officer and FARMER starts. FARMER

informs the officer that he will call
his supplier and ask him to deliver a

'sample' of drugs.

Meeting starts

How do I add an icon from a palette?
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3. Select the Motorcycle icon, drag it onto the chart and place it above the 
FARMER receives package event frame.

4. Double-click on the Motorcycle icon to display the Edit Icon dialog and select 
Data\Identity.

5. Type the following information in the Identity box: 

6. Add an icon to represent the forensic laboratory that the drugs were sent to for 
analysis. To do this:

a. From the drop-down list on the palette bar, select the Locations palette.

b. Drag a Laboratory icon onto the chart and place it below the Return from 
meeting event frame.

c. Edit the name of this icon to be Laboratory.

The icons for the motorcycle and the forensic laboratory are shown on your 
chart:

Motorcycle
Part License Plate
2*9WF*

A 1 5

29 September 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 September 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 September 2006 13:30

After a successful
meeting, FARMER and the
officer leave separately.

Meeting ends Return from
meeting

Laboratory

Motorcycle
Part License Plate

2*9WF*



Adding Chart Items Using Palettes

56 i2 Analyst’s Notebook 8 User Guide: Creating Charts

You need to link the icons that you have just added to your chart to the relevant 
event frames. Link FARMER and the undercover officer to the Meeting starts event 
frame and link the Motorcycle to the FARMER receives package event frame. You 
will also need to link the Laboratory to the Return from meeting event frame. Using 
the Link Bar, add an Attendee link type between FARMER and the Meeting starts 
event frame. To do this:

1. From the View menu, select Toolbars ➧ Link Bar to display the Link Bar.

2. Before you can link two entities using the Link Bar you must first select the link 
type. To do this:

a. From the Palette drop-down list, select Individuals to select the Individuals 
palette.

b. From the Link drop-down list, select Attendee 

c. You do not want the link to be drawn with an arrowhead, from the End style 
drop-down list, select the line without an arrowhead

d. Click Draw a Link.

3. Hold down the left mouse button, and drag the link from the FARMER icon to 
the Meeting starts event frame.

Note: As you move your mouse close to the Meeting starts event frame the 
pointer changes to a cross with a small cross at the top right side. This 
indicates that the link will be added to this event frame.

How do I link items using the Link Bar?

Palette drop-down list

End style drop-down list

Line strength 
drop-down list

Insert Link 
button

Link type 
drop-down list

Wiring Height style
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4. Release the left mouse button.

5. Remove the label text on this link. To do this:

a. Click the label on the link to select it. 

b. Press the F2 key. The text is highlighted.

c. Press the Delete key, followed by the Enter key.

d. Click on the chart background to deselect the link.

6. Using the same method, add an Attendee link type between the Undercover 
officer and the Meeting starts event frame. Remove the label from this link.

The Undercover officer and FARMER are both linked to the Meeting starts 
event frame:

7. Using a General link type, from the Standard palette, add a link between the 
Motorcycle and FARMER receives package event frame. Remove the label 
from this link.

8. Add a General link type between the Laboratory and Return from meeting 
event frame and edit the link label to be To forensic laboratory. 

Undercover officerFARMER

29 September 2006 12:00

Meeting between the undercover
officer and FARMER starts. FARMER

informs the officer that he will call
his supplier and ask him to deliver a

'sample' of drugs.

Meeting starts
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9. Add an arrowhead to this link to show that the drugs were sent from the Return 
from meeting event frame to the Laboratory.

10. Click the button on the top right of the Link Bar to close it.

Your chart should now look similar to that below (Example 1 finished.anb):

Click the Save toolbar button to save your chart.

To forensic laboratory

Laboratory

Undercover officerFARMER

A 1 5

29 September 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 September 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 September 2006 13:30

After a successful
meeting, FARMER and the
officer leave separately.

Meeting ends Return from
meeting

Motorcycle
Part License Plate

2*9WF*

29 September 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

29 September 2006 12:00

Meeting between the undercover
officer and FARMER starts. FARMER
informs the officer that he will call

his supplier and ask him to deliver a
'sample' of drugs.

Meeting startsMeeting
arranged

29 September 2006
11:00

Leave for meeting
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Using the Spelling Checker 1.10

A spelling checker is provided with Analyst’s Notebook. You can choose to run it:

• as you type

• when you have finished a chart, prior to printing or presentation

Before you run the spelling checker there are several options that you can set. 
These options determine the extent to which the contents of your chart will be 
checked for possible errors. For further information on these options, refer to the 
online help.

As you have been entering information for each of the chart items you may find 
that you have made typing mistakes. Before you can run the Spelling Checker you 
will need to specify which parts of the chart that you want to check. Set up the 
Spelling Checker so that each time you run it the entire contents of your chart are 
checked for spelling mistakes. To do this:

1. Click on the chart background to ensure no items are selected.

2. From the Tools menu, select Options to display the Options dialog and select 
Options\Spelling to display the Spelling page:

How do I set up the spelling checker?
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3. You want to run the Spelling Checker over the entire chart. In the Coverage 
area make sure that all of the check boxes are turned on.

4. The settings in the Preferences area are fine, so you can leave them as they 
are.

5. Click OK to close the Options dialog.

Now that you have set up the Spelling Checker you can run it. If any spelling errors 
are found the Spelling dialog is displayed. Press the F7 key to run the Spelling 
Checker. 

The following demonstrates how you can correct any spelling errors highlighted by 
the Spelling Checker.

In the event frame below, there is a spelling mistake in the description, “The” has 
been typed incorrectly as “Teh”:

How do I run the Spelling Checker?

A 1 5

01 Jan 2006 02:30

SL 908/98aOfficer

Teh three suspects (KENT,
SHARP and STEELE were
observed in a hotel bar in

Castries harbor.

Meeting in hotel bar
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When the Spelling Checker is run it finds this spelling mistake and displays the 
Spelling dialog:

In the Change to box, an alternative word is suggested. You know that the word 
should be “The” and not “Tech” as suggested, to change this, select The in the 
Suggestions area.

To replace the text in the chart, click Change. 

The spelling checker continues to check the contents of your chart, suggesting 
alternative spellings as it finds possible errors. When it can no longer find any 
possible errors, a message will be displayed that the Spelling Checker has finished 
checking your chart. Click OK to close this.



Using the Spelling Checker

62 i2 Analyst’s Notebook 8 User Guide: Creating Charts

Rather than running the Spelling Checker over the entire chart, you can also check 
your spelling as you type. To do this:

1. From the Tools menu, select Options to display the Options dialog and select 
Options\Spelling to display the Spelling page:

2. For the purposes of this example, you want to check the spelling of both 
entities and links. Make sure Entities and Links is selected.

3. In the Preferences area, make sure the Report doubled words check box is 
turned on. 

4. To check your spelling as you type, make sure the Check Spelling as You 
Type check box is turned on and click OK to close the Options dialog.

How do I check spelling as I type?
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The following demonstrates how the Spelling Checker works when you have 
specified to check spelling as you type.

As you type, any word that is seen as a possible spelling mistake is underlined with 
a red wavy line.

If you right-click on the underlined word, a shortcut menu is displayed suggesting 
alternative spellings:

Choose the correct spelling from the shortcut menu. The red wavy underline is 
removed and the incorrectly-spelled word is replaced with the correct spelling.

Using the in-line Spelling Checker
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If the word that has been found by the Spelling Checker is not a spelling mistake 
select Ignore from the shortcut menu, the red wavy underline will be removed. If 
there is more than one occurrence of this word on the chart select Ignore All to 
specify that the spelling checker does not highlight this spelling. 

If you frequently use a word, and this word is not displayed as an alternative in the 
shortcut menu, you can add it to the Spelling Checker’s dictionary by selecting 
Add from the shortcut menu.
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Viewing Page Boundaries and Printing a Chart 1.11

We recommend that you follow the steps below when printing a chart:

• specify the printer you wish to print the chart to

Select a printer to print a chart to. When you select a printer you can also set 
the properties for the printer.

• specify the page settings

The chart's printed appearance depends on the properties that you have set for 
the printer and the way in which the page is set up. Page setup allows you to 
set any of the following options when setting up a printer to print your chart to:
— paper size, such as letter, A4 and so on
— paper orientation, landscape or portrait
— the number of pages the chart will be printed over (scaling)
— center the chart on the page
— items that span two separate pages are printed with an overlap
— page margins
— borders and background colors
— print themeline names with a set width on every page
— print the time bar on every page
— print chart properties, including page numbers, in the headers and footers

There are a number of reasons that you should set up your pages before 
printing a chart:
— the page size varies between different printers
— if you change your chosen printer you will have to setup pages again
— if you receive a chart from someone else, you may have to set up the pages 

again to print on your chosen printer

• view page boundaries

Page boundaries displays lines on your chart indicating the edges of each 
page. This enables you to check where your page breaks are located before 
printing your chart.
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The page boundary is displayed on the chart as a gray rectangle. Chart items 
within the rectangle will be printed, chart items that are not within the rectangle 
will not be printed. If the page boundaries do not represent how you want to 
print your chart you should change the page setup settings.

Note: When you use the Page Setup dialog to specify the page settings, the 
page boundary is temporarily displayed to help you adjust the scaling so 
that all items are displayed within the page boundary.

In the example chart below, the page boundaries show how the chart will be 
printed. The chart will be printed on two landscape pages, the split between 
the two pages is shown on the chart as a broken line.

• print the chart

The chart is printed on your chosen printer. If it is not printed exactly as you 
want it, for example not all of the chart is printed, or it is printed on too many 
pages, you will need to change the printer setup and page layout settings.

When printing a chart it is important that you follow the above steps in order. If, for 
example, you receive a chart from another user who has used a printer that you do 
not have access to, you will need to choose another printer. You will then need to 
set the printer properties and the page setup, so that it is printed in the required 
style. 

Associates

Subscriber

A 1 5

01 Jan 2006 10:30

DFG 0989/1aWitness

Meeting between Kent
CORNEY and Kevin DUPLEASE

starts.

Meeting starts

Kent CORNEY Kevin DUPLEASE

A 1 5

01 Jan 2006 11:45

GQF879072Witness

Kent CORNEY receives package.
This package wqas delivered by

an unknown male on a
motorcycle.

CORNEY receives package

License plate: 474 TRL

A 1 5

01 Jan 2006 12:00

HLK 9098/a1Record

Kent CORNEY hands Kevin
DUPLEASE the package in

exchange for an envelope,
believed to contain money.

Package handed to DUPLEASE

A 1 5

01 Jan 2006 12:15

WaitressWitness

Kent CORNEY and Kevin
DUPLEASE leave

separately.

Meeting ends

174 579 5487

David YOUNG

A 1 5

01 Jan 2006 10:50

SA 90738Officer

Kent CORNEY is seen
making a call from a

payphone in the hotel.

Telephone call
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Before you print your chart you will need to choose a printer to print it on. To 
choose a printer:

1. From the File menu, select Print. This displays the Print dialog.

2. In the Printer area, from the drop-down list, select a printer.

3. Click OK to close the Print dialog.

How do I choose a printer?
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Before you specify the page settings, see how your chart will be positioned on the 
paper. 

To do this, click the Page Boundaries toolbar button.

A gray box is displayed around an area of your chart, to show the page boundaries. 
You can see that most of the chart items do not fit within the page boundaries:

How do I view page boundaries?

To forensic laborato

Laboratory

Undercover officerFARMER

A 1 5

29 September 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 September 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 September 2006 13:30

After a successful
meeting, FARMER and the
officer leave separately.

Meeting ends Return from
meeting

Motorcycle
Part License Plate

2*9WF*

29 September 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

29 September 2006 12:00

Meeting between the undercover
officer and FARMER starts. FARMER

informs the officer that he will call
his supplier and ask him to deliver a

'sample' of drugs.

Meeting startsMeeting
arranged

29 September 2006
11:00

Leave for meeting

1
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:

Before you print your chart you will need to set up the page boundaries so that it is 
printed on two landscape pages. To do this:

1. Click the Edit Page Setup toolbar button to display the Page Setup dialog:

2. Make sure that Page is displayed.

3. In the Orientation area select Landscape.

4. To specify that you want the chart to be printed on two landscape pages, in the 
Scaling area:

a. Set the value in the Page(s) Wide by box to be 2.

b. Set the value in the Page(s) Tall box to be 1.

c. Click Adjust and from the drop-down list, select Scale.

5. You want to print the chart in the center of the page, so make sure that in the 
Placement area the Center Chart on Paper check box is turned on.

How do I reposition a chart within the page boundaries?
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6. When you print this chart you do not want to see the page borders. Click the 
Borders tab at the top of the Page Setup dialog to display the Borders page:

7. In the Border area, select None.

8. In the Background Colors area, turn off the Time Bar and Chart check boxes.

9. Click OK to close the Page Setup dialog.

Your chart is repositioned so that all of the chart items are displayed within the 
page boundaries:

To forensic laboratory

Laboratory

Undercover officerFARMER

A 1 5

29 September 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 September 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 September 2006 13:30

After a successful
meeting, FARMER and the
officer leave separately.

Meeting ends Return from
meeting

Motorcycle
Part License Plate

2*9WF*

29 September 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

29 September 2006 12:00

Meeting between the undercover
officer and FARMER starts. FARMER

informs the officer that he will call
his supplier and ask him to deliver a

'sample' of drugs.

Meeting startsMeeting
arranged

29 September 2006
11:00

Leave for meeting

1 2
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When you have chosen a printer and set up your chart for printing you can print it. 
To do this, click the Print toolbar button.

Your chart is printed on the chosen printer. If the printed result is not as you 
expected, you will have to return to the Page Setup dialog and make the necessary 
changes.

.

You have finished adding information to this chart so you can close it. To do this:

1. From the File menu, select Close.

If you have made any changes since it was last saved, a dialog box will be 
displayed with the following message:

Note: If you have made changes to your chart and saved them, the above 
dialog will not be displayed and the chart will be closed.

2. Click Yes to save the changes.

Your chart is saved with your latest changes and closed.

How do I print a chart?

How do I close a chart?
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Summary 1.12

In this example, you will have learned how to:

• create charts

• use event frames to represent happenings, usually over a period of time

• save your charts, and complete a Cover Sheet to record information about your 
charts

• align and space items on your chart

• zoom in and out of the chart to see specific details more clearly or to obtain an 
overall view of the entire chart

• change the event frame display to customize what parts of the information 
contained in an event frame are displayed on your chart

• use palettes to locate types easily, such as icon types or link types and add 
chart items

• add icons and links

• use the spelling checker to check the spelling in your chart

• fit your chart within page boundaries for printing purposes

• print your chart
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2
Handling Chart Items

This chapter describes how to build up your chart using entity types in the form of 
icons and adding links. It also describes how to add grading information and how 
to label and uniquely identify chart items.

Contents

Introduction 74
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Labeling and Uniquely Identifying Entities 86

Using Additional Features of Links 94

Adding Information Using Other Representations 101

Tidying up a Chart 115

Summary 118
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Introduction 2.1

The features covered in detail in this example are:

• adding grading information to chart items

• labeling and uniquely identifying entities

• using additional features of links

• using other representations to add information

• tidying up a chart by adding corners and rearranging links and link labels

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished chart (Example 2 finished.anb) at any time while 
you are working through this example. To access the folder in which this chart is 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.
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Scenario

It is suspected that FARMER is involved in drug dealing. An undercover officer sets 
up a meeting with him. During the meeting, FARMER makes a call from a 
payphone in the station lobby. From police observations and subsequent timings, it 
is found that the number called was 07786 162 534. It is ascertained that this is a 
cellphone, owned by Marc BAKER.

Information for cellphone 07786 162 534 shows that around the time FARMER 
called this cellphone, a call was made to another cellphone, number 07787 563 
412. There are no subscriber details available for this second cellphone. 
Subsequently the police traced a series of telephone calls between the two 
cellphones.

Marc BAKER is on the board of directors of a company called Arcacia Investments. 
He owns a Black Saab 900, license plate 456 FGT. He also uses a mailing address 
of Box 518, Finchley Road, Crownsville. Arcacia Investments is the registered 
owner of a cruiser called MOONSHADOW.

An associate of Marc BAKER, Mr STEELE, is involved in another investigation 
concerning drugs importation, money laundering and forgery. He lives at 5 Silver 
Street, Crownsville, with another person believed to be S DIAMOND.

Another suspect, Stuart WRIGHT is believed to crew on board MOONSHADOW.
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Adding Grading Information to Items 2.2

You can specify grades on any chart item to indicate the reliability of the 
information. You can also add grading information to cards. For further information 
on cards, refer to Adding Information Using Cards on page 121.

The grades that you use will depend on the grading system that has been adopted 
by your organization. 

For the purposes of this guide, the grading system is made up of three grades:

In addition to this you can specify the source type for the information, for example 
the types of person providing the information. In this guide the source types have 
been defined as Informant, Officer, Record, Victim and Witness. 

You can add a source reference for the information. This is typically a reference 
back to the record, statement or officer’s notebook from which the information was 
originally retrieved, for example DS 765/01-a.

Create a new chart based on the User Guide Examples template and add an entity 
to represent the payphone from where FARMER called his supplier. To do this:

1. Create a new chart based on the User Guide Examples template. For more 
information on how to do this refer to How do I create a new chart based on a 
template? on page 20.

2. To save the chart, from the File menu, select Save As. Click OK on the Cover 
Sheet dialog to display the Save As dialog. Select the folder you created to 
save your charts in. Type Example 2 handling chart items.anb in the 
File Name box and click Save.

3. Click the drop-down arrow on the Insert Icon toolbar button and select 
Telecoms ➧ Payphone to select the Payphone icon from the Telecoms palette.

4. Place the Payphone icon onto your chart.

Grade 1 The reliability ratings of the source: A, B, C, D, E, and ungraded.

Grade 2 The reliability ratings of the information:  
1, 2, 3, 4, 5, and ungraded.

Grade 3 The privacy ratings of the information:  
1, 2, 3, 4, 5, and ungraded.

How do I add grades to an entity?
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5. Double-click on the Payphone icon to display the Edit Icon dialog and select 
Data\Identity to display the Identity page:

6. In the Identity box replace the text Payphone 1 with the following information:

Do not close the Edit Icon dialog

02703 871 117 
Station Lobby 
Caledonian Road
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.

You can add grading information to chart items such as entities and links. The 
information about the payphone that you have just added was taken from police 
observations and subsequent timings so you know that it has been obtained from a 
trustworthy source. Add grading information to the payphone to show this. To do 
this:

1. Select Data\Description & Grades to display the Description & Grades page:

2. To set Grade 1, from the Grade 1 drop-down list, select A.

3. To set Grade 2, from the Grade 2 drop-down list, select 1.

4. To set Grade 3, from the Grade 3 drop-down list, select 5.

You have now finished adding grading information to the payphone.

5. The information about the payphone was obtained from police records. Use 
this as the source type by selecting Record from the Type drop-down list.

6. The information was obtained from a particular police record. In the Reference 
box type RZ/2.

7. Click OK to close the Edit Icon dialog.

How do I add grading information to an icon?
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The payphone is displayed on your chart:

8. Click the Save toolbar button to save your chart.

You can easily add several icons of the same type to your chart without having to 
click the Insert Icon toolbar button each time you add an icon.

Records show that, when FARMER made a call from the payphone in the station 
lobby during his meeting with the undercover officer, he called a telephone 
(07786 162 534). This call was diverted to another telephone (07787 563 412) 
believed to be owned by Marc BAKER. Add two telephones to your chart, one for 
the number that FARMER called (07786 162 534) and one for the telephone 
belonging to Marc BAKER (07787 563 412). To do this:

1. Click the drop-down arrow on the Insert Icon toolbar button, select Telecoms ➧ 

Telephone to select the Telephone type from the Telecoms palette.

2. Before you place this icon on the chart, double-click on the Insert Icon toolbar 
button. This will put Analyst’s Notebook into Insert mode.

3. Click on the chart below the Payphone to place a telephone on it.

4. Notice that your mouse pointer is still a Telephone icon. Click on the chart 
again, this time below the telephone that you have just added, to add a second 
telephone.

5. The pointer is still in Insert mode. To exit Insert mode, click the Select/Move 
toolbar button.

6. In the same way that you added information to the payphone, add the following 
information to the first telephone that you added:

02703 871 117
Station Lobby

Caledonian Road

How do I add multiple entities of the same type?

Identity 07786 162 534

Grades A 1 5

Source Type Record

Source Reference RZ/3
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7. Add the following information to the second telephone that you added:

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Identity 07787 563 412

Grades A 1 5

Source Type Record

Source Reference RZ/4

07786 162 534

02703 871 117
Station Lobby

Caledonian Road

07787 563 412
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You have now received further information that the telephones you added to your 
chart are actually cellphones. Change the entity type for the Telephone entities to 
be Cellphone entities. To do this:

1. Click on the drop-down arrow in the palette bar area and select Telecoms to 
display the Telecoms palette.

2. Select the Cellphone entity type and while holding down the left mouse button, 
drag it over telephone number 07786 162 534. As you drag the Cellphone 
entity type over the Telephone entity the pointer changes to show that the 
Telephone entity will be replaced with a Cellphone entity:

3. Release the left mouse button. The Telephone entity is replaced with a 
Cellphone entity.

4. Replace the Telephone entity for telephone number 07787 563 412 in the same 
manner.

How do I change the type of an entity on a chart?
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

You can add links between entities in the same way that you added links between 
event frames in Chapter 1, Introducing Some Basic Features. Add links to show 
that FARMER called Cellphone 07786 162 534 which was diverted to Cellphone 
07787 563 412 and add grading information to these links. To do this:

1. Click the drop-down arrow on the Insert Link toolbar button, select Telecoms ➧ 

Telephone Call to select the Telephone Call link type from the Telecoms 
palette.

2. Add a link between Payphone 02703 871 117 and Cellphone 07786 162 534 in 
the same way that you added links between event frames in How do I link 
items? on page 49.

07786 162 534

02703 871 117
Station Lobby

Caledonian Road

07787 563 412

How do I add links between entities?
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In the same way that you added grading information to icons, you can add grading 
information to links. Add grading information to the link that you have just added 
between the Payphone and Cellphone 07786 162 534. To do this:

1. Double-click on the link label to display the Edit Link dialog and select 
Data\Identity to display the Identity page:

2. In the Label box edit the label to be 1 to represent a single telephone call 
between the Payphone and Cellphone 07786 162 534. 

Do not close the Edit Link dialog.
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1. Select Data\Description & Grades to display the Description & Grades page:

2. Add the following grading information:

3. Click OK to close the Edit Link dialog.

4. Using the same method, add a link of type Telephone Call, found on the 
Telecoms palette, between Cellphone 07786 162 534 and Cellphone 07787 
563 412.

5. Edit the label of this link to be Diverts to. This link represents the 
information that the telephone call made from the Payphone was diverted to 
Cellphone 07787 563 412.

How do I add grading information to a link?

Grades A 1 5

Source Type Record

Source Reference RZ/5
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6. Add the following grading information to this link:

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Grades A 1 5

Source Type Record

Source Reference RZ/6

1

Diverts to

07786 162 534

02703 871 117
Station Lobby

Caledonian Road

07787 563 412
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Labeling and Uniquely Identifying Entities 2.3

Each entity in a chart has a label and an identity, both of which are textual. The 
label is displayed on the chart as part of the entity, whereas the identity is one of 
the properties of the entity stored inside the chart. 

In general the label and identity are the same, and by default the label simply 
reflects the identity. For example, the Cellphone icon created previously has 
07787 563 412 as its identity and label. In some cases, the label may differ from 
the identity and as a result, the identity is not apparent from the appearance of the 
chart.

An entity’s identity is always unique within a chart. This enables entities to be 
copied back and forth between charts without unwanted duplication. It is important 
to choose something suitable for the identity, such as a person’s name, a car’s 
license plate, or a bank account number. If you attempt to set an identity for an 
entity that is the same as one already used in the chart, the identity text will 
change color to warn you that this will not be accepted.

In contrast to an identity, an entity’s label does not have to be unique. 
Nevertheless, it is potentially confusing to have more than one entity on a chart 
with the same label, so you should be careful when using labels that are different 
from the identity. One instance where it is useful to have duplicate labels is for the 
purposes of annotation, for example you may have several entities with the label 
“No subscriber details”.

Label Stored inside
chart

Label
Identity

Displayed
on chart

Paul Mr X

Mr X
Paul

Paul
Paul
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Naming 
conventions

Every character of an entity’s identity is significant, including its case. To avoid 
inadvertently duplicating entities, and to ensure that you can subsequently find 
entities in the chart, it is recommended that you adopt a consistent convention for 
identifying entities. Such a convention should cover:

• Character case. “Black Car” and “black car” are different because the case of 
the leading characters of the two words is different. The convention used for 
people’s names within this guide is for the last name to be in upper case and 
any other names to have initial capitals; for example, “Marc BAKER”.

• Word separators. “Black Car”, “Black   Car” and “Black-Car” are all different, as 
are the telephone numbers “340 529 8114” and “340-529-8114”, because the 
characters separating the words (or digit groups) are different. A common 
convention is to use a single space to separate words.

• Leading and trailing spaces. “ Black Car”, “Black Car ” and “Black Car” are all 
different because the characters at the beginning and end are different. Avoid 
leading and trailing spaces.

It is, therefore, good working practice to maintain consistency within your charts for 
ease of use and presentation purposes.

Event frames People, vehicles, and bank accounts are identifiable and distinct objects. Choosing 
identities for these types of objects is straightforward. A happening, however, can 
be indistinct, for example you could have more than one event frame on your chart 
called “Meeting in bar”. This means that an event frame does not have an obvious 
identity. It is important that you follow a coherent naming scheme for event frames, 
so that identities are unique within a chart, and to permit automatic merging of 
entities when combining charts. 
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For example, an identity for an event frame could have three parts:

• a concise description, such as the entity type name, for example Meeting, 
Sighting

• the associated object(s), for example the theme line(s) to which the event 
frame is connected

• the date and time that the happening took place

The event frame below, shows a sighting of Sam STEELE in a bar in the harbor. 
Following the above naming convention, its identity could be “Sighting, Sam 
STEELE, 01 Jan 2006 13:20”. This identity is unsuitable for the event frame’s label 
so a different label, “Seen in bar in harbor”, has been used.

You have received information that Marc BAKER is the owner of Cellphone 07786 
162 534. Add Marc BAKER to the chart. To do this:

1. Click the drop-down arrow on the Insert Icon toolbar button and select 
Individuals ➧ Male to select the Male type from the Individuals palette.

2. Place the Male icon to the left of Cellphone 07786 162 534 and add the 
following information to it:

How do I add an entity with a label that is different to its identity?

Sam STEELE

A 1 5

01 Jan 2006 13:20

WS 5671Witness

Sam STEELE was seen in
a bar in the harbor.

Seen in bar in harbor

Label: Seen in bar in harbor

Identity: Sighting, Sam STEELE, 01 Jan 2006 13:20

Identity Marc BAKER

Grades A 1 5

Source Type Record

Source Reference RZ/7
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3. Add a Subscriber link type from the Telecoms palette and place it between 
Marc BAKER and Cellphone 07786 162 534.

You have no subscriber information for Cellphone 07787 563 412. Add an 
Anonymous icon to the chart and link it using a Subscriber link type to Cellphone 
07787 563 412. To do this:

1. Add an Anonymous icon from the Individuals palette and place it to the right of 
Cellphone 07787 563 412.

Subscriber

Diverts to

1

Marc BAKER

07787 563 412

07786 162 534

02703 871 117
Station Lobby

Caledonian Road
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2. Double-click on the Anonymous icon to display the Edit Icon dialog and select 
Data\Identity to display the Identity page:

3. In the Identity box type Subscriber - 07787 563 412.

4. Turn on the Label is Different From Identity check box.

5. In the Label box type:

6. Click OK to close the Edit Icon dialog.

No subscriber 
details available
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7. Add a Subscriber link type, from the Telecoms palette, between “No subscriber 
details available” and Cellphone 07787 563 412 as shown below:

Subscriber

Subscriber

Diverts to

1

No subscriber
details available

07787 563 412

02703 871 117
Station Lobby

Caledonian Road

07786 162 534Marc BAKER
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You have obtained further information relating to Marc BAKER. You know that he is 
the owner of a Black Saab 900 car and has an office address in Crownsville. Add 
this information to the chart and use appropriate link types to show the 
relationships. To do this:

1. Add a Car icon type, from the Transport palette and place it above Marc 
BAKER on the chart. Add the following information to it:

2. Add an Owner link type, from the Individuals palette, between Marc BAKER 
and the Black Saab 900. Add the following grading information to this link:

3. Add an Office icon type, from the Locations palette, place it below Marc BAKER 
and add the following information to it:

Adding further information

Identity 456 FGT
Black Saab 900

Description Marc BAKER’s car.

Grades A 1 5

Source Type Record

Source Reference RZ/8

Grades A 1 5

Source Type Record

Source Reference RZ/9

Identity Box 518 
Finchley Road
Crownsville

Grades A 1 5

Source Type Record

Source Reference RZ/10
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4. Add an Address link type, from the Individuals palette, between Marc BAKER 
and Box 518 Finchley Road.

5. Edit the name of the Address link to be Mailing Address and add the 
following grading information to it:

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Grades A 1 5

Source Type Record

Source Reference RZ/11

Subscriber

Subscriber

Owner

Mailing Address Diverts to

1

No subscriber
details available

07787 563 412

02703 871 117
Station Lobby

Caledonian Road

Marc BAKER 07786 162 534

456 FGT
Black Saab 900

Box 518
Finchley Road
Crownsville



Using Additional Features of Links

94 i2 Analyst’s Notebook 8 User Guide: Creating Charts

Using Additional Features of Links 2.4

A link is a chart item representing a connection between entities, for example 
icons, boxes and event frames.

In the same way that you can specify the display settings for entity types you can 
specify the display settings for link types, so you can choose to display, for example 
a date and time, description, grades, pin, and so on.

A connection shows an association between two chart items, represented by one 
or more links. There are three styles of connection:

• single 

• directed

• multiple

Single 
connection

A single connection contains only one link between two entities, that may or may 
not have one or more arrowheads.

The example below shows a single connection between John and Mary that shows 
that they are associated through marriage. The link has no arrowhead:

The example below, shows a single connection between two bank accounts 
showing a money transfer between them. This connection has an arrowhead:

Directed 
connection

The connection between two entities is represented by one link for each possible 
direction. A directed connection can contain up to four links and can comprise up 
to one link without an arrowhead and three links with arrowheads. 

Links with arrowheads can be:

• from Entity A to Entity B

• from Entity B to Entity A

• arrowheads at both ends

• no arrowheads

Married

John Mary

$2000

0012-3963 8430-2253
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The example below illustrates a directed connection:

Note: A directed connection cannot have more than one link of each kind. 

Multiple 
connection

A multiple connection can contain any number of links, with or without arrowheads. 
Each link between two entities is displayed individually.

The example below shows a multiple connection between two entities:

You have received telephone billing data that shows four calls were made between 
Cellphone 07787 563 412 and Cellphone 07786 162 534. Add these links to your 
chart and show the direction of the telephone calls. To do this:

1. Click the drop-down arrow on the Insert Link toolbar button and select 
Telecoms ➧ Telephone Call to select the Telephone Call link type from the 
Telecoms palette.

2. While holding down the Shift key, draw four Telephone Call links between 
Cellphone 07787 563 412 and Cellphone 07786 162 534.

Note: Release the Shift key before you add the fourth link to the chart.

3. Edit the label of each of these links to be Called.

Both ends

A to B

B to A

No arrowheads

Entity BEntity A

A to B

No arrowheads

B to A

A to B

Both ends

No arrowheads

A to B

Entity A Entity B

How do I add multiple links?
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4. Select each of the Telephone Call links in turn and add the following 
information to them:

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Grades A 1 5

Source Type Record

Source Reference (first link) RP1

Source Reference (second link) RP2

Source Reference (third link) RP3

Source Reference (fourth link) RP4

Mailing Address

Owner

Subscriber

Subscriber

Diverts toCalledCalledCalled Called

1

No subscriber
details available

07787 563 412

02703 871 117
Station Lobby

Caledonian Road

07786 162 534

Box 518
Finchley Road
Crownsville

456 FGT
Black Saab 900

Marc BAKER
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In addition to the link label, you want to show the source reference on each of the 
links between Cellphone 07787 563 412 and Cellphone 07786 162 534. You can 
edit the display properties of multiple links in one quick step. To do this:

1. Select all five links between the two cellphones.

Note: To select all of the links, right-click on one of them, and from the 
shortcut menu, select Select Sibling Links.

2. Right-click on one of the selected links, and from the shortcut menu, select 
Combined Properties. This displays the Edit Chart Items dialog. The title bar 
shows that five chart items are selected. Select Style\Links\Display to display 
the Display page:

3. In the Display area turn on the Source Reference check box.

4. Click OK to close the Edit Chart Items dialog.

How do I change the display properties of multiple links?
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Your chart should now look similar to that below, with the source reference 
displayed on each of the links:

Click the Save toolbar button to save your chart.

You want to show the direction of the calls between all of the telephones on your 
chart. To do this:

1. Right-click on the link between the Payphone and Cellphone 07786 162 534, 
and from the shortcut menu, select Add Arrow.

Note: If the arrowhead points in the wrong direction (you want to show that the 
call was made from the Payphone to Cellphone 07786 162 534) you can 
reverse it so that it is points in the other direction. To do this, right-click 
on the link, and from the shortcut menu, select Reverse Arrow.

Mailing Address

Owner

Subscriber

Subscriber

RZ/6
Diverts to

RP1
Called

RP2
Called

RP3
Called

RP4
Called

1

No subscriber
details available

07787 563 412

02703 871 117
Station Lobby

Caledonian Road

Marc BAKER 07786 162 534

Box 518
Finchley Road
Crownsville

456 FGT
Black Saab 900

How do I add direction to a link?
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2. Right-click on the link with source reference RP1, between Cellphone 07786 
162 534 and Cellphone 07787 563 412, and add an arrowhead so that the 
direction of the link flows from Cellphone 07787 563 412 to Cellphone 
07786 162 534.

3. Add direction to the remaining links as follows:

The Telephone Call links are difficult to read as their labels overlap. Rearrange the 
labels on the links between Cellphone 07786 162 534 and Cellphone 07787 563 
412 so that you can read each label. To do this:

1. Right-click on one of the links between Cellphone 07786 162 534 and 
Cellphone 07787 563 412, and from the shortcut menu, select Select Sibling 
Links.

All of the links between the two cellphones are selected:

2. With all of the links still selected, from the Tools menu, select Arrange Link 
Labels.

Source Reference: RP2 From: 07787 563 412 To: 07786 162 534

Source Reference: RP3 From: 07787 563 412 To: 07786 162 534

Source Reference: RP4 From: 07786 162 534 To: 07787 563 412

Link Label: Diverts to From: 07786 162 534 To: 07787 563 412

How do I rearrange labels on multiple links?

RP4
Called

RP3
Called

RP2
Called

RZ/6
Diverts to

RP1
Called

07786 162 534

07787 563 412



Using Additional Features of Links

100 i2 Analyst’s Notebook 8 User Guide: Creating Charts

The link labels are rearranged so that they no longer overlap.

Note: You may still not be able to clearly see the link labels. Move a label by 
selecting it and while holding down the Alt key, dragging it to a new 
position on the chart.

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Owner 1

Subscriber

Subscriber

RZ/6
Diverts to

Mailing Address

RP1
Called

RP4
Called

RP3
Called

RP2
Called

No subscriber
details available

07787 563 412

07786 162 534

02703 871 117
Station Lobby

Caledonian Road

Marc BAKER

456 FGT
Black Saab 900

Box 518
Finchley Road
Crownsville



 Chapter 2: Handling Chart Items

i2 Analyst’s Notebook 8 User Guide: Creating Charts 101

Adding Information Using Other Representations 2.5

Entities can represent, for example, individuals, locations, organizations or objects. 
An entity can have any of the following representations:

Records show that Marc BAKER is on the board of directors at Arcacia 
Investments. Add Arcacia Investments to your chart, represented as a box, using 
an Organization type and show that Marc BAKER is on the board of directors. To 
do this:

1. Click the drop-down arrow on the Insert Box toolbar button and select 
Standard ➧ Organization to select the Organization type from the Standard 
palette.

Icon Often used to represent objects, for example people, places 
or commodities.

Theme line Represents one of the key elements of your investigation, for 
example a victim, witness, suspect or location. Theme lines 
provide a common thread, typically to represent a sequence 
of events over time.

Event frame Represents a happening on your chart, typically an event that 
happened at a specific time, for example a meeting or an 
appointment.

Box Typically used to enclose items of interest, for example a 
place, organization, or a group.

Circle, Text block Often used for annotation on a chart.

OLE object An object from another Windows application, for example a 
text file, audio file or video clip that you can add to your chart. 
For further information on OLE objects, refer to Including 
Files in a Chart using OLE Objects on page 160.

How do I add a box to my chart?
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The Organization type may not be immediately visible on the Standard palette. 
If you cannot see it:

a. Select Standard ➧ More Types to display the Select Type to Insert dialog:

b. Scroll down the list of text block types and select Organization.

c. Click OK to close the dialog.

The pointer changes to a crosshair:

2. While holding down the left mouse button click on the chart just above and to 
the left of Marc BAKER. With the left mouse button still held down, drag a box 
around Marc BAKER. When you have finished drawing the box, release the left 
mouse button. An Organization, represented as a box, is placed on the chart 
around Marc BAKER:

Organization 1

Marc BAKER



 Chapter 2: Handling Chart Items

i2 Analyst’s Notebook 8 User Guide: Creating Charts 103

3. Add the following information to this box, in the same way that you added 
information to icons:

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Identity Arcacia Investments

Grades A 1 5

Source Type Record

Source Reference RB/1

Owner 1

Subscriber

Subscriber

RZ/6
Diverts to

Mailing Address

RP4
Called

RP1
Called

RP2
Called

RP3
Called

Arcacia Investments

07787 563 412 No subscriber
details available

07786 162 534

02703 871 117
Station Lobby

Caledonian Road

Box 518
Finchley Road
Crownsville

Marc BAKER

456 FGT
Black Saab 900
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Arcacia Investments is the registered owner of a cruiser called MOONSHADOW. 
Add MOONSHADOW to your chart and a link to show that Arcacia Investments is 
the registered owner. To do this:

1. Click the drop-down arrow on the Insert Icon toolbar button and select 
Transport ➧ Cruiser to select the Cruiser type from the Transport palette.

2. Place the cruiser on your chart to the left of Box 518, and add the following 
information to it: 

3. Add a link between Arcacia Investments and MOONSHADOW. To do this:

a. Select the Owner link type from the Individuals palette.

b. Draw the link from any part of the Arcacia Investments box to 
MOONSHADOW.

4. Add the following information to this link: 

Adding more entities and links

Identity MOONSHADOW

Grades A 1 5

Source Type Record

Source Reference RB/2

Label Registered Owner

Grades A 1 5

Source Type Record

Source Reference RB/3
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5. You have obtained information about a Mr STEELE, an associate of Marc 
BAKER. 

Add a Male icon, from the Individuals palette and place it to the left of Marc 
BAKER and add the following information to it:

6. Show that Marc BAKER and Mr STEELE are associates by adding a link of 
type Associates, from the Individuals palette, between Marc BAKER and Mr 
STEELE and adding the following information to it:

7. Records show that Mr STEELE lives at 5 Silver Street, Crownsville. 

Add a House icon type, from the Locations palette, place it below Mr STEELE 
on your chart and add the following information to it:

Identity Mr STEELE

Grades A 1 5

Source Type Record

Source Reference RB/4

Grades A 1 5

Source Type Record

Source Reference RB/5

Identity 5 Silver Street
Crownsville

Grades A 1 5

Source Type Record

Source Reference RB/6



Adding Information Using Other Representations

106 i2 Analyst’s Notebook 8 User Guide: Creating Charts

8. Show that Mr STEELE lives at 5 Silver Street by adding an Address link type, 
from the Locations palette, between Mr STEELE and 5 Silver Street.

9. Add grading information to this link as follows:

Your chart should look similar to that below:

Click the Save toolbar button to save your chart.

Grades A 1 5

Source Type Record

Source Reference RB/7

Associates

Registered Owner
Mailing AddressAddress

Owner 1

Subscriber

Subscriber

RZ/6
Diverts to

RP1
Called

RP4
Called

RP3
Called

RP2
Called

Arcacia Investments

07787 563 412 No subscriber
details available

07786 162 534

02703 871 117
Station Lobby

Caledonian Road

Box 518
Finchley Road
Crownsville

Marc BAKER

456 FGT
Black Saab 900

MOONSHADOW5 Silver Street
Crownsville

Mr STEELE
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Unsubstantiated evidence has been obtained that a man called Stuart WRIGHT 
crews on board MOONSHADOW. Add Stuart WRIGHT to your chart and then 
show that the information that he crews on board MOONSHADOW is unconfirmed. 
To do this:

1. Add a Male icon, from the Individuals palette, place it below MOONSHADOW 
and add the following information to it:

2. Using the General link type, from the Standard palette, add a link between 
Stuart WRIGHT and MOONSHADOW and add the following information to it:

How do I change the line strength of a link?

Identity Stuart WRIGHT

Grades A 1 5

Source Type Record

Source Reference RB/8

Label Believed to crew 
on vessel

Grades C 3 5

Source Type Informant

Source Reference Statement 213
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3. Change the line strength of the link between Stuart WRIGHT and 
MOONSHADOW to show that the information that he crews on board the 
vessel is unconfirmed. To do this, right-click on the link between Stuart 
WRIGHT and MOONSHADOW and select Strength ➧ Unconfirmed from the 
shortcut menu.

The link between Stuart WRIGHT and MOONSHADOW is now dashed to indicate 
that it is unconfirmed information:

Believed to crew
on vessel

MOONSHADOW

Stuart WRIGHT
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Mr STEELE is the subject of another investigation by police and customs officers 
relating to the importation of drugs, money laundering and forgery. The information 
that has been received as part of their investigation may be linked to this 
investigation. Add a text block to your chart to show this information. To do this: 

1. Click the drop-down arrow on the Insert Text Block toolbar button and select 
Standard ➧ Blue to select the Blue type from the Standard palette.

The Blue text block may not be immediately visible on the Standard palette. If 
you cannot see it:

a. Select Standard ➧ More Types to display the Select Type to Insert dialog:

b. Scroll down the list of Text Block types and select Blue.

c. Click OK to close the dialog.

Place the text block to the left of Mr STEELE.

How do I add a text block to my chart?
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2. Double-click on the label of the text block that you have just added to your chart 
to display the Edit Text Block dialog:

3. Select Data\Identity and edit the Identity of the text block to be:

Do not close the Edit Text Block dialog.

4. Select Data\Description & Grades and add the following information:

Do not close the Edit Text Block dialog.

5. You do not know if the information from the investigation by the police and 
customers is relevant to this investigation, therefore this information is tentative. 
Select Style\Type and from the Line Strength drop-down list, select 
Tentative.

6. Select 3 from the Width drop-down list to change the line width to be 3.

Target in Operation Crest.
A joint police and customs investigation 
into drug importation, money laundering and 
forgery.

Grades A 1 5

Source Type Officer

Source Reference RB/11
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7. Click OK to close the Edit Text Block dialog. 

The text block is displayed on your chart with a thick blue dotted line around it:

You may not be able to see all of the text in your text block. If this is the case, resize 
it so that the text fits. To do this:

1. Click on the text block.

When the text block is selected the text is highlighted and eight small blue 
squares are displayed around the edges of the text block. These small blue 
squares are known as drag handles. 

Move your pointer over one of the drag handles, the pointer changes to:

While holding down the left mouse button, drag the box until the text fits in it 
and then release the left mouse button.

2. Add a General link, from the Standard palette, between Mr STEELE and the 
text block. Delete the label on this link.

3. Right-click on the link label and from the shortcut menu, select Strength ➧ 

Tentative. The line strength of the link is shown as a dotted line on your chart.

4. Add an arrowhead to the link to show direction from Mr STEELE to the text 
block.

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

How do I resize a text block?

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Text labels can be used to annotate your chart, for example you may want to 
display the title of your chart. Add a text label to your chart so that the chart is 
named after the event that triggered this investigation which was when FARMER 
made a call from the payphone. To do this:

1. Click the Insert Label toolbar button, the pointer changes to:

2. Click on the chart just above and to the left of the other items to add the label.

3. Edit the name of this label to be Call made by FARMER.

Associates

Believed to crew
on vessel

Mailing AddressAddress

Owner 1

Subscriber

Subscriber

Registered Owner

RZ/6
Diverts to

RP4
Called

RP1
Called

RP2
Called

RP3
Called

Arcacia Investments
Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

07787 563 412 No subscriber
details available

07786 162 534

02703 871 117
Station Lobby

Caledonian Road

Box 518
Finchley Road
Crownsville

Marc BAKER

456 FGT
Black Saab 900

MOONSHADOW5 Silver Street
Crownsville

Mr STEELE

Stuart WRIGHT

How do I add a text label to a chart?
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The text label that you have just added to your chart is not very easy to read. You 
want it to stand out from the other items on your chart. Change its font properties 
so that the text is displayed bold and underlined, and the font size is larger. To do 
this:

1. Double-click the text label to display the Edit Label dialog and select Style\Font 
to display the Font page:

2. To change the font so that it is displayed bold and underlined:

a. In the Font Style list, select Bold.

b. In the Effects area, turn on the Underline check box.

3. Make the font size larger; select 14 from the Size list. 

Note: The Sample box displays a sample of the font as it will appear on the 
chart.

4. Click OK to close the Edit Label dialog. 

How do I change the font properties of a text label?
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Associates

Believed to crew
on vessel

Mailing AddressAddress

Owner 1

Subscriber

Subscriber

RZ/6
Diverts to

Registered Owner

RP4
Called

RP1
Called

RP2
Called

RP3
Called

Arcacia Investments

Call made by FARMER

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

Stuart WRIGHT

07787 563 412 No subscriber
details available

07786 162 534

02703 871 117
Station Lobby

Caledonian Road

Box 518
Finchley Road
Crownsville

Marc BAKER

456 FGT
Black Saab 900

MOONSHADOW5 Silver Street
Crownsville

Mr STEELE
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Tidying up a Chart 2.6

If you have a large chart with many items on it, it may be difficult to read because 
links may be crossed or entities may overlap. 

There are actions you can take to tidy up your chart; for example when you created 
the links between the telephone calls, you moved the link labels to make the 
information easier to read.

Corners can also be used to tidy up a chart. A small dot is placed on a link on your 
screen to divide the link into sections. A corner allows you to bend a link to improve 
the chart appearance and prevent overlapping of labels. Depending on the 
complexity of your chart, links may contain one or more corners. 

The chart that you have created so far is now looking cluttered. Tidy up your chart 
by adding corners to some of the links. To do this

1. Click the Insert Corner toolbar button. Your pointer changes to:

2. Position your pointer just below the link label on the link between Arcacia 
Investments and MOONSHADOW, and click with the left mouse button. 

A corner is placed on the link line represented by a small black diamond.

Note: You can remove a corner from a link line by selecting it and pressing the 
Delete key.

How do I add corners to a link?

Corner



Tidying up a Chart

116 i2 Analyst’s Notebook 8 User Guide: Creating Charts

3. Click the corner and, while holding down the left mouse button, drag the link to 
reposition it so that the link looks similar to the example below:

Note: You will have to drag the MOONSHADOW and Stuart WRIGHT icons to 
the left so that the link is at right angles to Arcacia Investments and 
MOONSHADOW.

Some of the labels on the links are not easy to read as they are overlapped by 
other items on the chart. It would be easier to read these labels if you moved the 
links. To do this:

1. Click on one of the Telephone Call links between Cellphone 07786 162 534 
and Cellphone 07787 871 117.

2. Hold down the Shift and Alt keys, and while holding down the left mouse button, 
drag the link to one side. 

How do I pull multiple links apart?
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The link is moved. You should now be able to clearly see the link label.

3. In the same way, move the remaining Telephone Call links.

When you have finished tidying up your chart it should look similar to that below 
(Example 2 finished.anb):

Click the Save toolbar button and close your chart.

RZ/6
Diverts to

RP4
Called

RP3
Called

RP2
Called

RP1
Called

07786 162 534

07787 563 412

Registered Owner

Believed to crew
on vessel

Mailing Address

Subscriber

Subscriber

1Owner

Associates

Address

RP1
Called

RP3
Called

RP2
Called

RZ/6
Diverts to

RP4
Called

Arcacia Investments

Stuart WRIGHT

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

Call made by FARMER

No subscriber
details available

Box 518
Finchley Road
Crownsville

Marc BAKER 07786 162 534

02703 871 117
Station Lobby

Caledonian Road

456 FGT
Black Saab 900

MOONSHADOW5 Silver Street
Crownsville

Mr STEELE

07787 563 412
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Summary 2.7

In this example, you will have learned how to:

• add grading information to chart items

• label and uniquely identify entities

• use additional features of links

• use other representations to add information

• tidy up a chart by adding corners, rearranging link labels, and pulling links 
apart
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3
Adding Cards and Attributes

This chapter describes how to add cards and attributes to items on your chart.
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Summary 148



Introduction

120 i2 Analyst’s Notebook 8 User Guide: Creating Charts

Introduction 3.1

The features covered in detail in this example are:

• adding information using cards

• adding information using attributes

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished chart (Example 3 finished.anb) at any time while 
you are working through this example. To access the folder in which this chart is 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i2\i2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.

Scenario

You have already added information to a chart about the happenings that took 
place when FARMER called his supplier during the meeting with the undercover 
officer.

You now have further information relating to the people, addresses, telephones, 
and telephone calls that you want to add to your chart.
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Adding Information Using Cards 3.2

As an investigation progresses, you will generally receive more information about 
suspects, locations or associations that you have added to your chart. This 
additional information can be added to chart items using cards. A card acts as a 
reference card, allowing you to enter information as you receive it. Cards can be 
added to links and entities but cannot be added to text labels.

The information you receive can be specific to one item on your chart. However 
there may be occasions when information is relevant to more than one item on the 
chart. It is very easy to copy cards from one item and add them to another item on 
the same, or a different, chart. You can add as many cards as you wish to each 
chart item. You can edit a card, for example to add more information to it and delete 
a card, for example if you have added the information in error.

You can add the following information to a card:

Summary A single line of text summarizing the 
information in the card.

Date & Time The date and time that an event occurred or 
the card was created.

Description of Date & Time A non-specific date and time, for example a 
happening that took place after lunch.

Description The main text of the card showing the 
information you wish to record on it.

Grades The reliability of the information.

Source Type A description of the source of the information. 
Examples of source types are Officer, Witness, 
Record. 

Source Reference A reference for the information provided. An 
example of a source reference is a document 
reference number.
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In Chapter 2, Handling Chart Items, you created a chart and added information to 
it. In this example you will continue to use this chart and add further information to 
it.

You have obtained information that the Black Saab 900 owned by Marc BAKER is 
often seen parked around the harbor in Poole. Add this information to the Black 
Saab 900 as a card. To do this:

1. Open the chart Example 3 initial.anb. To access the folder in which this 
chart is stored, double-click on the User Guide Example Material shortcut in 
the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-
click on the Creating Charts folder.

2. Save this chart; from the File menu select Save As. Click OK on the Cover 
Sheet dialog to display the Save As dialog. Select the folder you created to 
save your charts in. Type Example 3 adding cards.anb in the File Name 
box and click Save.

3. Double-click on the Black Saab 900 to display the Edit Icon dialog.

How do I add a card to a single entity or link?

Mailing Address
RZ/6

Diverts to

1

Subscriber

Owner

Address

Believed to crew
on vessel

RP3
Called

RP2
Called

RP1
Called

RP4
Called

Associates

Registered Owner

Subscriber

Arcacia Investments

Call made by FARMER

Mr STEELE

5 Silver Street
Crownsville

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

MOONSHADOW

Stuart WRIGHT

Marc BAKER

02703 871 117
Station Lobby

Caledonian Road

07787 563 412

07786 162 534

No subscriber
details available

456 FGT
Black Saab 900

Box 518
Finchley Road
Crownsville



 Chapter 3: Adding Cards and Attributes

i2 Analyst’s Notebook 8 User Guide: Creating Charts 123

4. Select Cards to display the Cards page:

5. Click New. A new empty card is created for you to add information to:
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Before you start adding information to this card it is useful to know what you can 
enter in each box. The online help provides procedural information about how to 
perform an action in Analyst’s Notebook as well as information about specific 
dialogs. Open the online help to find out what you should enter in each box in this 
dialog. To do this:

1. Click Help. 

The online help topic that is associated with how to edit card properties is 
displayed:

How do I access the online help?
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2. Using the text in the online help to assist you, add the following information to 
the card:

3. Click the small Close button at the top right of the Help window to close it.

4. Click OK to close the Edit Icon dialog.

When you created a card on the Black Saab 900 you did not add the license plate 
information. You know that the license plate of this car is 456 FGT. Edit this card to 
add the license plate information, use What’s This? Help to find out how to add 
this. To do this: 

1. Double-click on the Black Saab 900 to display the Edit Icon dialog.

Summary Seen parked

Date & Time 22 Aug 2006 (No time)

Description Seen parked at Poole Harbor.
Registered keeper, since new, Marc BAKER.

Grades A 1 5

Source Type Officer

Source Reference DS 9870/01

How do I access the What’s This Help?
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2. Select Cards\Card 1: Seen parked to display the card that you have just 
added:

3. Click the What’s This? Help button on the top right of the Edit Icon dialog and 
then click in the Description box. A popup window containing help for the 
Description box is displayed:

4. Follow the online help instructions to edit your text and add the following 
information to the description: License plate 456 FGT.

5. Click OK to close the Edit Icon dialog.

6. Click the Save toolbar button to save your chart.

Create cards on each of the following chart items in the same way that you added 
a card to the Black Saab 900. Use a combination of the online help and the What’s 
This? Help to assist you.
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1. Marc BAKER uses a Box number for his mail. Create a new card on the icon 
Box 518, Finchley Road, Crownsville and add the following information to it:

2. FARMER called his supplier from the payphone in the station lobby. Add a new 
card to the Payphone and add the following information to it:

Adding more cards

Summary Known mailing address

Description Known mailing address. Marc BAKER receives 
correspondence at this address. He collects it 
every Monday and Friday morning at 09:30.

Grades A 1 5

Source Type Record

Source Reference DS 3451/02

Summary Call

Date & Time 29 Sep 2006 12:59

Description FARMER was observed making a call to his 
supplier. He used the payphone sited near the 
ticket office at the station.

Grades A 1 5

Source Type Officer

Source Reference DS 3451/03
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3. Add a card to Marc BAKER to show his connection with Arcacia Investments:

4. Add a card to the link between the Payphone and Cellphone 07786 162 534 to 
show that FARMER called this cellphone from the payphone and add the 
following information to it: 

5. Further information has been received that Mr STEELE lives with another 
person at 5 Silver Street. Add a new card to Mr STEELE and add the following 
information to it: 

Summary Company positions

Description Records show Marc BAKER is on the board of 
directors of Arcacia Investments.

Grades A 1 5

Source Type Record

Source Reference PR/023b

Summary Call information

Date & Time 29 Sep 2006 12:59

Description Call information from the payphone shows a call to 
this cellphone around the time FARMER called his 
supplier from the payphone.

Intelligence Grades A 1 5

Source Type Record

Source Reference TK 318/01

Summary Living with S DIAMOND

Description Mr STEELE is shown to be living at this address 
with someone named S DIAMOND.

Intelligence Grades A 1 5

Source Type Record

Source Reference PR/890/01
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You have already added a card to Mr STEELE showing that he shares the house at 
5 Silver Street with someone called S DIAMOND. Add this card to 5 Silver Street. 
To do this:

1. Double-click on Mr STEELE to display the Edit Icon dialog.

2. Click Cards\Card List. 

3. The Living with S DIAMOND card that you added to Mr STEELE is listed at the 
top of the table.

4. Click on this card to select it and click Copy.

The card, along with all of its information is copied to the clipboard.

5. Click OK to close the Edit Icon dialog.

6. Double-click on 5 Silver Street to display the Edit Icon dialog and select 
Cards\Card List to display the Card List page.

7. Click Paste.

The card that you copied from Mr STEELE is added to 5 Silver Street and is 
listed in the table.

8. Click OK to close the Edit Icon dialog.

How do I copy a card?
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Stuart WRIGHT and Marc BAKER are known associates. Add cards to both of the 
suspects to illustrate this association. To do this:

1. Add a new card to Stuart WRIGHT, as you did before and add the following 
information to it:

2. In the same way that you copied the Living with S DIAMOND card from Mr 
STEELE to 5 Silver Street, copy this card and paste it into Marc BAKER.

3. Click the Save toolbar button to save your chart.

Adding further cards

Summary Association

Description Stuart WRIGHT and Marc BAKER are known 
associates.

Grades B 2 5

Source Type Informant

Source Reference Statement 318
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Some of the information that you have received has been incorrect. Stuart 
WRIGHT and Marc BAKER are not known associates; however, Mr STEELE and 
Marc BAKER are. Remove the card that you added to Stuart WRIGHT and add it to 
Mr STEELE. To do this:

1. Double-click on Stuart WRIGHT to display the Edit Icon dialog and select 
Cards\Card List to display the Card List page: 

2. Select the Association card at the top of the table and click Cut to delete this 
card. 

3. Click OK to close the Edit Icon dialog.

4. Paste this card onto Mr STEELE. 

The Description of this card needs updating: it incorrectly states that Stuart 
WRIGHT is an associate of Marc BAKER. To update the description:

5. Select Cards\Card 2: Association to display the card. 

6. Select the Stuart WRIGHT text in the Description box and type Mr STEELE.

Note: To select the text, position your pointer at the beginning of the text and, 
while holding down the left mouse button, drag it so that the Stuart 
WRIGHT text is selected.

How do I move a card to another item?
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7. Click OK to close the Edit Icon dialog.

8. In the same way that you updated the description in the Association card 
added to Mr STEELE, replace the name Stuart WRIGHT in the Association 
card added to Marc BAKER.

You have added the same card to Marc BAKER and Mr STEELE and updated 
them to show that they are known associates. The card that you added in error to 
Stuart WRIGHT has been removed from him.

You know that Mr STEELE has been living at 5 Silver Street since May 1996 and 
that S DIAMOND started living at this address in April 1997. Edit the Living with S 
DIAMOND card on Mr STEELE and add this additional information. You should 
also add this additional information to 5 Silver Street. To do this: 

1. Edit the Living with S DIAMOND card on Mr STEELE in the same way that you 
edited the card on page 125 and add the following information to the end of the 
description:

2. With the Edit Icon dialog still open, select the text that you have just added so 
that it is highlighted. 

Note: To select the text, position your pointer at the beginning of the text and 
while holding down the left mouse button, drag it so that all of the text 
that you have just added is selected.

3. Press Ctrl+C. The selected text is copied to the clipboard.

4. Click OK to close the Edit Icon dialog.

5. Double-click on 5 Silver Street and select Cards\Card 1: Living with 
S DIAMOND to display the Living with card.

6. Place your pointer at the end of the text in the Description box and press 
Ctrl+V.

The text that you copied from the card on Mr STEELE is appended to the 
description.

7. Click OK to close the Edit Icon dialog.

How do I copy text from one card to another?

Records also show that he has lived at this address since 
May 1996. S DIAMOND moved into this address in April 1997.
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8. Click the Save toolbar button to save your chart.
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As there are now several cards for Mr STEELE, it would be useful to review all of 
the information held for him in a single place. List Cards can be used to select 
chart items which contain cards of interest, sort and compare cards from different 
items, and to see all the properties of selected cards in report form. Use List Cards 
to review all of the cards held for Mr STEELE.

To do this:

1. From the Analysis menu, select List Cards to display the List Cards dialog:

All of the cards that are held in items on your chart are listed.

2. Click the Item column heading so that the cards on Mr STEELE are displayed 
at the top of the list. 

3. As you want to review all of the cards held for Mr STEELE, select both of the Mr 
STEELE rows in the dialog. 

Note: Select the first Mr STEELE row, and while holding down the Ctrl key, 
click on the second Mr STEELE row to select both. 

How do I view a list of all of the cards on my chart?
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4. You can now review a report of these selected cards. Click Report to display 
the Report dialog:

5. This report displays all of the cards held for Mr STEELE. The text in the report 
dialog is selected and it is not clear to read. To make it easier to read, click 
anywhere in the dialog to deselect the text.

6. Click Close to close the Report dialog.

7. Click OK to close the List Cards dialog.
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You have received information that Mr STEELE lives with someone called Sara 
DIAMOND. Some of the cards on this chart contain text that refers to S DIAMOND. 
Find all of the instances of S DIAMOND on the chart and change them to be Sara 
DIAMOND. To do this:

1. From the Edit menu, select Find Text to display the Find Text dialog:

2. In the Find box type S DIAMOND.

3. You want to edit any occurrence of the text “S DIAMOND” to be “Sara 
DIAMOND”. In the Action area select Edit First.

4. Click OK to close the Find Text dialog.

How do I find text in a chart?
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5. The first occurrence of S DIAMOND is contained in a card that you placed on 
Mr STEELE. The Edit Icon dialog for Mr STEELE is displayed with the text for S 
DIAMOND highlighted:

6. With the S DIAMOND text still selected type Sara DIAMOND.

7. Press the F3 key. Find Text finds the next occurrence of S DIAMOND. In the 
same way that you edited the first occurrence, change the next one to be Sara 
DIAMOND.

8. Continue finding all occurrences (six of them in total) of S DIAMOND and 
change them to be Sara DIAMOND. 

9. When all occurrences have been found, a message is displayed that no further 
matches can be found. Click OK to close the message.

10. Click the Save toolbar button to save your chart.
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You can copy the content of your cards into another Windows application, for 
example a Microsoft Word document. Copy the contents of the Company positions 
card on Marc BAKER into Microsoft Word. To do this:

1. Double-click on Marc BAKER to display the Edit Icon dialog and select 
Cards\Card List to display the Card List page:

2. Select the Company positions card and click Copy. The contents of the card 
are copied to the clipboard.

3. Click OK to close the Edit Icon dialog.

4. Start Microsoft Word with a new empty document.

5. Press Ctrl+V to paste the contents of the card into Microsoft Word.

How can I copy card information to other Windows applications?
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All of the details that were contained on the Company positions card, along 
with what the card was attached to (Marc BAKER), are pasted into the 
Microsoft Word document:

6. Close Microsoft Word without saving the document.

7. Click the Save toolbar button to save your chart.
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Adding Information Using Attributes 3.3

Attributes allow you to show specific characteristics of items on your chart. 
Attributes can be added to all chart items. An attribute is typically shown below the 
chart item as a symbol with a value. In the example below, John and Mary both 
have blue eyes and have been married for ten years:

An attribute class is a category of attribute, for example Previous Convictions, that 
is available for use on your chart. Each attribute class has a name, a symbol and a 
type (the type defines the kind of information that the attribute can contain). By 
default, an attribute class is included in the Standard palette, but it can be 
contained in any number of other user palettes.

There are four types of attribute class:

Text Allows you to enter a textual description, for example the 
names of drugs seized, such as Cocaine, Heroin and 
Cannabis.

Number Allows you to enter a value, for example a person’s age, or a 
monetary amount.

Time Allows you to enter a date and time, for example date of birth.

Flag Allows you to enter a value of YES or NO, for example 
whether a person is a known drugs dealer.

An attribute entry comprises an attribute class with a preset value. Attribute entries 
are stored in palettes.

An attribute instance is a single use of an attribute on a chart item. You can create 
attribute instances by:

• adding an attribute class to an item and entering a value

• adding an attribute entry with a fixed value to an item

10 y ears
Married

Blue
Mary

Blue
John
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In the example below, John is British and Mary is Dutch and they have been 
married for ten years:

You know that Box 518 Finchley Road and 5 Silver Street Crownsville are both 
addresses in the UK. Add attributes to each of these addresses to show this. To do 
this:

1. Select Individuals from the drop-down palette list. All of the entity types and 
attribute entries specified in the Individuals palette are displayed in the palette 
bar:

2. Hover your pointer over one of the attribute entries in the palette bar; a tooltip is 
displayed showing the attribute class name.

10 years
Married

Dutch
Mary

British
John

How do I add attributes to items on my chart?
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3. Drag the UK attribute entry from the lower pane of the palette bar and drop it on 
5 Silver Street. 

5 Silver Street is displayed with an attribute instance showing that it is a UK 
address:

4. Repeat step 3 to add a UK attribute to Box 518 Finchley Road.

You can quickly add attributes to chart items using the Attribute Bar. The Attribute 
Bar is displayed in the bottom right corner of the application window, below the 
palette bar. 

Add Nationality attributes to Marc BAKER, Mr STEELE and Stuart WRIGHT to 
show that they are British. To do this:

1. Select Marc BAKER, Mr STEELE and Stuart WRIGHT. To do this, select Marc 
BAKER and then, while holding down the Ctrl key, select Mr STEELE and 
Stuart WRIGHT.

2. From the Palette drop down list, select Individuals. This selects the Individuals 
palette.

UK

5 Silver Street
Crownsville

How do I use the Attribute Bar?

Palette drop-down list

Attribute Class drop-down list

Value box

Apply to Selected button

Command drop-down list



 Chapter 3: Adding Cards and Attributes

i2 Analyst’s Notebook 8 User Guide: Creating Charts 143

3. From the Attribute Class drop-down list, select Nationality. This selects the 
Nationality attribute class.

4. In the Value box type British.

5. From the Command drop-down list, select Add Attribute.

The Attribute Bar should now look like this:

6. Click the Apply to Selected button to add the attribute to the selected items.

Mr STEELE, Marc BAKER and Stuart WRIGHT are displayed with an attribute to 
show that they are all British nationals. The two addresses are displayed with an 
attribute to show that they are both UK addresses:

Mailing AddressAddress

Believed to crew
on vessel

Registered Owner

Associates

Arcacia Investments

UK

5 Silver Street
Crownsville

UK

Box 518
Finchley Road
Crownsville

British
Stuart WRIGHT

British
Marc BAKER

British
Mr STEELE

MOONSHADOW
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Records show that the cruiser MOONSHADOW is white and registered in the UK. 
Add attributes to MOONSHADOW. To do this:

1. Select Standard from the drop-down palette list. All of the attributes and entity 
types specified in the Standard palette are displayed in the palette bar.

2. While holding down the Shift key select the UK and White attribute entries in 
the lower pane of the palette bar and drag them onto MOONSHADOW.

How do I add two attributes at the same time?

White

UK

MOONSHADOW
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t

MOONSHADOW is shown on the chart with values for the Country and Color 
attribute classes. Edit the UK attribute instance so that it is displayed as UK 
Registered on your chart. To do this:

1. Double-click on the MOONSHADOW icon to display the Edit Icon dialog and 
select Attributes\Instances to display the Instances page:

2. Select the Country attribute class, double-click in the Value column and edit the 
value to be UK Registered then press the Enter key.

3. Click OK to close the Edit Icon dialog.

MOONSHADOW is now displayed with two attributes to show that it is white 
and UK registered:

How do I change the value of an attribute instance?

White

UK Registered

MOONSHADOW
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You want to show that Marc BAKER, Mr STEELE and Stuart WRIGHT are English, 
rather than British. Edit the nationality of each of them to be English. To do this:

1. Select Mr STEELE, Marc BAKER and Stuart WRIGHT.

Note: Select Mr STEELE and while holding down the Ctrl key, click on Marc 
BAKER and Stuart WRIGHT to select them.

2. Right-click on one of the selected persons and from the shortcut menu, select 
Combined Properties to display the Edit Chart Items dialog, and select 
Attributes\Instances to display the Instances page:

Note: The Combined Properties command allows you to change the settings 
of several chart items at the same time. If you edit one setting this 
change is reflected in all of the selected items. If you have selected 
several chart items, and they have different settings, the corresponding 
field in the Edit Chart Items dialog is filled with cross-hatching. For 
example, Mr STEELE, Marc BAKER and Stuart WRIGHT all have 
different settings for the attribute class Has Cards.

3. Select the Nationality attribute class and double-click in the Value cell.

4. Edit the value to be English then press the Enter key.

How can I edit more than one attribute instance at the same time?
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5. Click OK to close the Edit Chart Items dialog.

Your chart should look similar to that below (Example 3 finished.anb): 

Click the Save toolbar button and close your chart.

Mailing Address

Subscriber

Owner

Address

Believed to crew
on vessel

RP3
Called

RP2
Called

RP4
Called

Registered Owner

Subscriber

Associates

RZ/6
Diverts to

RP1
Called

1

Arcacia Investments

Call made by FARMER

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

No subscriber
details available

07787 563 412

02703 871 117
Station Lobby

Caledonian Road

456 FGT
Black Saab 900

07786 162 534

UK

Box 518
Finchley Road
Crownsville

UK

5 Silver Street
Crownsville

English
Stuart WRIGHT

English
Marc BAKER

English
Mr STEELE

White

UK Registered

MOONSHADOW
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Summary 3.4

In this example, you will have learned how to:

• add information using cards

• add information using attributes
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4
Combining Charts and OLE Objects

This chapter explains how to combine two charts into one, how to add OLE objects 
to a chart, and how to use the Reporter to create a textual report from your chart.
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Introduction 4.1

The features covered in detail in this example are:

• combining two charts into one

• adding external information into the chart using OLE objects

• linking to external information using hyperlinks

• producing a textual report from a chart

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished chart (Example 4 finished.anb) at any time while 
you are working through this example. To access the folder in which this chart is 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.

Scenario

Information concerning two parts of a single drugs investigation has been charted 
in two separate charts. It is now necessary to combine this information onto a 
single chart so that you can perform further analysis.

Further material is available in the form of a textual narrative of one of the 
telephone conversations featured in the chart and a Microsoft Word document 
containing a laboratory report for the drugs involved in the investigation.
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Incorporating One Chart into Another 4.2

You can transfer or copy items between charts using commands such as Cut, 
Copy and Paste. This can be useful if, during an investigation, you create more 
than one chart to analyze different elements of the investigation and you want to 
create a single chart to combine the information from all of the charts.

Information concerning two parts of a single drug investigation has already been 
charted for you in two charts, Example 4 drug 1.anb and  
Example 4 drug 2.anb. You want to create a single chart that contains the 
combined information from both charts. Copy the contents of  
Example 4 drug 1.anb into Example 4 drug 2.anb. To do this:

1. Open the charts Example 4 drug 1.anb and Example 4 drug 2.anb at 
the same time. To do this:

a. From the File menu, select Open. The Open dialog is displayed. 

b. Find the two charts. To access the folder in which these charts are stored, 
double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click 
on the Creating Charts folder.

c. Select the first file in the list and then Ctrl+Click to select the second file.

d. With both files still selected, click Open.

How do I copy an entire chart?
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2. Make the Example 4 drug 2 chart the active chart. To do this, from the Window 
menu, select Example 4 drug 2:

3. Make sure that nothing is selected by clicking on the chart background. From 
the Edit menu, select Copy Chart.

The entire chart, including all of the entities, links, attributes, and labels is 
copied to the Windows clipboard.

4. Close the Example 4 drug 2 chart.

5. Save the Example 4 drug 1 chart using Save As from the File menu. Click OK 
on the Cover Sheet dialog to display the Save As dialog. Select the folder you 
created to save your charts in. Type Example 4 combining charts.anb in 
the File Name box and click Save.

6. Paste the contents of the Example 4 drug 2 chart into this chart; from the Edit 
menu, select Paste.

Note: Do not click the mouse button. If you do this all of the selected items on 
this chart will be deselected.

7. With all of the items that you have just pasted into the chart still selected, drag 
them so that they are positioned just below the Supplier contacted event frame.

Mailing Address

1

Subscriber

Owner

Address

Believed to crew
on vessel

RP2
Called

RP4
Called

Associates

Registered Owner

Subscriber

RP1
Called

RZ/6
Diverts to RP3

Called

Arcacia Investments

Call made by FARMER

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

MOONSHADOW

Stuart WRIGHT

Marc BAKER

02703 871 117
Station Lobby

Caledonian Road

07787 563 412

07786 162 534

No subscriber
details available

456 FGT
Black Saab 900

Box 518
Finchley Road
Crownsville

Mr STEELE

5 Silver Street
Crownsville
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Your chart should now look similar to that below:

Subscriber

Registered Owner

Associates

RP4
Called

RP1
Called RP2

Called

Believed to crew
on vessel

Address

Owner

Subscriber

1

Mailing Address
RZ/6

Diverts to RP3
Called

Arcacia Investments

Motorcycle
Part License Plate

2*9WF*

456 FGT
Black Saab 900

No subscriber
details available

07786 162 534

07787 563 412

02703 871 117
Station Lobby

Caledonian Road

Stuart WRIGHT

MOONSHADOW

Marc BAKER

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

Call made by FARMER

Meeting
arranged

29 Sep 2006 11:00

Leave for meeting

A 1 5

29 Sep 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 Sep 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 Sep 2006 13:30

After a successful
meeting, FARMER and

the officer leave
separately.

Meeting ends Return from
meeting

Box 518
Finchley Road
Crownsville

Mr STEELE

5 Silver Street
Crownsville

29 Sep 2006 12:00

Meeting between the undercover
officer and FARMER starts.

FARMER informs the officer that he
will call his supplier and ask him to

deliver a 'sample' of drugs.

Meeting starts

29 Sep 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted
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The chart items that you have pasted into your chart relate to the information 
gathered as a result of the call that FARMER made from the payphone in the 
station lobby during his meeting with the undercover officer. Add a box so that all of 
the pasted items are within it and link this box to the Supplier contacted event 
frame using a General link type. To do this:

1. Click the drop-down arrow on the Insert Box toolbar button and select 
Standard ➧ Black to select the Black type from the Standard palette.

2. Draw a box around the items that you have just pasted into this chart.

3. Edit the name of this box to be Call made by FARMER.

4. Turn off the box label display. 

Note: How to do this is described in How do I change the display of an event 
frame? on page 45.

5. Click OK to close the Edit Box dialog.

6. Click the drop-down arrow on the Insert Link toolbar button and select 
Standard ➧ General to select the General link type from the Standard palette.

7. Add a link between the box and the event frame Supplier contacted.

8. Edit the name of this link to be FARMER calls contact.

9. Turn off the link label display.

Adding further information
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Subscriber

Registered Owner

Associates

RP4
Called

RP1
Called RP2

Called

Believed to crew
on vessel

Address

Owner

Subscriber

1

Mailing Address
RZ/6

Diverts to RP3
Called

Arcacia Investments

Motorcycle
Part License Plate

2*9WF*

456 FGT
Black Saab 900

No subscriber
details available

07786 162 534

07787 563 412

02703 871 117
Station Lobby

Caledonian Road

Stuart WRIGHT

MOONSHADOW

Marc BAKER

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

Call made by FARMER

Meeting
arranged

29 Sep 2006 11:00

Leave for meeting

A 1 5

29 Sep 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 Sep 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 Sep 2006 13:30

After a successful
meeting, FARMER and

the officer leave
separately.

Meeting ends Return from
meeting

Box 518
Finchley Road
Crownsville

Mr STEELE

5 Silver Street
Crownsville

29 Sep 2006 12:00

Meeting between the undercover
officer and FARMER starts.

FARMER informs the officer that he
will call his supplier and ask him to

deliver a 'sample' of drugs.

Meeting starts

29 Sep 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted
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Changing Fill Color and Background Text Color 4.3

As you have already seen in previous examples, when you add an event frame to a 
chart you can add as much information as you like and change its display 
properties. You can also change the fill color and background text color of an event 
frame so that it stands out from the rest of the event frames on the chart. This is 
particularly useful if you want to color code event frames containing the same type 
of information, for example to show that the information in an event frame is 
classified. 

In the example chart below, all of the event frames on the chart containing top 
secret information have both their fill color and background text color set to be red.

TAYLOR is a know n drug
dealer.

A 1 5

15 Nov 2006 20:00

GH 8790Officer

TAYLOR was observed in the
hotel lobby with a package.
This package is believed to

contain drugs.

Package

A 1 5

15 Nov 2006 19:30

DS 9289/1aOfficer

DUPLEASE and CORNEY met in a
hotel in London. They were
joined by a third suspect,

TAYLOR.

Meeting in London

A 1 5

14 Nov 2006 17:00

FM 6793Record

DUPLEASE and CORNEY and
an unknown male returned
from St Lucia to Crownsville

airport.

Returned from St Lucia

A 1 5

01 Nov 2006 16:06

FM 5062Record

DUPLEASE and CORNEY
traveled to St Lucia from

Crownsville airport.

Flew to St Lucia

A 1 5

01 Nov 2006 15:00

GD 6882Officer

CORNEY was seen with an
envelope, believed to

contain money.

Envelope

A 1 5

31 Oct 2006 12:00

CS 4578/09Officer

DUPLEASE and CORNEY
met in a hotel bar in

London.

Meeting in London

CORNEY TAYLORDUPLEASE
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When you combined the two charts, one of the event frames on the first chart links 
to the happenings on the second chart. Change the fill color of the Supplier 
contacted event frame to be yellow, so it is highlighted as being of interest on the 
chart. To do this:

1. Double-click on the Supplier contacted event frame and select Style\Display to 
display the Display page of the Edit Event Frame dialog:

2. Click on the drop-down arrow on the Fill drop-down list and select Yellow.

3. Click OK to close the Edit Event Frame dialog.

The Supplier contacted event frame is displayed with a yellow fill color.

How do I change the fill color of an event frame?

29 Sep 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted
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When you changed the fill color of the Supplier contacted event frame the text 
background color did not change to match. Edit the background text color so that it 
matches the event frame fill color. To do this:

1. Double-click on the Supplier contacted event frame and select Style\Font to 
display the Font page of the Edit Event Frame dialog:

2. Click on the drop-down arrow on the Shading drop-down list and select Yellow. 
to match the fill color.

3. Click OK to close the Edit Event Frame dialog.

How do I change the background text color?
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The Supplier contacted event frame is displayed on your chart with both its fill color 
and text background color set to yellow:

Click the Save toolbar button to save your chart.

29 Sep 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted
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Including Files in a Chart using OLE Objects 4.4

An OLE object is an object from another Windows application, for example a text 
file, audio file, picture, or video clip. You can link to the original object or embed the 
information directly into your chart.

Linked object A linked object, retains a link between Analyst’s Notebook and the document from 
which it originated. If the originating document is updated, the changes will be 
made in the OLE object in the chart. A linked object is a useful way of making sure 
that a document in a chart is up to date with the latest changes. 

Changes 
made

Updated 
in chart

Updated 
in chart

Updated 
in chart
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Embedded 
object

An embedded object is an object that is a copy of a document created in another 
Windows application. An embedded object is no longer connected to the 
originating document. If changes are made to the document they will not be made 
to the OLE object in the chart. Any updates will have to be performed manually. 

Changes
made

No updates made in chart



Including Files in a Chart using OLE Objects

162 i2 Analyst’s Notebook 8 User Guide: Creating Charts

Linked versus 
embedded

The table below illustrates the effects that actions have on linked and embedded 
OLE objects:

You have received a transcript of the conversation that took place when the 
undercover officer called FARMER to arrange the meeting. This transcript has 
been saved as a text file. Add the transcript to your chart and add a General link 
between the transcript and the event frame Meeting arranged. To do this:

1. Click the drop-down arrow on the Insert OLE Object toolbar button and select 
Documents ➧ Document to select the Document type from the Documents 
palette. This displays the Insert Object dialog:

Action Linked Object Embedded Object

Edit Updates. Doesn’t update.

File Size Chart Size remains the same. Chart Size increases.

Distribute All files and charts. Just the chart.

How do I add an OLE object to a chart as a linked item?
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2. Select Create from File. The Insert Object dialog changes:

3. Click Browse to display the Browse dialog to find the Word document 
Example 4 Transcript.doc. To access the folder in which this document 
is stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on 
the Creating Charts folder.

4. Select Example 4 Transcript.doc, and click Open to add the selected file 
and return to the Insert Object dialog.

5. Turn on the Display As Icon check box to show the transcript as an icon. 

Note: If you do not turn on the Display As Icon check box the entire transcript 
will be displayed on your chart, which may be too large to view.
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6. Turn on the Link check box. This will create a link between the original 
transcript and the document on the chart.

7. Click OK to close the Insert Object dialog.

The transcript is added to your chart as an OLE Object:

Note: The document in the chart is a linked object. Any changes made in the 
original document will also be made to the document on the chart.

8. Move the transcript above the Meeting arranged event frame and using a 
General link type from the Standard palette, add a link between the text file and 
the event frame Meeting arranged.

9. Remove the label on this link.

Your chart should now look similar to that below. You will learn how to open the 
transcript in How do I open a linked OLE object? on page 168.

Example 4 
Transcript.doc

Document 1

Subscriber

Registered Owner

Associates

RP4
Called

RP1
Called RP2

Called
RP3

Called

Believed to crew
on vessel

Address

Owner

Subscriber

1

RZ/6
Diverts to

Mailing Address

Arcacia Investments

Motorcycle
Part License Plate

2*9WF*

456 FGT
Black Saab 900

No subscriber
details available

07786 162 534

07787 563 412

02703 871 117
Station Lobby

Caledonian Road

Stuart WRIGHT

MOONSHADOW

Marc BAKER

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

Call made by FARMER

29 Sep 2006 11:00

Leave for meeting

29 Sep 2006 12:00

Meeting between the undercover
officer and FARMER starts.

FARMER informs the officer that he
will call his supplier and ask him to

deliver a 'sample' of drugs.

Meeting starts

A 1 5

29 Sep 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 Sep 2006 13:30

After a successful
meeting, FARMER and

the officer leave
separately.

Meeting ends Return from
meeting

29 Sep 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

Box 518
Finchley Road
Crownsville

Mr STEELE

5 Silver Street
Crownsville

Meeting
arranged

A 1 5

29 Sep 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene. 

FARMER receives package

Example 4 
Transcript.doc

Document 1
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Click the Save toolbar button to save your chart.

A photograph of FARMER was taken as he was seen leaving the station lobby. Add 
this photograph to your chart as an embedded OLE object and add a General link 
between it and the Supplier contacted event frame. To do this:

1. Click the drop-down arrow on the Insert OLE Object toolbar button and select 
Documents ➧ Picture to select the Picture type from the Documents palette. 
This displays the Insert Object dialog:

2. Select Create from File. The Insert Object dialog changes:

3. Click Browse and locate the picture Example 4 Picture.bmp. To access 
the folder in which this picture is stored, double-click on the User Guide 
Example Material shortcut in the My Documents\i 2\i 2 Analyst’s 
Notebook 8 folder, and double-click on the Creating Charts folder. 

How do I add an OLE object to a chart as an embedded item?
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4. Select Example 4 Picture.bmp, and click Open to return to the Insert 
Object dialog.

5. Click OK to add it to your chart.

6. The picture of FARMER is added to your chart. Edit the name of this picture to 
be FARMER leaving station lobby.

Note: This is an embedded object. If changes are made to the original 
document they will not be made to this document. This is particularly 
useful if you are creating a chart showing the status at a given time.

7. Move the picture of FARMER so that it is positioned just above the Supplier 
contacted event frame.

8. You want this picture of FARMER to be framed with a border. Right-click on the 
picture and select Display ➧ Border to display a border.

9. Click on the drop-down arrow on the Insert Link toolbar button and select 
Standard ➧ General to select the General link type from the Standard palette.

10. Add a link between the picture of FARMER and the Supplier contacted event 
frame.

11. Remove the label on this link.
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Your chart should now look similar to that below:

Note: The document in the chart is a linked object. Any changes made in the 
original document will also be made to the document on the chart.

Subscriber

Registered Owner

Associates

RP4
Called

RP1
Called RP2

Called
RP3

Called

Believed to crew
on vessel

Address

Owner

Subscriber

1

RZ/6
Diverts to

Mailing Address

Arcacia Investments

Motorcycle
Part License Plate

2*9WF*

456 FGT
Black Saab 900

No subscriber
details available

07786 162 534

07787 563 412

02703 871 117
Station Lobby

Caledonian Road

Stuart WRIGHT

MOONSHADOW

Marc BAKER

Target in Operation Crest.
A joint police and customs

investigation 
into drug importation, money

laundering and 
forgery.

Call made by FARMER

FARMER leaving station lobby

29 Sep 2006 11:00

Leave for meeting

29 Sep 2006 12:00

Meeting between the undercover
officer and FARMER starts.

FARMER informs the officer that he
will call his supplier and ask him to

deliver a 'sample' of drugs.

Meeting starts

A 1 5

29 Sep 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 Sep 2006 13:30

After a successful
meeting, FARMER and

the officer leave
separately.

Meeting ends Return from
meeting

29 Sep 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

Box 518
Finchley Road
Crownsville

Mr STEELE

5 Silver Street
Crownsville

Meeting
arranged

Example 4 
Transcript.doc

Document 1

A 1 5

29 Sep 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene. 

FARMER receives package
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Open the Microsoft Word document of the conversation that took place when 
FARMER handed the drugs to the undercover officer. To do this:

1. Right-click on the Microsoft Word document, and from the shortcut menu, 
select Linked Document Object ➧ Open. 

The transcript is opened in Microsoft Word:

2. Close Microsoft Word without saving the document.

How do I open a linked OLE object?
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Including Files in a Chart using Hyperlinks 4.5

Analyst’s Notebook allows you to create hyperlinks in your chart to external 
documents and Web sites that may have some relevance to the intelligence 
portrayed in your chart. For example, you can create a hyperlink to link directly to 
an eye witness statement.

Analyst’s Notebook automatically converts the hyperlinks that you type into active 
hyperlinks as you type. Hyperlinks are saved with your chart for future use. See the 
topic About Hyperlinks in the Online Help for details about which hyperlinks you 
can create and where in your charts you can create them.

Add a hyperlink to the FARMER receives package event frame to reference a 
witness statement made by Ruby RIVERS, which contains additional details about 
a package that was seen in Sam STEELE’s possession on 29 September 2006. 
Add a hyperlink to the Description box to reference the witness statement 
Example 4 Statement.doc.

1. From the Windows Start menu, select All Programs ➧ Accessories ➧ 

Windows Explorer to display Windows Explorer.

2. Use the Address drop-down list to navigate to the folder containing the witness 
statement Example 4 Statement.doc. To access the folder in which this 
document is stored, double-click on the User Guide Example Material 
shortcut in the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, 
and double-click on the Creating Charts folder.

3. Highlight the folder path in the Address box and, while holding down the Ctrl 
key, press the c key. Close Window Explorer. 

4. In Analyst’s Notebook, double-click on the event frame FARMER receives 
package to display the Edit Event Frame dialog.

5. Select Data\Description & Grades to display the Description & Grades page.

6. Move your mouse pointer to the end of the text in the Description box and click 
once. Press the Space Bar.

7. Paste the folder path containing Example 4 Statement.doc into the 
Description box. To do this, while holding down the Shift key, press the Insert 
key.

8. Type \Example 4 Statement.doc after the folder path.

9. Type file:// before the file path and enclose the whole text with angle 
brackets (< >) to create the hyperlink.

How do I create a hyperlink?
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The Description box should now look like this:

Test the hyperlink you have created to make sure that it works, and to review the 
contents of the witness report in connection with the chart.

1. Move your mouse pointer over the hyperlink you have just created. A tooltip is 
displayed indicating that you must hold down the Ctrl key and click on the link 
to activate it.

How do I activate a hyperlink?
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2. Hold down the Ctrl key and click on the hyperlink in the Description box to 
activate to link to the document Example 4 Statement.doc. Microsoft Word 
is started, and displays the contents of the statement.

3. Close Microsoft Word.

4. Click OK to close the Edit Event Frame dialog.

5. Click the Save toolbar button to save your chart.
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Producing a Textual Report from a Chart 4.6

You can export chart information regarding entities, links, associated attributes and 
cards to a report. It can be useful to create textual reports from your charts, for 
example if you want to prepare a report that includes all of the relevant intelligence 
included in your chart or part of your chart.

The Reporter allows you to define the content and destination of your report using 
a report specification. You can create several different specifications, and each can 
display different items of information in the style that you require.

Analyst’s Notebook is distributed with some predefined report specifications for 
you to use.

An example report specification has been created for you that will produce a 
complete report of all of the items on your chart. Before you can create a report 
using this report specification you will need to make sure that Analyst’s Notebook 
is referencing it. To do this:

1. From the Tools menu, select Options, then select Options\Reporter to 
display the Reporter page of the Options dialog.

How do I use a specific report specification?



 Chapter 4: Combining Charts and OLE Objects

i2 Analyst’s Notebook 8 User Guide: Creating Charts 173

2. In the Report Specifications File area, click Browse and select the example 
report specification Example 4 Reporter.rep. To access the folder in 
which this document is stored, double-click on the User Guide Example 
Material shortcut in the My Documents\i 2\i 2 Analyst’s Notebook 8 
folder, and double-click on the Creating Charts folder.

3. Click Open to return to the Options dialog. The path in the Report 
Specifications area is updated to reference the correct report specification. 

4. Click OK to close the Options dialog and return to your chart.
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Create a report of this chart, containing a detailed description of the chart 
contents. To do this:

1. From the Tools menu, select Report. The Report On dialog is displayed:

2. In the Report Specifications table, select Full Report and click Run to run the 
reporter. 

A textual report describing the contents of your chart is created. This report is 
copied to the Windows clipboard.

3. Click OK to close the Report On dialog.

4. Close your chart.

The report that you have just created was saved to the clipboard. View this report 
in Microsoft Word. To do this:

1. Start Microsoft Word.

2. From the Edit menu, select Paste.

How do I produce a textual report of a chart?

How can I view a report?
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The report is pasted into Microsoft Word:

3. Close Microsoft Word without saving the document.
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Summary 4.7

In this example you will have learned how to:

• combine two charts into one

• include external information into the chart using OLE objects

• link to external information using hyperlinks

• produce a textual report of a chart
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5
Merging and Navigating Charts

This chapter explains how to merge items from different charts, work with two 
charts open at the same time, navigate large charts, and link items on large charts.
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Introduction 5.1

The features covered in detail in this example are:

• automatically merging items copied from different charts

• viewing two charts beside each other

• navigating large charts

• linking entities in large charts

• manually merging entities and links

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished chart (Example 5 finished.anb) at any time while 
you are working through this example. To access the folder in which this chart is 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.

Scenario

Three charts providing information concerning the controlled purchase of drugs by 
three separate undercover officers already exist. The information in these charts 
needs to be combined into a single chart in preparation for a presentation.
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Merging Items Pasted from Different Charts 5.2

When you copy an entity from one chart into another chart containing an entity 
with the same name, the entities are merged. The merged entity retains all of the 
information that the original entity had, added to the item as a card. 

In the example chart below, Kevin DUPLEASE has been seen in a meeting in 
London:

Further information is contained in a second chart that provides more information 
surrounding this meeting in London:

When the contents of the second chart are pasted into the first chart, any entities 
with the same name are merged. For example, both of the above charts have an 
event frame “Meeting in London”. When the contents of the first chart are pasted 
into the second chart these event frames are merged to create one combined 
event frame. Any additional information that was stored on the original event frame 
is added to the merged event frame as a card.

Kevin DUPLEASE
General

Arrived home
by unknown

means
01 Jan 2006 06:00

Met with David
TAYLOR in
London.

Meeting in London.

Traveled to
meeting by

unknown means

Kevin DUPLEASE
General

01 Jan 2006 04:00

Traveled to
meeting.

Traveled to London

01 Jan 2006 06:00

Met with
broker.

Meeting in London.

01 Jan 2006 10:30

Drove home
after meeting.

Drove home

01 Jan 2006 08:20

Went shopping
in London.

Surveillance

Kevin DUPLEASE
GeneralTraveled to

meeting by
unknown means

01 Jan 2006 04:00

Traveled to
meeting.

Traveled to London

01 Jan 2006 06:00

Met with David
TAYLOR in
London.

Meeting in London.

01 Jan 2006 08:20

Went shopping
in London.

Surveillance Arrived home
by unknown

means

01 Jan 2006 10:30

Drove home
after meeting.

Drove home
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Three charts have been created for you. Each of these charts contains information 
concerning the controlled purchase of drugs by undercover officers. You want to 
combine all three of these charts into one large chart. Copy the contents of the 
chart relating to the second purchase of drugs into the chart concerning the first 
drugs purchase. To do this: 

1. Open the chart Example 5 buy 1.anb. To access the folder in which this 
chart is stored, double-click on the User Guide Example Material shortcut in 
the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-
click on the Creating Charts folder.

This chart will be the starting point when creating the single combined chart. 

2. Save this chart using Save As from the File menu. Click OK on the Cover 
Sheet dialog to display the Save As dialog. Select the folder you created to 
save your charts in. Type Example 5 merging.anb in the File Name box 
and click Save.

3. Open the chart Example 5 buy 2.anb. To access the folder in which this 
chart is stored, double-click on the User Guide Example Material shortcut in 
the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-
click on the Creating Charts folder.

4. In the Example 5 buy 2 chart, from the Edit menu select Copy Chart to copy 
the entire chart.

5. Make the Example 5 merging chart the active chart; from the Window menu, 
select Example 5 merging.

6. From the Edit menu, select Paste to paste the contents of Example 5 buy 2 into 
this chart.

The first event frame of Example 5 buy 2 automatically merges with the last 
event frame of the Example 5 merging chart. This is because their identities are 
the same.

How do I merge items pasted from different charts?

To forensic laboratory

Undercover officerFARMER Motorcycle
Part License Plate

2*9WF*

Laboratory

Meeting
arranged

29 Sep 2006 11:00

Leave for meeting

29 Sep 2006 12:00

Meeting between the undercover
officer and FARMER starts.

FARMER informs the officer that he
will call his supplier and ask him to

deliver a 'sample' of drugs.

Meeting starts

29 Sep 2006 12:55

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

A 1 5

29 Sep 2006 13:10

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 Sep 2006 13:15

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 Sep 2006 13:30

After a successful
meeting, FARMER and

the officer leave
separately.

Meeting ends Return from
meeting

01 Oct 2006 15:30

The officer contacts FARMER to
arrange for another meeting. He

states that he was happy with the
sample and would like to arrange

for a bigger delivery.

Call to arrange the next meeting

28 Nov 2006 10:12

FARMER contacted by
telephone by an

undercover officer who
wants to arrange another

meeting.

Arranged meeting

04 Oct 2006 14:50

Officer returns and bags up
the drugs to send to the
Forensic Laboratory. The

bag is also sent to
forensics.

Return

04 Oct 2006 14:05

The knapsack containing the
drugs was handed to the
officer by FARMER. The

agreed amount was given in
return.

Hand over

04 Oct 2006 13:59

An unknown person arrives on
a motorcycle (license plate not

noted). The rider has a
knapsack which he hands to

FARMER.

Package arrives

04 Oct 2006 13:19

FARMER calls his supplier
using a cellphone. He

arranges for the delivery
of the drugs.

Supplier called

04 Oct 2006 13:07

Meeting starts. Again,
FARMER hasn't got the drugs

with him, so details of the
amount and costs are
discussed and agreed.

Meeting commences

04 Oct 2006 12:00

Officer
departs for

meeting

Depart for meeting

01 Oct 2006 15:30

The officer contacts FARMER to
arrange for another meeting. He

states that he was happy with the
sample and would like to arrange

for a bigger delivery.

Call to arrange the next meeting

04 Oct 2006 14:15

Meeting with
FARMER ends.
Both parties

go off
separately.

Meet ends
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7. Click the Fit Chart in Window toolbar button. Your chart should now look 
similar to that below:

8. Close the Example 5 buy 2 chart, do not save any changes.

9. Click the Save toolbar button to save your chart.

To forensic laboratory

Undercover officerFARMER

Laboratory

04 Oct 2006 12:00

Officer
departs for

meeting

Depart for meeting

04 Oct 2006 13:19

FARMER calls his supplier
using a cellphone. He

arranges for the delivery
of the drugs.

Supplier called

04 Oct 2006 13:59

An unknown person arrives on
a motorcycle (license plate not

noted). The rider has a
knapsack which he hands to

FARMER.

Package arrives

04 Oct 2006 13:07

Meeting starts. Again,
FARMER hasn't got the drugs

with him, so details of the
amount and costs are
discussed and agreed.

Meeting commences

Motorcycle
Part License Plate

2*9WF*

Meeting
arranged

29 Sep 2006
11:00:00

Leave for meeting

29 Sep 2006 12:00:00

Meeting between the undercover
officer and FARMER starts.

FARMER informs the officer that he
will call his supplier and ask him to

deliver a 'sample' of drugs.

Meeting starts

29 Sep 2006 12:55:00

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

A 1 5

29 Sep 2006 13:10:00

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 Sep 2006 13:15:00

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 Sep 2006 13:30:00

After a successful
meeting, FARMER and

the officer leave
separately.

Meeting ends Return from
meeting

01 Oct 2006 15:30:00

The officer contacts FARMER to
arrange for another meeting. He

states that he was happy with the
sample and would like to arrange

for a bigger delivery.

Call to arrange the next meeting

04 Oct 2006 14:05

The knapsack containing the
drugs was handed to the
officer by FARMER. The

agreed amount was given in
return.

Hand over

04 Oct 2006 14:15

Meeting with
FARMER ends.
Both parties

go off
separately.

Meet ends

04 Oct 2006 14:50

Officer returns and bags up
the drugs to send to the
Forensic Laboratory. The

bag is also sent to
forensics.

Return

28 Nov 2006 10:12

FARMER contacted by
telephone by an

undercover officer who
wants to arrange another

meeting.

Arranged meeting
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Working With Two Charts Together 5.3

It is useful when you have more than one chart open, to be able to see each chart 
at the same time. To see all of your open charts in a single window, you can tile 
them horizontally or vertically. If you wish to copy or link chart items from separate 
charts you can simply drag items from one tiled window to the other.

Horizontal 
tiling 

If you choose to tile your chart this way, the chart windows are arranged 
horizontally:

Vertical tiling If you choose to tile your charts this way, the chart windows are arranged vertically:

To show when a chart is the active chart its title bar is colored.
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You have combined the happenings from the first two controlled purchases of 
drugs by the undercover officers into a single chart. A third chart exists, containing 
the happenings concerning a third controlled purchase of drugs by an undercover 
officer. Open this third chart, tile the open charts horizontally, and drag the 
contents of this third chart into the Example 5 merging chart. To do this:

1. Open the chart Example 5 buy 3.anb. To access the folder in which this 
chart is stored, double-click on the User Guide Example Material shortcut in 
the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-
click on the Creating Charts folder.

2. From the Window menu, select Tile Horizontal.

How do I work with two charts at the same time?

29 Nov 2006 12:39

An unknown person arrives on
a motorcycle (only part of

license plate visible). Hands
FARMER a package that he
removed from a knapsack.

Drugs arrive

29 Nov 2006 12:19

FARMER calls his supplier.
He uses a public telephone
just outside the meeting

venue.

Contact

29 Nov 2006 12:51

Drugs supplied
to officer by

FARMER

Hand over

29 Nov 2006 13:00

Meeting with
FARMER ends
and both the
officer and

FARMER start
to leave.

End of meeting

28 Nov 2006 10:12

FARMER contacted by
telephone by an

undercover officer who
wants to arrange another

meeting.

Arranged meet

29 Nov 2006 12:07

Meeting with FARMER
starts. As before, he has

no drugs with him, but
agrees to call his delivery

driver.

Start of meet

29 Nov 2006 11:00

Officer
departs for

meeting

Officers leave

29 Nov 2006 13:01

As FARMER and the
officer leave, the

surveillance team arrest
FARMER and secure the

drugs.

Arrest

Motorcycle
Part License Plate - 

2*9WFL
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Each of the open charts are tiled horizontally in two separate windows:

3. Make Example 5 buy 3 the active chart; click on the chart title bar. The title bar 
of this chart will be colored to indicate that it is active. Click the Fit Chart in 
Window toolbar button to display the entire chart in the window:

4. Press Ctrl+A to select all of the chart items in Example 5 buy 3.

5. Drag the selected chart items from the Example 5 buy 3 chart into the Example 
5 merging chart. 

Note: As you drag the chart items onto the Example 5 merging chart the 
pointer changes to indicate that they will be added to the chart.

6. Close the Example 5 buy 3 chart, do not save any changes.
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7. Click the Maximize button on the Example 5 merging title bar so that the chart 
is displayed within the entire application window.

8. Click the Fit Chart in Window toolbar button so that you can see all of your 
working chart. Your chart should look similar to that below:

When you dragged the chart items from Example 5 buy 3.anb into your chart 
the event frames Arranged meeting and Arranged meet did not merge 
automatically. This is because, although they are similar, the identities of the event 
frames are different. On closer inspection the Arranged meet event frame and the 
Arranged meeting event frames both describe the same happening. Manually 
merge these two event frames. To do this:

1. Select the Arranged meet and the Arranged meeting event frames, in that 
order. 

Note: Select the Arranged meet event frame and, while holding down the Ctrl 
key, select the Arranged meeting event frame.

2. From the Tools menu, select Merge Entities. The event frames will be merged 
into one event frame:

How do I manually merge items on a chart?

To forensic laboratory

Undercover officerFARMER

Laboratory

04 Oct 2006 12:00

Officer
departs for

meeting

Depart for meeting

04 Oct 2006 13:19

FARMER calls his supplier
using a cellphone. He

arranges for the delivery
of the drugs.

Supplier called

04 Oct 2006 13:59

An unknown person arrives on
a motorcycle (license plate not

noted). The rider has a
knapsack which he hands to

FARMER.

Package arrives

04 Oct 2006 13:07

Meeting starts. Again,
FARMER hasn't got the drugs

with him, so details of the
amount and costs are
discussed and agreed.

Meeting commences

Motorcycle
Part License Plate

2*9WF*

Meeting
arranged

29 Sep 2006
11:00:00

Leave for meeting

29 Sep 2006 12:00:00

Meeting between the undercover
officer and FARMER starts.

FARMER informs the officer that he
will call his supplier and ask him to

deliver a 'sample' of drugs.

Meeting starts

A 1 5

29 Sep 2006 13:10:00

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 Sep 2006 13:15:00

DS 453/06Officer

FARMER gives the package to the
undercover officer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 Sep 2006 13:30:00

After a successful
meeting, FARMER and

the officer leave
separately.

Meeting ends Return from
meeting

01 Oct 2006 15:30:00

The officer contacts FARMER to
arrange for another meeting. He

states that he was happy with the
sample and would like to arrange

for a bigger delivery.

Call to arrange the next meeting

04 Oct 2006 14:05

The knapsack containing the
drugs was handed to the
officer by FARMER. The

agreed amount was given in
return.

Hand over

04 Oct 2006 14:15

Meeting with
FARMER ends.
Both parties

go off
separately.

Meet ends

04 Oct 2006 14:50

Officer returns and bags up
the drugs to send to the
Forensic Laboratory. The

bag is also sent to
forensics.

Return

28 Nov 2006 10:12

FARMER contacted by
telephone by an

undercover officer who
wants to arrange another

meeting.

Arranged meeting

29 Nov 2006 12:19

FARMER calls his supplier.
He uses a public telephone
just outside the meeting

venue.

Contact

29 Nov 2006 12:51

Drugs supplied
to officer by

FARMER

Hand over

29 Nov 2006 13:00

Meeting with
FARMER ends
and both the
officer and

FARMER start
to leave.

End of meeting

29 Nov 2006 12:07

Meeting with FARMER
starts. As before, he has

no drugs with him, but
agrees to call his delivery

driver.

Start of meet

29 Nov 2006 11:00

Officer
departs for

meeting

Officers leave

29 Nov 2006 13:01

As FARMER and the
officer leave, the

surveillance team arrest
FARMER and secure the

drugs.

Arrest

Motorcycle
Part License Plate - 

2*9WFL

28 Nov 2006 10:12

FARMER contacted by
telephone by an

undercover officer who
wants to arrange another

meeting.

Arranged meet

29 Nov 2006 12:39

An unknown person arrives on
a motorcycle (only part of

license plate visible). Hands
FARMER a package that he
removed from a knapsack.

Drugs arrive

29 Sep 2006 12:55:00

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

28 Nov 2006 10:12

FARMER contacted by
telephone by an undercover
officer who wants to arrange

another meeting.

Arranged meet
Arranged meeting
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The merged event frame has a combined label displayed on two separate lines. 
Edit the label of this event frame to be Arranged meet. To do this:

1. Double-click on the event frame to display the Edit Event Frame dialog and 
select Data\Identity to display the Identity page:

2. Turn off the Label is different from Identity check box and click OK to close 
the Edit Event Frame dialog.

3. Click the Fit Chart in Window toolbar button. Your chart should now look 
similar to that below:

4. Click the Save toolbar button to save your chart.

How do I edit the label of an event frame?

To forensic laboratory

Undercover off icerFARMER

Laboratory

04 Oct 2006 12:00

Officer
departs for

meeting

Depart for meeting

04 Oct 2006 13:19

FARMER calls his supplier
using a cellphone. He

arranges for the delivery
of the drugs.

Supplier called

04 Oct 2006 13:59

An unknown person arrives on
a motorcycle (license plate not

noted). The rider has a
knapsack which he hands to

FARMER.

Package arrives

04 Oct 2006 14:05

The knapsack containing the
drugs was handed to the
officer by FARMER. The

agreed amount was given in
return.

Hand over

04 Oct 2006 14:15

Meeting with
FARMER ends.
Both parties

go of f
separately.

Meet ends

04 Oct 2006 13:07

Meeting starts.  Again,
FARMER hasn't got the drugs

with him, so details of the
amount and costs are
discussed and agreed.

Meeting commences

29 Nov 2006 11:00

Officer
departs for

meeting

Officers leave

29 Nov 2006 12:19

FARMER calls his supplier.
He uses a public telephone
just outside the meeting

venue.

Contact

29 Nov 2006 12:39

An unknown person arrives on
a motorcycle (only part of

license plate visible). Hands
FARMER a package that he
removed from a knapsack.

Drugs arrive

29 Nov 2006 12:51

Drugs supplied
to of ficer by

FARMER

Hand over

29 Nov 2006 13:00

Meeting with
FARMER ends
and both the
officer and

FARMER start
to leave.

End of meeting

Motorcycle
Part License Plate

2*9WF*

04 Oct 2006 14:50

Officer returns and bags up
the drugs to send to the
Forensic Laboratory. The

bag is also sent to
forensics.

Return

29 Nov 2006 12:07

Meeting with FARMER
starts. As before, he has

no drugs with him, but
agrees to call his delivery

driver.

Start of meetMeeting
arranged

29 Sep 2006
11:00:00

Leave for meeting

29 Sep 2006 12:00:00

Meeting between the undercover
officer and FARMER starts.

FARMER informs the officer that he
will call his supplier and ask him to

deliver a 'sample' of drugs.

Meeting starts

29 Sep 2006 12:55:00

DS 453/04

FARMER states that he will
contact his supplier and uses
the payphone situated in the

station lobby.

Supplier contacted

A 1 5

29 Sep 2006 13:10:00

DS 453/05Officer

An unknown person arrives on a
motorcycle (only part of the license

plate is visible). Talks to FARMER and
hands him a package before leaving

the scene.

FARMER receives package

A 1 5

29 Sep 2006 13:15:00

DS 453/06Officer

FARMER gives the package to the
undercover off icer, who says that
he will get back to FARMER when

he has 'checked it out'.

Drugs supplied

29 Sep 2006 13:30:00

After a successful
meeting,  FARMER and

the officer leave
separately.

Meeting ends Return from
meeting

01 Oct 2006 15:30:00

The off icer contacts FARMER to
arrange for another meeting. He

states that he was happy with the
sample and would like to arrange

for a bigger delivery.

Call to arrange the next meeting

Motorcycle
Part License Plate - 

2*9WFL

29 Nov 2006 13:01

As FARMER and the
officer leave, the

surveillance team arrest
FARMER and secure the

drugs.

Arrest

28 Nov 2006 10:12

FARMER contacted by
telephone by an

undercover off icer who
wants to arrange another
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Navigating Large Charts 5.4

If you are working on a large chart you may not always be able to see all of the 
chart items. This may cause difficulties if you want to add a link between one part 
of the chart to another and you cannot quite see the detail on the chart.

You can tile the same chart in more than one window, allowing you to display a 
different part of it in each open window. This makes it easier to navigate a large 
chart. If you make a change in one window that change is reflected in the other 
open windows. When you save your changes the chart will only be updated once.
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The Example 5 merging chart that you have open is becoming too large to see all 
of the detail in it. You want to see the three controlled purchases of drugs that you 
have added to the chart, in separate windows. Open two new windows on the 
chart. To do this:

1. From the Window menu, select New Window.

A second window is opened with a view of the same chart in it.

2. Open another new window in the same way.

You now have three windows open containing the same chart.

3. Tile these windows horizontally; from the Window menu select Tile 
Horizontal.

How do I view my chart in several windows?
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The three windows each contain a different view of the same chart. Change what is 
viewed in each window so that each of the controlled purchases of drugs are 
displayed in separate windows. To do this:

1. Make the window at the top of the tiled windows the active window and click the 
Fit Chart in Window toolbar button.

The entire chart is displayed in the window.

You only want to see the happenings surrounding the first meeting between an 
undercover officer and FARMER in the window. To do this:

1. Click the Zoom to Area toolbar button. The pointer changes to:

2. Click the Meeting arranged event frame, which is the first event frame displayed 
on the left of the chart. This part of the chart is now displayed in the window.

3. Using a combination of the Zoom Out toolbar button and the arrow keys on 
your keyboard, arrange the part of the chart that relates to the first undercover 
drug purchase so that it is displayed in one window.

How do I navigate a chart displayed in several windows?

How do I just see a part of my chart in a window?
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The chart in the first window should look similar to that below:

There are other navigation tools available in Analyst’s Notebook that allow you to 
navigate your charts. In the second tiled window display the event frames 
concerning the second controlled purchase of drugs. These event frames are 
those that you copied from the Example 5 buy 2 chart. To do this:

1. Click the second window to make it active, then click the Fit Chart in Window 
toolbar button to display the entire chart in this window.

2. Click the Zoom to Area toolbar button and click on the Call to arrange next 
meeting event frame. This is the first in the series of event frames that describe 
the second controlled purchase of drugs.

3. Press the Page Up key on your keyboard. The window zooms in on the chart.

4. Press the Page Down key. The window zooms out of the chart.

5. Using a combination of the toolbar buttons and the keyboard, rearrange the 
items in this window so that just the part of the chart that relates to the second 
undercover drug purchase is displayed in one window.

The second window should now look similar to that below:

Other navigation tools
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6. Using the different toolbar buttons and the keyboard, make the contents of the 
bottom window contain just those event frames that are concerned with the 
third controlled purchase of drugs. 

7. The three tiled windows should now look similar to those below:
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Searching for Items on a Chart 5.5

When you have a large chart that is fitted in the window, it can be difficult to identify 
the individual chart items. The Search Bar allows you to search through all of the 
information in your chart in one simple operation. Type in the word, phrase, 
number or date you are looking for and the Search Bar returns a list of all the items 
in the chart that match your request. 

The Search Bar includes a close-up preview of each resulting item so that you can 
always locate your results no matter how large your chart is. 

Locating and identifying the results of your analysis in heavily populated charts can 
be difficult. The highlighted results of your searches can get lost in the numerous 
chart items visible on your larger network charts. Zooming in on the selected items 
can prevent you from seeing their positions in the context of the whole chart.

You are trying to find a motorcycle with a partial license plate of 2*9WF*. You can 
find a chart item using the Search Bar at the bottom of the application window. To 
do this:

1. In the Search Bar text box, type the partial license plate 2*9WF*

2. Click the Find All Matches button. All information for all items in the chart (not 
including the legend) is searched, including attributes, cards, semantic types, 
and data records.

The results of the search are shown in a table in the Search Bar:

The search results show that there are two items on the chart that contain the 
search text "2*9WF*". The results table shows where on the chart item the 
search text was found. In these results, the Location of the search text was 
found in the Label and in the Identity of the chart items. 

How do I use the Search Bar to find items on my chart?
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3. Open the Edit Item Properties dialog for the first chart item in the Search 
Results. To do this, double-click on the first chart item in the search results 
table:

4. The Edit Item Properties dialog is opened at the page in which the search text 
has been found. Both the Identity and Label show the partial license plate that 
you searched for.

5. Click Cancel to close the Edit Item Properties dialog.

6. When items are selected in the Search Bar results, they are also selected on 
the chart. Select both of the results returned from your search. To do this:

Select the first line in the search results, then hold down the Ctrl key and select 
the second line.
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As your chart is quite large, it is difficult to identify the selected items. To 
emphasize selected items that would otherwise be lost in the detail of your chart, 
you can use the Highlight tool.

From the View menu, click Highlight. The selected items on your chart now 
appear with an animated red box around them and can be identified easily:

How do I highlight a selected item?
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Linking Items on Large Charts 5.6

If you are working with large charts, you can split the display of the chart into two 
or four panes to enable you to work with smaller, more manageable areas of the 
chart. You can then display a different region of your chart in each of the panes and 
zoom in and out or scroll in each of the panes independently. 

Splitting your chart into panes can make it easier to link items that are far apart.

You can remove a split from your window when you want to view the chart in one 
window again.

Split your chart so that it is displayed in two vertical panes. To do this:

1. Close two of the open windows by clicking the Close button at the top right of 
each window.

2. Maximize the remaining open window by clicking the Maximize button at the 
top right of the window.

3. From the Window menu, select Split Window. 

As you move your pointer over the chart window the pointer changes, and split 
lines appear showing how the screen will be divided. Do not click on the chart 
background.

How do I split a chart window into two panes?
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4. To split the window into two vertical panes, drag the pointer down to the bottom 
of the chart until you cannot move the horizontal line down any further and click 
with the left mouse button:

The two motorcycle icons that you found by using the Search Bar, have been 
determined to be the same. Draw a link between them to show this. To do this:

1. In the left pane, select the highlighted motorcycle and click the Fit Selection to 
Window toolbar button.

2. In the right pane, select the second highlighted motorcycle and click the Fit 
Selection to Window toolbar button.

3. Click the Highlight toolbar button to turn the highlight tool off.

How do I add link entities in different panes?
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Your Analyst’s Notebook window should now look similar to that shown below:

4. Select a link of type Same from the Standard palette.

5. Draw a link from the motorcycle in the left pane and drag it so that it links to the 
motorcycle in the right pane. As you draw the link from the left pane to the right 
pane the pointer changes to a large cross, to show that the link is being drawn 
between the two windows.

As you drag the link from the left pane to the right pane, notice that the view in 
the window on the left changes.
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Now that you have linked items in different parts of your chart you no longer need 
to have split windows. Double-click on the vertical divider to remove it.

Click the Fit Chart in Window toolbar button to display the entire chart in the 
window.

Your chart should now look similar to that below (Example 5 finished.anb):

Click the Save toolbar button, and close the chart.

How do I remove a split window?
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Summary 5.7

In this example you will have learned how to:

• automatically merge items pasted from different charts

• view two charts beside each other

• navigate large charts

• link items in large charts
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6
Introducing Theme Lines

This chapter explains how you can add theme lines to your chart, link them to 
event frames, and add a legend and document summary information. 
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Introduction 6.1

The features covered in detail in this example are:

• introducing the time bar

• using theme lines

• linking event frames to theme lines

• varying the style of a theme line

• annotating a chart with a legend

• adding summary and custom property information to a chart using Chart 
Properties

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished chart (Example 6 finished.anb) at any time while 
you are working through this example. To access the folder in which this chart is 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.

Scenario

Surveillance has been carried out on individuals of an organization suspected of 
being involved in drug smuggling activities. The method of importing the drugs 
appears to involve the use of a private motor cruiser named MOONSHADOW. 
Details have been acquired regarding the movement and location of 
MOONSHADOW, along with sightings of various members of the organization. 
Some of this information has come from officers who have witnessed the 
happenings and some of the information has been obtained from official records.

One of the members of the organization, STEELE, was also sighted previously in 
the UK, having a meeting with a man named Paul SHARP in a bar in London. 
SHARP is known to have crewed on MOONSHADOW on a sailing trip to St Lucia. 
Two days later, STEELE was seen in St Lucia on the boat. It is not known how or 
when he traveled.
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Introducing the Time Bar 6.2

In Analyst’s Notebook you can display a time bar that shows the date and time of 
the chart space. It is useful to display the time bar when you are charting 
happenings that have occurred over a period of time.

It is optional whether you display the time bar. In earlier examples you have 
charted happenings and other chart items that may have had dates and times but 
the time bar has not been displayed. The time bar may or may not be initially 
displayed depending on the template that you used to create your chart from.

You can change the following display properties of the time bar:

• the line, border or background color, and symbol color

• the alignment and font used in the labels on each of the intervals on the time 
bar

You can also choose which components of the time bar you wish to display.

For more information on using the time bar, refer to Using the Time Bar on 
page 266.

In this example you will add information to the chart that has taken place over a 
period of time. So that you can see when a happening took place in relation to 
another happening on the chart you will need to display the time bar. To do this:

1. Create a new chart based on the User Guide Examples template. For more 
information on how to do this, refer to How do I create a new chart based on a 
template? on page 20.

2. Click the Time Bar Visible toolbar button.

The time bar is displayed at the top of your chart.

How do I display the time bar?
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Adding Information to Charts Using Theme Lines 6.3

A theme line represents one of the key elements of your investigation, for example 
a victim, witness, suspect or location. Theme lines provide a common thread, 
typically to a sequence of happenings over time.

Analyst’s Notebook draws a horizontal line (a theme line) on the chart to represent 
each element of your investigation. Once you have created a theme line you can 
add event frames, links or any other entity representations to it. 

For analysis purposes, it is good practice to link event frames and other entity 
representations to theme lines if there is a relationship between them. This is 
particularly useful when using Analyst’s Notebook analysis tools.

You may not always be able to see that an event frame is linked to a theme line if it 
is positioned directly on a theme line.

John

General

Called

349 589 0233

Got out of
bed

John Got out of
bed

Went to
work

Ate
breakfast



 Chapter 6: Introducing Theme Lines

i2 Analyst’s Notebook 8 User Guide: Creating Charts 205

During this investigation there have been several sightings of Sam STEELE and 
the cruiser MOONSHADOW that you want to add to your chart. Create theme lines 
for Sam STEELE and MOONSHADOW so that you can add these sightings to the 
chart. To do this:

1. Click the drop-down arrow on the Insert Theme Line toolbar button and select 
Individuals ➧ Male to select the Male type from the Individuals palette. The 
pointer changes to:

2. Place the theme line onto the chart and edit its name to be Sam STEELE.

3. Click the drop-down arrow on the Insert Theme Line toolbar button again and 
select Transport ➧ Cruiser to select the Cruiser type from the Transport 
palette.

4. Place this theme line onto the chart above the Sam STEELE theme line and 
edit its name to be MOONSHADOW.

You have added theme lines for Sam STEELE and the cruiser 
MOONSHADOW to your chart:

How do I add a theme line to a chart?

MOONSHADOW

Sam STEELE
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5. Click the Save toolbar button to save your chart. Click OK on the Cover Sheet 
to display the Save As dialog. Select the folder you created to save your charts 
in. Type Example 6 theme lines.anb in the File Name box and click 
Save. 

Note: For further information on how to save your chart, refer to Saving Charts 
and the Cover Sheet on page 32.

You have received further information about the investigation. Create event frames 
for all of the happenings that were uncovered during the investigation concerning 
MOONSHADOW and Sam STEELE. You will then link these event frames to the 
appropriate theme lines. To do this:

1. A witness saw Sam STEELE on board MOONSHADOW as it sailed into the 
harbor at Castries. 

Add an event frame of type Surveillance from the Crime palette, and place it 
between the two theme lines. As you add the event frame to your chart, notice 
that the theme lines for MOONSHADOW and Sam STEELE both extend to the 
right.

Add the following information to the event frame:

2. From the Standard palette, add a Sighting link type between the above event 
frame and the Sam STEELE theme line.

How do I link an event frame to a theme line?

Identity Observed

Date & Time 24 Feb 2006 13:15 

Description Sam STEELE was seen on board 
MOONSHADOW as it sailed into the harbor at 
Castries.

Grades A 1 5

Source Type Witness

Reference WS 250
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The Observed event frame is now linked to the Sam STEELE theme line with a 
Sighting link type:

3. Add the following information to this link:

4. Repeat the steps above to add a link of type Sighting between the Observed 
event frame and the MOONSHADOW theme line. Add the same information to 
this link that you added to the link between Sam STEELE and the Observed 
event frame.

Description The harbor master at Castries observed Sam 
STEELE on board MOONSHADOW as it sailed 
into the harbor.

Grades A 1 5

Source Type Witness

Reference WS 251

Sam STEELE

MOONSHADOW

Sighting

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed
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5. Another witness saw MOONSHADOW moored in the port at Castries in the 
evening of 25 February 2006.

Add an event frame of type Port, from the Locations palette, place it above the 
MOONSHADOW theme line, after the Observed event frame, and add the 
following information to it:

6. Add a link of type Sighting, from the Individuals palette, between the above 
event frame and the MOONSHADOW theme line:

Identity Moored in port

Date & Time 25 Feb 2006 19:00

Description MOONSHADOW was seen moored in the harbor 
at Castries.

Grades A 1 5

Source Type Witness

Reference WS 252

Sam STEELE

MOONSHADOW

Sighting

Sighting

Sighting

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port
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7. Add the following information to this link:

8. A police officer saw Sam STEELE alone in the Liquide X bar in Castries harbor. 

Add an event frame of type Bar, from the Locations palette, place it below the 
Sam STEELE theme line and add the following information to it:

9. Add a link of type Sighting, from the Individuals palette, between the above 
event frame and the Sam STEELE theme line.

Description MOONSHADOW was confirmed as being moored 
in the harbor at Castries by both the harbor master 
and an undercover officer.

Grades A 1 5

Source Type Witness

Reference WS 253

Identity Seen in bar

Date & Time 25 Feb 2006 13:30

Description Sam STEELE was seen in 'Liquide X', a bar in the 
harbor. He appeared to be on his own and was 
looking out at the boats moored on the pontoons.

Grades A 1 5

Source Type Officer

Reference DS 682/01
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10. You have received further information about a second suspect who is involved 
in the drugs smuggling operation.

Add a third theme line of type Male, from the Individuals palette and place it on 
the chart below the Sam STEELE theme line. Edit the name of this theme line 
to be Paul SHARP.

Paul SHARP

Sam STEELE

MOONSHADOW

Sighting

Sighting

Sighting

Sighting

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port
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11. On 20 February 2006, Sam STEELE and Paul SHARP were seen together at 
Tricksters Bar in London.

Add an event frame of type Bar, from the Locations palette, place it between 
the Paul SHARP and Sam STEELE theme lines and add the following 
information to it:

12. Add links of type Sighting, from the Individuals palette, between the above 
event frame and both the Sam STEELE and Paul SHARP theme lines.

13. On 27 February 2006, MOONSHADOW was seen moored in a different 
location to its previous sighting in Castries harbor on 24 February 2006.

Add an event frame of type Port, from the Locations palette, place it above the 
MOONSHADOW theme line, after the Moored in port event frame, and add the 
following information to it:

14. Add a link of type Sighting, from the Individuals palette, between the above 
event frame and the theme line MOONSHADOW.

Identity Tricksters Bar

Date & Time 20 Feb 2006 18:10

Description Sam STEELE and Paul SHARP were observed 
drinking together in Tricksters Bar in London. They 
seemed to be having a heated discussion about 
something.

Grades A 1 5

Source Type Officer

Reference DS 685/01

Identity In port

Date & Time 27 Feb 2006 18:30

Description MOONSHADOW was seen moored in a different 
location to its previous sighting in Castries harbor.

Grades A 1 5

Source Type Witness

Reference WS 254
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15. Records show that Paul SHARP flew to St Lucia from Heathrow airport at 11:30 
on 26 February 2006.

Add an event frame of type Airport, from the Locations palette, place it below 
the Paul SHARP theme line, after the Seen in bar event frame, and add the 
following information to it:

16. Add a link of type Traveled, from the Transport palette, between the above 
event frame and the Paul SHARP theme line.

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Identity Heathrow

Date & Time 26 Feb 2006 11:30

Description SHARP flew to St Lucia on the 11:30 flight from 
Heathrow.

Grades A 1 5

Source Type Record

Reference FM AB163

Paul SHARP

Sam STEELE

MOONSHADOW

Sighting

Sighting

SightingSighting

Sighting

Traveled

SightingSighting

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

nday 20th February 2006 Friday 24th February 2006 Saturday 25th February 2006 26th February 2006 Monday 27th Februa
3:00 14:00 16:00 17:4017:0015:00 21st 22nd 23rd 15:00 21:0018:0000:00 03:00 09:0006:00 18:0012:00 06:00 12:0000:00 19:00 20:00 21:12:0000:0000:00
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Varying the Style of a Theme Line Segment 6.4

Theme line segments are created between connected items on a theme line, for 
example:

Sometimes your information concerning the time between connecting items on a 
theme line may be vague or tentative. You can change the style of the theme line 
segment to highlight that you do not know what happened over this period of time. 

You can edit the style of a theme line segment so that individual segments of time 
are displayed differently on the theme line.

You can edit the following display properties of a theme line segment:

• line color

• line width

• line strength

You do not know what Sam STEELE did in the intervening period between him 
being seen entering Castries harbor on board MOONSHADOW on 24 February 
2006 and being seen in the Liquide X bar on 25 February 2006.

Change this segment of the Sam STEELE theme line to indicate that this 
information is vague. To do this:

1. Right-click on the Sam STEELE theme line between the event frames 
Observed and Seen in bar and from the shortcut menu, select Edit Item 
Properties. This displays the Edit Theme Line dialog.

John
15 Jan 2006

06:30

Got out of bed

15 Jan 2006
07:00

Had breakfast

15 Jan 2006
19:00

Returned from
work

15 Jan 2006
07:30

Went to work

Segment Segment Segment

How do I change the style of a segment of a theme line?

John
15 Jan 2006

06:30

Got out of bed

15 Jan 2006
07:00

Had breakfast

15 Jan 2006
19:00

Returned from
work

15 Jan 2006
07:30

Went to work
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2. Select Style\Segments to display the Segment Properties page.

3. The theme line segment between the Observed and Seen in bar event frames 
is highlighted. In the Color column, click the drop-down arrow and select the 
color Red.

4. In the Strength column, click the drop-down arrow and select Unconfirmed 
from the drop-down list.

5. Click OK to close the Edit Theme Line dialog.
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The Sam STEELE theme line between the Observed and Seen in bar event 
frames is now displayed on the chart as a red dashed line to indicate that the 
information is vague.

6. You also know that the intervening period between MOONSHADOW being 
seen entering the harbor at Castries on 24 February 2006 and being moored in 
the port on 25 February is vague. Double-click the MOONSHADOW theme line 
between the Observed and Moored in port event frames to display the Edit 
Theme Line dialog. 

7. Using the same method that you used to change the segment style on the Sam 
STEELE theme line, set the line strength to be unconfirmed and its color to be 
red.

The MOONSHADOW theme line now has a segment between the Observed 
and Moored in port event frames that is unconfirmed and red.

Sam STEELE

MOONSHADOW

Sighting

Sighting

Sighting

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar
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Your chart should look similar to that below:

Click the Save toolbar button to save your chart.

Paul SHARP

Sam STEELE

MOONSHADOW

Sighting

Sighting

Sighting

Sighting

Sighting

Traveled

Sighting

Sighting

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

nday 20th February 2006 Friday 24th February 2006 Saturday 25th February 2006 26th February 2006 Monday 27th Februa
3:00 14:00 16:00 17:4017:0015:00 21st 22nd 23rd 15:00 21:0018:0000:00 03:00 09:0006:00 18:0012:00 06:00 12:0000:00 19:00 20:00 21:12:0000:0000:00
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Working with Theme Line Styles 6.5

There are a number of ways that you can change the way that a theme line is 
displayed on your chart.

You can change the symbol (or terminator) that is displayed at the beginning of a 
theme line (the left terminator) or the end of a theme line (the right terminator), for 
example a triangle, closed circle, open circle:

You can also choose not to have a terminator on your theme line:

You can extend the theme line so that it reaches to the leftmost and rightmost item 
on the chart, for example:

John

John

Mary

John

General

General

Met for
lunch

Went
shopping

Met friends in
coffee shop
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Alternatively, you can choose not to extend the theme line to the leftmost or 
rightmost items on the chart, for example:

The theme lines are currently displayed on your chart with closed circles for both 
the leftmost and rightmost terminators. Set the terminator style for all of the theme 
lines on your chart so that the leftmost terminator is a filled triangle and the 
rightmost terminator is an open circle. To do this:

1. Position your mouse just above and to the left of the MOONSHADOW theme 
line, hold down the left mouse button and drag the mouse down and to the right 
so that the selection box extends to include all of the theme line icons. Release 
the mouse button, the selection box disappears but everything that was in it is 
selected.

Note: Make sure that only the theme lines are selected.

2. With the theme lines selected, right-click on one of them, and from the shortcut 
menu select Combined Properties.

Mary

John

General

General

Met for
lunch

Went
shopping

Met friends in
coffee shop

How do I change the terminator style of a theme line?
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3. Select Style\Theme Lines\Display to display the Theme Line Display page:

4. From the Left Terminator drop-down list, select Triangle.

5. From the Right Terminator drop-down list, select Open Circle.

6. Click OK.

The theme lines are now displayed on the chart with a triangle as the left 
terminator and an open circle as the right terminator.

Note: If you cannot see both ends of the theme line click the Fit Chart in 
Window toolbar button.
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

The larger a chart becomes, the more difficult it is to see what each item 
represents, particularly if you are zoomed out to see the bigger picture. Analyst’s 
Notebook displays the labels of chart items as you hover your mouse over them. 
To see this:

1. Scroll to the right side of the chart so you cannot see the beginning of any of 
the theme lines. Hover your pointer over one of the theme lines. A tooltip 
appears with the label of the theme line that your mouse is positioned over.

2. Hold your pointer over some of the event frames and the other theme lines on 
the chart to see the label of each item.

Sam STEELE

Paul SHARP

MOONSHADOW

Sighting

Sighting

Sighting

Sighting

Sighting

Traveled

Sighting

Sighting

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

nday 20th February 2006 Friday 24th February 2006 Saturday 25th February 2006 26th February 2006 Monday 27th Februa
3:00 14:00 16:00 17:4017:0015:00 21st 22nd 23rd 15:00 21:0018:0000:00 03:00 09:0006:00 18:0012:00 06:00 12:0000:00 19:00 20:00 21:12:0000:0000:00

How do I see the label of a chart item in a large chart?
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Annotating a Chart with a Legend 6.6

You can create a legend that is the key to the entity types, link types, attribute 
classes and fonts that you have used on your chart. For example, if you want to 
specify which link type has been used to represent a particular type of association 
you can display this link type together with descriptive text in the legend. A legend 
is also a good place to put information relating to version numbers and the date of 
printing.

You can create legend entries for the following chart items:

• entity icons

• attributes

• bordered entities

• text labels

• links

You can specify the location of the legend on the chart and its size and style.

Associate

Font Sty le
AaBbYyZz

FemaleMale

Blood Group

Untitled
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Now that you have added all of the happenings that took place during the 
investigation you want to add a legend to summarize the contents of the chart. To 
add a legend to the chart:

1. From the Format menu, select Legend. This will display the Legend 
Population Option dialog:

2. Click Yes. This will display the Edit Legend dialog:

3. You are not interested in displaying any other information on the legend so 
delete each of the other entries. To do this, click Clear All.

How do I add a legend to a chart?
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4. Click the Title button. The Add Legend Title dialog is displayed. Enter the 
following information:

5. Click OK to close the Add Legend Title dialog.

Do not close the Edit Legend dialog.

Themes 
Operation Crest 
A chart showing segments and a legend. 
V 0.1 
7 Jun 2006 
Analyst Fitzwilliams
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You also want to set your legend so that you can move it freely around the chart. To 
do this:

1. Select Properties to display the Legend Properties page.

2. Make sure that the Show on Chart check box is turned on.

3. In the Shape area select Square.

4. In the Horizontal Chart Location and Vertical Chart Location areas select Free.

5. Click OK to close the Edit Legend dialog.

The legend is now displayed on the chart.

6. Drag the legend to the bottom right of your chart.

How can I move the legend around a chart?
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Your chart should now look similar to that below  
(Example 6 finished.anb):

Sam STEELE

Paul SHARP

MOONSHADOW

Sighting

Sighting

Sighting

Sighting

Sighting

Traveled

Sighting

Sighting

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

Themes
Operation Crest

A chart showing segments and a legend.
V 0.1

7 Jun 2006
Analyst Fitzwilliams

nday 20th February 2006 Friday 24th February 2006 Saturday 25th February 2006 26th February 2006 Monday 27th February 2006
3:00 14:00 16:00 17:4017:0015:00 21st 22nd 23rd 15:00 21:0018:0000:00 03:00 09:0006:00 18:0012:00 06:00 12:0000:00 19:00 20:00 22:00 2321:0012:0000:0000:00
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When you have finished adding information to your chart you can print it. You want 
to print this chart so that the legend is printed and theme line names are displayed 
on the left side of each printed page. To do this:

1. From the File menu, select Page Setup to display the Page Setup dialog:

2. First of all, choose a printer. To do this, click the Printer Setup button to display 
the Printer Setup dialog:

If the name of the printer displayed in the Name drop-down list is correct, click 
OK. If not, click the drop-down list and select the correct printer, then click 
OK.The Page Setup dialog will be displayed again.

How do I print a chart with the time bar and theme line names?
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3. You want to print this chart on two landscape pages.To do this:

a. In the Orientation area, select Landscape.

b. In the Scaling area, set the Page(s) Wide by to be 2 and the Page(s) Tall 
to be 1.

4. As you want the chart to be printed as large as possible on the two pages, click 
Adjust, and from the drop-down list select Scale. This option increases or 
decreases the size of the chart, so that it will fit on the number of pages you 
have specified.
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5. The display of the Time Bar, and Theme Line Names is set in the Annotation 
page. Click the Annotation tab to display the Annotation page:

6. Turn on the Time Bar check box. You want the time bar to be printed on each 
page so turn on the Every Page check box.

7. You want the theme line names to be printed on each page; turn on the Theme 
Line Names check box, then turn on the Every Page check box.

8. Click OK to close the Page Setup dialog.
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9. Page Boundaries will now be displayed on your chart, and should look similar 
to that shown below:

10. Print the chart; click the Print toolbar button.

11. Save the chart but do not close it. In the next part of this example you will be 
adding further information to it.

Note: Printing a chart is described in further detail in Viewing Page Boundaries and 
Printing a Chart on page 65.
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Adding Summary Information to a Chart 6.7

When you have created a new chart you can add summary information to it that 
describes its contents. You can add:

• Title

• Subject

• Keywords

• Category

• Comments

• Author

Chart summary information is particularly useful for describing the contents and 
intended use of the chart, which analysts can read on the Cover Sheet when 
opening a chart. For example, the chart summary information is useful if the chart 
has not been used for some time and you, or another analyst, want to have some 
idea about what it contains before opening it. See Cover Sheet on page 32.

The summary information is also displayed as a tooltip when you hold your pointer 
over the chart name in Windows Explorer.

Summary properties are also 
displayed as a tooltip.

Some of the 
summary details 
are displayed in 
the Details section 
of Windows 
Explorer.
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In addition to adding summary properties, you can also add custom properties to 
describe and classify the chart with terms or classifications that are specific to your 
team or organization. The Case and Classification custom properties are provided 
with every new chart that you create from the standard template to which you can 
add values, and add new custom properties.

The custom properties are not displayed as a tooltip in Windows Explorer, 
however, they can be viewed on the Custom page of the Windows File Properties 
dialog.

Typically, you will add and amend your summary and custom properties in the 
Cover Sheet when you open and save your charts. See Saving Charts and the 
Cover Sheet on page 32. However, they can be created and amended at any time 
using the Chart Properties dialog.

Add summary properties to the chart to help other authors find the chart in the 
future and understand its contents. 

1. From the File menu, select Chart Properties.

How do I add a summary to a chart using Chart Properties?
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2. Select Summary\Description to display the Description page of the Chart 
Properties dialog.

3. Enter the following information in the summary fields:

Note: You can use the Tab key to move between the boxes on the Description 
page.

Title Drug Smuggling Activities involving 
MOONSHADOW

Subject St Lucia Drug Smuggling

Keywords Drugs, "St Lucia", MOONSHADOW

Category Surveillance

Comments This is an example from the i2 Analyst’s Notebook 
8 User Guide.
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4. Select Summary\Origin to display the Origin page of the Chart Properties 
dialog.

5. Type <your name> in the Author box.

You have now completed the summary properties.

Do not close the Chart Properties dialog.

When you create a new chart from the User Guide Examples template, custom 
properties called Case and Classification are created for you to add values. Add 
the text value St Lucia to the existing Case custom property, and Restricted to the 
existing Classification custom property. 

1. Select Summary\Description to display the Description page of the Chart 
Properties dialog.

How do I edit a custom property using Chart Properties?
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2. In the Custom area of the Description page, select the Case custom property 
and click Edit to display the Edit Classification Property dialog.

3. Type St Lucia in the Value box, and click OK.

4. Select the Classification custom property and click Edit to display the Edit 
Classification Property dialog

5. Type Restricted in the Value box, and click OK.

The Case and Classification custom properties have now been edited.

Do not close the Chart Properties dialog.

Create an additional custom property to record the draft status of the chart.

1. Click New to display the New Custom Property dialog.

2. Delete the text in the Name box and type Draft Status.

3. Delete the text in the Value box and type Final.

How do I create custom properties using Chart Properties?
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4. Click OK to close the New Custom Property dialog, and to create the Case and 
Draft Status custom properties. The completed Chart Properties Description 
page should look similar to that below:

5. Click OK to close the Chart Properties dialog.

6. Click the Save toolbar button to save your chart.

Close the chart.

You can search for a file using any summary information that you have added. To 
do this:

1. Start Windows Explorer from the Windows Start menu and select 
All Programs ➧ Accessories ➧ Windows Explorer.

How do I find a chart using summary information?
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2. Click the Search toolbar button. This displays the Search page of Windows 
Explorer:

3. In the What do you want to search for? area, select All files and folders. This 
displays the following dialog:

4. In the A word or phrase in the file box, type MOONSHADOW. This was one of 
the keywords you added as summary information to your chart.
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5. In the Look In box, type C:\Documents and Settings\My Documents, 
or wherever you have saved the charts that you have created as you have been 
working through the examples in this guide.

6. Click Search.

Windows Explorer searches for any files containing the text MOONSHADOW. 
The search results are displayed in the Search Results dialog:

Do not close Windows Explorer.
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When you have added summary information to your chart you can see this 
information in Windows Explorer. To do this:

Hold your pointer over this file in the file list; the summary information that you 
added to this chart is shown in a tooltip.

How do I see summary information?
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Summary 6.8

In this example you will have learned how to:

• display the time bar

• add theme lines to your chart

• link event frames to theme lines

• change the style of a theme line

• annotate a chart with a legend

• add summary and custom property information to a chart using Chart 
Properties
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7
Working with Theme Lines

This chapter describes how to automatically link event frames to theme lines. It 
also explains how to edit the display properties of event frames and theme lines.
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Displaying Link Information in Event Frames 259

Summary 262
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Introduction 7.1

The features covered in detail in this example are:

• automatically linking event frames to theme lines

• diverting theme lines through event frames

• showing link information on diverted event frames

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished chart (Example 7 finished.anb) at any time while 
you are working through this example. To access the folder in which this chart is 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.
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Scenario

In previous examples you have been charting information regarding drug 
smuggling activities involving a private motor cruiser called MOONSHADOW and 
its crew. Further information has been received about the suspects.

Information has been received that Paul SHARP returned from St Lucia to 
Heathrow on 23 February 2006. 

Further information has been received that a third suspect, Danny KENT, traveled 
to St Lucia on a flight from Heathrow on 26 February 2006. Danny KENT is a 
known associate of Paul SHARP and Sam STEELE.

Two of the suspects, Paul SHARP and Sam STEELE, were seen drinking in 
Tricksters Bar in London on 20 February 2006. This information has already been 
charted on the existing chart. 

Sam STEELE and MOONSHADOW were both observed in the harbor on 
24 February 2006. 

At some time after the meeting in Tricksters Bar on 20 February 2006, Paul 
SHARP traveled to St Lucia. You have details about his return journey but you do 
not have any information about how he traveled to St Lucia.

Paul SHARP and Sam STEELE were seen meeting in a hotel in London on 
27 February.

All three suspects were observed acting suspiciously in the harbor on 25 February 
2006.
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Automatically Linking Event Frames 7.2

In Chapter 6, Introducing Theme Lines you added event frames to your chart and 
linked them manually to theme lines. In Analyst’s Notebook you can also link event 
frames to theme lines automatically. This is useful if you have several theme lines 
on a chart and you want to link an event frame to all of them.

The link type that is used is the last used link type for your chart. If you want to use 
any link type other than the last used link type, select it before you add the event 
frame to the theme line, or change the link type as you automatically link an event 
frame to a theme line.

It is good practice to link event frames to theme lines if they are related.

Information has been received that Paul SHARP returned from St Lucia to 
Heathrow on 23 February 2006. Create an event frame to represent this 
information and automatically link it, using a link of type General, to the Paul 
SHARP theme line. To do this:

1. Open the chart Example 7 initial.anb. To access the folder in which this 
chart is stored, double-click on the User Guide Example Material shortcut in 
the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-
click on the Creating Charts folder.

In Chapter 6, Introducing Theme Lines you created a chart that contained 
several theme lines and event frames to represent the information that had 
been received about two suspects (Sam STEELE and Paul SHARP) and the 
MOONSHADOW cruiser. You then manually linked the event frames to the 
theme lines.

How do I automatically link an event frame to a theme line?
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In this example you will continue to use the chart that you created in Chapter 6, 
Introducing Theme Lines, and add further information to it.

2. Save this chart using Save As from the File menu. Click OK on the Cover 
Sheet dialog to display the Save As dialog. Select the folder you created to 
save your charts in. Type Example 7 more theme lines.anb in the File 
Name box and click Save.

3. Click the drop-down arrow on the Insert Link toolbar button and select 
Standard ➧ General to select the General link type from the Standard palette.

Note: Select the required link type before you automatically link an event 
frame to a theme line. This ensures that the event frame is linked to the 
theme line with the correct link type.

4. Click the drop-down arrow on the Insert Event Frame toolbar button and select 
Locations ➧ Airport to select the Airport type from the Locations palette.

Sam STEELE

Paul SHARP

MOONSHADOW

Sighting

Sighting

Sighting

Sighting

Sighting

Traveled

Sighting

Sighting

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

Themes
Operation Crest

A chart showing segments and a legend.
V 0.1
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nday 20th February 2006 Friday 24th February 2006 Saturday 25th February 2006 26th February 2006 Monday 27th February 2006
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5. While holding down the Ctrl key, place the event frame on the Paul SHARP 
theme line. 

Note: When you drag the new event frame near to the Paul SHARP theme line 
the pointer changes to a cross and a tooltip displays the label of the 
theme line. When you place the event frame on the theme line it will 
automatically link to it.

6. Click on the theme line and release the Ctrl key. Add the following information 
to this event frame:

Further information has been received that a third suspect, Danny KENT, traveled 
to St Lucia on a flight from Heathrow on 26 February 2006. To represent this 
information on the chart add a new theme line for Danny KENT and then add a 
new event frame so that it is automatically linked to this theme line. To do this:

1. Click the drop-down arrow on the Insert Theme Line toolbar button and select 
Individuals ➧ Male to select the Male type from the Individuals palette. Place 
this theme line above the MOONSHADOW theme line and edit its identity to be 
Danny KENT. 

2. Add a new event frame of type Airport and link it automatically to the Danny 
KENT theme line with a General link type. To do this:

a. Click the drop-down arrow on the Insert Event Frame toolbar button and 
select Locations ➧ Airport to select the Airport type from the Locations 
palette.

b. Hold down the Ctrl+Alt keys.

Identity Return

Date & Time 23 Feb 2006 12:30

Description SHARP returned from St Lucia to Heathrow.

Grades A 1 5

Source Type Record

Source Reference FM AB164

How do I change the link type while adding an event frame?
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c. Drop the event frame directly onto the Danny KENT theme line.

d. As you drop the event frame onto the theme line release the Ctrl and Alt 
keys. The Edit Link dialog is displayed.

3. Type Flew to St Lucia in the Label box.

4. Select Style\Type to display the Type page:

5. Select the Traveled link type.

6. Click OK to close the Edit Link dialog.
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7. Add the following information to this event frame:

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Identity Departure

Date & Time 26 Feb 2006 08:30 

Description KENT boarded a flight to St Lucia. He traveled on 
a cash paid, open return ticket.

Grades A 1 5

Source Type Record

Source Reference FM AB165

MOONSHADOW

Danny KENT

Sam STEELE

Paul SHARP

Sighting

Sighting

Sighting

Sighting

Sighting

Sighting

Traveled

Sighting

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

A 1 5

23 Feb 2006 12:30

FM AB164Record

SHARP returned from St
Lucia to Heathrow.

Return

A 1 5

26 Feb 2006 08:30

FM AB165Record

KENT boarded a flight to St
Lucia. He traveled on a cash

paid, open return ticket.

Departure

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

Themes
Operation Crest
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Changing Theme Line Display Using Wiring 7.3

Theme line wiring describes the way that a theme line diverts to pass through an 
event frame and how it travels between event frames. It also describes the vertical 
location at which the end of the theme line is drawn.

You can specify three different wiring height styles:

• previous event frame

• next event frame

• theme line icon

Previous event 
frame

When theme line wiring is set to Previous Event Frame, it maintains the height of 
the theme line diverting through the previous event frame on the chart.

Next event 
frame

When the theme wiring height is set to Next Event Frame, it maintains the height of 
the theme line diverting through the next event frame on the chart. 

John

Meeting

Meeting Meeting

Meeting

Theme line
is at the same
height as the
theme line diverting
through the previous event frame.

John

Meeting

Meeting Meeting

Meeting

Theme line 
is at the same
height as the theme 
line diverting through the 
next event frame.
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Theme Line 
icon

When the theme wiring height is set to Theme Line Icon, the theme line maintains 
the same height as the theme line icon.

Two of the suspects, Paul SHARP and Sam STEELE were seen drinking together 
in Tricksters Bar in London on 20 February 2006. An event frame for this is already 
on the chart. You now want to divert the Paul SHARP and Sam STEELE theme 
lines through this event frame. To do this:

1. Right-click on the Tricksters Bar event frame and select Divert Theme Line ➧ 

Paul SHARP from the shortcut menu. The Paul SHARP theme line is diverted 
through the Tricksters Bar event frame:

Note: An event frame must be linked to a theme line before you can divert the 
theme line through it.

2. Repeat the process and divert the Sam STEELE theme line through the 
Tricksters Bar event frame.

John

Meeting Meeting MeetingMeeting

Theme line is at the
same height as the theme
line icon.

How do I divert a theme line through an event frame?

Sam STEELE

Paul SHARP

Sighting

A 1 5

23 Feb 2006 12:30

FM AB164Record

SHARP returned from St
Lucia to Heathrow.

Return

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar
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Both the Paul SHARP and Sam STEELE theme lines are diverted through the 
Tricksters Bar event frame.

Sam STEELE and MOONSHADOW were both observed in the harbor on 24 
February 2006. Divert the Sam STEELE and MOONSHADOW theme lines 
through the Observed event frame and change the wiring height of the theme 
lines. To do this:

1. Right-click on the event frame Observed and from the shortcut menu, select 
Divert Theme Line ➧ All Theme Lines.

Sam STEELE

Paul SHARP

A 1 5

23 Feb 2006 12:30

FM AB164Record

SHARP returned from St
Lucia to Heathrow.

Return

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

How do I change the wiring height of a theme line?



Changing Theme Line Display Using Wiring

252 i2 Analyst’s Notebook 8 User Guide: Creating Charts

Both the Sam STEELE and MOONSHADOW theme lines are diverted through 
the Observed event frame:

2. Right-click on the MOONSHADOW theme line between the Observed and 
Moored in port event frames, and from the shortcut menu, select Wiring 
Height ➧ Previous Event Frame.

The theme line segment between the Observed and Moored in port event 
frames is displayed at the same height as the previous event on the chart:

3. In the same way, make sure that the theme wiring height on the Sam STEELE 
theme line between the Observed and Seen in bar event frames is set to 
Theme Line Icon.

Sam STEELE

MOONSHADOW

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

MOONSHADOW
Sighting

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar
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4. Divert the theme lines below through the event frames and change the wiring 
height of the theme line as indicated:

Tidy up the chart by dragging the event frames on the theme lines.

Your chart should now look similar to that below:

Theme Line
between 
Event Frame...

and 
Event Frame...

Wiring Height

MOONSHADOW Observed Moored in port Theme Line Icon

Paul SHARP Tricksters Bar Return Previous Event 
Frame

Sam STEELE Tricksters Bar Observed Previous Event 
Frame

MOONSHADOW

Danny KENT

Sam STEELE

Paul SHARP

Sighting

Sighting

Sighting

Traveled

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

A 1 5

23 Feb 2006 12:30

FM AB164Record

SHARP returned from St
Lucia to Heathrow.

Return

A 1 5

26 Feb 2006 08:30

FM AB165Record

KENT boarded a flight to St
Lucia. He traveled on a cash

paid, open return ticket.

Departure

Themes
Operation Crest
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At some time after the meeting in Tricksters Bar on 20 February 2006, Paul 
SHARP traveled to St Lucia. You have details about his return journey but you do 
not have any information about how he returned from St Lucia. On the Paul 
SHARP theme line, make the segment between the Tricksters Bar and Return 
event frames to be unconfirmed and red.

Note: For further information on how to change the style of a theme line segment, refer to 
Varying the Style of a Theme Line Segment on page 213.

Click the Save toolbar button to save your chart.

Changing the style of a theme line segment
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Automatically Linking to Multiple Theme Lines 7.4

You may want to add an event frame so that it links to more than one theme line. 
Rather than linking the event frame to each theme line in turn you can add an 
event frame and link it to more than one theme line automatically.

When you automatically add an event frame to more than one theme line the 
theme wiring will alter according to the theme lines that it is placed on and its 
position on the theme lines.

Paul SHARP and Sam STEELE were seen meeting in a hotel in London on 27 
February. Add an event frame to the chart, linking it automatically to both the Paul 
SHARP and Sam STEELE theme lines. To do this:

1. Select the theme lines Paul SHARP and Sam STEELE, in that order. 

2. Click the drop-down arrow on the Insert Event Frame toolbar button and select 
Standard ➧ Meeting to select the Meeting type from the Standard palette.

3. While holding down the Alt and Ctrl keys, click on the chart, then release the Alt 
and Ctrl keys. The Edit Link dialog is displayed.

4. Type Attendee in the Label box.

How do I automatically link to more than one theme line?
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5. Select Style\Type to display the Type page:

6. Select the Attendee link type and click OK to close the Edit Icon dialog.

This will set the link type on the Paul SHARP theme line to be Attendee.

7. The Edit Link dialog is displayed once again so that you can edit the link on the 
Sam STEELE theme line. Repeat the steps above, edit the link label to be 
Convenor and select Convenor as the link type.

8. Click OK to close the Edit Link dialog.

9. Add the following information to this event frame:

Identity Meeting in hotel

Date & Time 27 Feb 2006 17:30 

Description Both met in a hotel bar. Agenda unknown.

Grades A 1 5

Source Type Officer

Source Reference DS 487/01
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The event frame is automatically linked to the Paul SHARP and Sam STEELE 
theme lines using the specified link types. It is also placed at its correct location on 
the chart, relative to its date and time.

All three suspects were observed acting suspiciously in the harbor on 25 February 
2006. Add an event frame so that it is automatically linked to each of the theme 
lines. To do this:

1. Select the Sam STEELE, Paul SHARP and Danny KENT theme lines.

2. Click the drop-down arrow on the Insert Link toolbar button and select 
Standard ➧ Sighting to select the Sighting link type from the Standard palette.

3. Click the drop-down arrow on the Insert Event Frame toolbar button and select 
Crime ➧ Surveillance to select the Surveillance type from the Crime palette.

4. While holding down the Ctrl key, drop the event frame directly onto the Danny 
KENT theme line. Release the Ctrl key. The event frame is automatically linked 
to each of the selected theme lines.

5. Add the following information to this event frame:

Adding further information

Identity Seen in harbor

Date & Time 25 Feb 2006 18:20

Description All three were seen walking in the harbor. They 
seemed very nervous, constantly checking around 
them as if to ensure that they were not being 
followed.

Grades A 1 5

Source Type Witness

Source Reference WS 472
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When you added the Seen in harbor event frame to the chart, the links between 
the theme lines and this event frame made the chart look untidy and difficult to 
read. Before you can present this chart you will need to remove any crossed links 
and rearrange the other items on the chart. To do this:

1. Right-click on the Danny KENT theme line, and from the shortcut menu, select 
Select Connections.

2. Right-click once again on the Danny KENT theme line and this time select 
Select Ends. The Danny KENT theme line and the Departure and Seen in 
harbor event frames are selected. 

3. While holding down the Shift key drag the selected items down the chart and 
place them just below the Paul SHARP theme line.

4. Tidy the chart up further by dragging event frames on the theme lines so that 
the chart is easier to read.

Your chart should look similar to that below:

Click the Save toolbar button to save your chart.

How do I reorder theme lines?

Paul SHARP

Danny KENT

Sam STEELE

MOONSHADOW

Sighting

Sighting

Sighting

Traveled

A 1 5

27 Feb 2006 17:30

DS 487/01Officer

Both met in a hotel bar.
Agenda unknown.

Meeting in hotel

A 1 5

26 Feb 2006 08:30

FM AB165Record

KENT boarded a flight to St
Lucia. He traveled on a cash

paid, open return ticket.

Departure

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow
A 1 5

23 Feb 2006 12:30

FM AB164Record

SHARP returned from St
Lucia to Heathrow.

Return

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

A 1 5

25 Feb 2006 18:20

WS 472Witness

All three were seen walking in the
harbor. They seemed very

nervous, constantly checking
around them as if to ensure that
they were not being followed.

Seen in harbor

Themes
Operation Crest

A  chart showing segments and a legend.
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Displaying Link Information in Event Frames 7.5

When you divert a theme line through an event frame it is not possible to see the 
links that are connected to it. In Analyst’s Notebook you can change the display of 
the event frame to show the link area. This makes it easier to see which theme 
lines are diverting with which links.

If you have an event frame that is linked to more than one theme line (for example, 
in this chart the Seen in harbor event frame is linked to the Sam STEELE, Paul 
SHARP, and Danny KENT theme lines), it is possible to display information about 
the link on the event frame itself. To do this:

1. Right-click on the Seen in harbor event frame, and from the shortcut menu, 
select Edit Item Properties. This will display the Edit Event Frame dialog.

Mary

John

Mary and John
met in a bar in

London.

Meeting in bar

Mary : Convenor

John : Attendee

How do I display type names using the link area of an event frame?
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2. Select Style\Display.

3. Turn on the Link Area check box and click OK.

The event frame is now displayed on the chart with three link areas that 
describe each of the theme lines and how they are linked to the event frame:

A 1 5

25 Feb 2006 18:20

WS 472Witness

All three were seen walking in the harbor.
They seemed very nervous, constantly

checking around them as if to ensure that
they were not being followed.

Seen in harbor

Danny KENT : Sighting

Paul SHARP : Sighting

Sam STEELE : Sighting
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Your chart should now look similar to that below (Example 7 finished.anb):

Click the Save toolbar button to save your chart.

Paul SHARP

Danny KENT

Sam STEELE

MOONSHADOW

Sighting

Sighting

Sighting

Traveled

A 1 5

27 Feb 2006 17:30

DS 487/01Officer

Both met in a hotel bar.
Agenda unknown.

Meeting in hotel

A 1 5

26 Feb 2006 08:30

FM AB165Record

KENT boarded a flight to St
Lucia. He traveled on a cash

paid, open return ticket.

Departure

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow
A 1 5

23 Feb 2006 12:30

FM AB164Record

SHARP returned from St
Lucia to Heathrow.

Return

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

A 1 5

25 Feb 2006 18:20

WS 472Witness

All three were seen walking in the harbor.
They seemed very nervous, constantly

checking around them as if to ensure that
they were not being followed.

Seen in harbor

Danny KENT : Sighting

Paul SHARP : Sighting

Sam STEELE : Sighting

Themes
Operation C rest

A chart showing segments and a legend.
V 0.1

7 Jun 2006
Analyst Fitzwilliams

onday 20th February 2006 Friday 24th February 2006 Saturday 25th February 2006 Saturday 25th February 2006 Saturday 25th February 2006 Sunday 26th February 2006 Monday 27th February 2006
3:00 14:00 16:00 17:0015:00 18:00 12:0021st 12:0022nd 23rd 15:00 21:0018:0000:00 03:00 09:0006:00 14:00 16:00 17:0015:00 19:00 21:0018:0012:00 03:00 06:00 18:0012:0000:00 06:00 16:00 19:00 20:00 21:18:0012:0000:0000:00
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Summary 7.6

In this example you will have learned how to:

• change theme line display using wiring

• work with theme lines

• show link information on diverted event frames
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8
Ordered and Controlling Items

This chapter describes how you can add date, time and order to items on your 
chart.
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Introduction 8.1

The features covered in detail in this example are:

• using the time bar

• duplicating items

• ordering items using pins

• timed links

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished chart (Example 8 finished.anb) at any time while 
you are working through this example. To access the folder in which this chart is 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.
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Scenario

On 20 November 2006, an officer observed the three suspects, KENT, SHARP and 
STEELE meeting in a hotel in the US. At one point they were seen looking at a 
map on which KENT made some markings.

After the meeting in the US, the three suspects returned to the UK but it is not 
known how they traveled back.

On 26 November 2006, at 09:30, KENT was seen leaving his home in the UK. He 
walked to a local travel agent and booked a flight, after which he spent some time 
visiting other shops in town. There are witness statements from Tanya OLCOTT 
and Steve DESOUZA to corroborate the fact that he was in town at this time. While 
he was in town, KENT made a payment for an earlier flight booking. 

That same morning, at approximately 10:30, KENT, STEELE and SHARP were 
seen meeting in a coffee shop in town. KENT arrived on foot and both STEELE 
and SHARP arrived together in STEELE’s car. 

Two days later, 28 November 2006 at approximately 11:00, SHARP and KENT 
were sighted meeting for a second time in a bar in London. Before this meeting two 
telephone calls took place within a few minutes of each other. A further telephone 
call was made shortly after this meeting.

We also have statements and credit card information relating to the flight that 
KENT booked in the travel agent.
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Using the Time Bar 8.2

In Analyst’s Notebook you can display the time bar at the top of your chart to show 
the date and time that happenings occurred. It is useful to display the time bar 
when you are charting happenings that have occurred over a period of time.

You can choose which components of the time bar are displayed on your chart. A 
typical time bar showing all of its components is shown below:

A time bar consists of the following components:

• Interval band

The interval band shows you the intervals that the time bar is displayed in, for 
example hours, days, weeks.

You can edit the line color of the interval band and specify a font for interval 
labels. You can also choose the alignment of the interval label within the 
interval band.

Interval Band
Tick Band
Marker Band

Minor TickMarker SymbolMajor Tick

Interval Label

Overlap Marker
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• Tick band

The tick band consists of major ticks, for example hourly intervals. Each major 
tick may be labeled with the time. Minor ticks show intervals of time between 
the major ticks, for example minutes. Minor ticks do not have any labels but if 
you move your mouse over a minor tick a tooltip, containing the date and time 
at that point on the chart, will be displayed.

As with the interval band you can edit the line color of the tick band and specify 
the font to be used for tick labels. You can also specify where the label is placed 
on the tick.

• Marker band

The marker band contains marker symbols which indicate when there are 
items on the chart that have a time and order specified. Marker symbols appear 
in the time bar directly above any ordered items that have a date and time. An 
overlap marker is displayed if you have two or more chart items that are 
positioned in close proximity to each other on the chart.

Overlap markers and marker symbols do not have any labels. If you hold your 
pointer over a marker symbol a tooltip will be displayed containing the label of 
the chart item and its date and time. If you hover your mouse over an overlap 
marker a tooltip will be displayed showing how many chart items are at that 
position on the chart.

You can edit the line color of the marker band and the color to be used for the 
marker symbol and the overlap marker.

If you add an item to the chart that has a date and time and order specified and it is 
placed before the first item on the chart, or after the last item on the chart, the time 
bar will extend to either the left or the right to accommodate the item on the chart.

If you create a new chart with items that have no date and time or order, the time 
bar will use the default date and time from the chart properties and the time scale 
to control the flow of time across the chart.

There are a number of additional display options you can set for your time bar, for 
example, its background and border colors.
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You have received information that an officer saw the three suspects, STEELE, 
SHARP and KENT together in a hotel in the US on 20 November 2006 at 22:48. 
On 26 November 2006, KENT was seen leaving his home and walking to a local 
travel agent where he booked a flight. At the same time STEELE was observed 
leaving his home and driving to collect SHARP, they both continued on to the 
meeting in STEELE’s car. Display the time bar and add this information to the 
chart, so that you can see when the happenings occurred. To do this:

1. Create a new chart based on the User Guide Examples template. For more 
information on how to do this, refer to How do I create a new chart based on a 
template? on page 20.

2. Save this chart using Save As from the File menu. Click OK on the Cover 
Sheet to display the Save As dialog. Select the folder you created to save your 
charts in. Type Example 8 ordered and controlling.anb in the File 
Name box and click Save.

3. Click the Time Bar toolbar button. The time bar is displayed at the top of your 
chart. 

4. Click the drop-down arrow on the Insert Theme Line button and select 
Individuals ➧ Male to select the Male type from the Individuals palette.

5. While holding down the Shift key, drop three theme lines onto your chart.

Note: Before you add the third theme line to your chart release the Shift key.

How do I display the time bar?
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6. Edit the names of the theme lines to be STEELE, SHARP and KENT:

7. Click the drop-down arrow on the Insert Event Frame toolbar button and select 
Standard ➧ Meeting to select the Meeting type from the Standard palette. 
Place it to the right of the theme lines and add the following information to it:

8. Click the drop-down arrow on the Insert Link toolbar button and select 
Individuals ➧ Attendee to select the Attendee link type from the Individuals 
palette.

STEELE

SHARP

KENT

Identity Seen in a hotel in the US

Date & Time 20 Nov 2006 22:48

Description STEELE, SHARP and KENT were seen together 
in a hotel in the US. At one point they were all 
looking at a navigational map on which STEELE 
made some markings.

Grades A 1 5

Source Type Officer

Source Reference CS 634/01
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9. Add links between the Seen in a hotel in the US event frame and each of the 
theme lines:

10. Add an event frame of type Surveillance, from the Crime palette. Place it to the 
right of the Seen in a hotel in the US event frame, just below the KENT theme 
line and add the following information to it:

Identity Left home

Date & Time 26 Nov 2006 09:30

Description KENT left home and walked to a local travel agent.

Grades A 1 5

Source Type Officer

Source Reference UC 889/01

KENT

SHARP

STEELE

Attendee

Attendee

Attendee

A 1 5

20 Nov 2006 22:48

CS 634/01Officer

STEELE, SHARP and KENT were seen
together in a hotel in the US. At one

point they were all looking at a
navigational map on which STEELE

made some markings.

Seen in a hotel in the US
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11. Add a link of type General, from the Standard palette, between the Left home 
event frame and the KENT theme line.

12. Add an event frame of type Car, from the Transport palette. Place it to the right 
of the Seen in a hotel in the US event frame, between the STEELE and SHARP 
theme lines and add the following information to it:

13. Add links of type General, from the Standard palette, between the above event 
frame and the STEELE and SHARP theme lines.

Identity Left UK home

Date & Time 26 Nov 2006 (no time)

Description STEELE left his home address and drove to collect 
SHARP.

Grades A 1 5

Source Type Officer

Source Reference UC 789/01
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

KENT

SHARP

STEELE

Attendee

Attendee

Attendee

General

General

General

A 1 5

20 Nov 2006 22:48

CS 634/01Officer

STEELE, SHARP and KENT were seen
together in a hotel in the US. At one

point they were all looking at a
navigational map on which STEELE

made some markings.

Seen in a hotel in the US

A 1 5

26 Nov 2006 09:30

UC 889/01Officer

KENT left home and walked
to a local travel agent.

Left home

A 1 5

26 Nov 2006 HH:mm

UC 789/01Officer

STEELE left his home
address and drove to

collect SHARP.

Left UK home

Monday 20th November 2006 Sun
19:00 20:00 22:0021:00 12:0000:00 12:0022nd 12:0023rd 12:0024th 12:00 10:00 11:00 100:0025th
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You know that STEELE and SHARP left home sometime before the meeting on 26 
November 2006, but you do not know the exact time. Add a description of the time 
and display this in the Left UK home event frame. To do this:

1. Right-click on the Left UK home event frame, and from the shortcut menu, 
select Edit Item Properties to display the Edit Event Frame dialog.

2. Select Data\Date & Time to display the Date & Time page:

3. In the Description of Date & Time box type:

26 Nov 2006

In the morning. 

Do not close the Edit Event Frame dialog.

How do I add a description of the time?
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4. The description of the date and time will not be automatically displayed on the 
chart so you will need to set the display properties of the event frame so that it 
is displayed. To do this, select Style\Display to display the Display page:

5. In the Displayed Date & Time area select Description.

6. Click OK to close the Edit Event Frame dialog.

The event frame is displayed on the chart with a description of the time:

A 1 5

26 Nov 2006
In the morning.

UC 789/01Officer

STEELE left his home
address and drove to

collect SHARP.

Left UK home
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

STEELE

SHARP

KENT

Attendee

Attendee

Attendee

General

General

General

A 1 5

20 Nov 2006 22:48

CS 634/01Officer

STEELE, SHARP and KENT were seen
together in a hotel in the US. At one

point they were all looking at a
navigational map on which STEELE

made some markings.

Seen in a hotel in the US

A 1 5

26 Nov 2006
In the morning.

UC 789/01Officer

STEELE left his home
address and drove to

collect SHARP.

Left UK home

A 1 5

26 Nov 2006 09:30

UC 889/01Officer

KENT left home and walked
to a local travel agent.

Left home

Monday 20th November 2006 Sund
19:00 20:00 22:0021:00 12:0000:00 12:0022nd 12:0023rd 12:0024th 12:00 10:00 11:00 1200:0025th
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Duplicating Items 8.3

Duplicating an item is a quick way of creating an instant copy of that item within the 
same chart. You can duplicate entities and links. 

A duplicated entity has a different identity to the original, but has all the same data 
style and display properties. 

Duplicate is useful when you want to create a chart item with a similar appearance 
to an existing item, but do not want to change the default style for a representation.

You do not know when each of the three suspects returned to the UK. Add an 
event frame to each of the theme lines to show this information. Show that the time 
the three suspects returned to the UK is vague. To do this:

1. Click the drop-down arrow on the Insert Event Frame toolbar button and select 
Standard ➧ Event to select the Event type from the Standard palette.

The Event type may not be immediately visible on the Standard palette. If you 
cannot see it, refer to page 101.

Place the event frame on the chart so that it is positioned above the STEELE 
theme line, between the Seen in a hotel in the US and Left UK home event 
frames. 

How do I duplicate an entity?
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2. Right-click on the event frame, and from the shortcut menu, select Edit Item 
Properties to display the Edit Event Frame dialog, and select Data\Identity to 
display the Identity page:

3. In the Identity box, type Traveled back by unknown means.

Do not close the Edit Event Frame dialog.
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4. Select Style\Type to display the Type page:

5. From the Strength drop-down list, select Unconfirmed. This will show that the 
happening about how STEELE returned to the UK is vague.

Do not close the Edit Event Frame dialog.



 Chapter 8: Ordered and Controlling Items

i2 Analyst’s Notebook 8 User Guide: Creating Charts 279

6. Select Style\Display to display the Display page:

7. In the Display area, click Clear All to turn off all of the check boxes.

8. Turn on the Pin and Label check boxes.

9. Click OK to close the Edit Event Frame dialog.

10. Click on the event frame to select it, and from the Tools menu, select 
Duplicate to create a copy of it. A copy of the event frame is placed on the 
chart.
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Notice that the label of the event frame is “copy 1 of Traveled back by unknown 
means”. 

You want the label to be the same for each event frame that you duplicate. To do 
this:

1. Right-click on the copy of the event frame, and from the shortcut menu, select 
Edit Item Properties and select Data\Identity to display the Identity page of 
the Edit Event Frame dialog:

2. Turn on the Label Is Different from Identity check box.

3. In the Label box, replace the text with Traveled back by unknown 
means.

4. Click OK to close the Edit Event Frame dialog.

How do I set the entity label to be different to its identity?

copy 1 of
Traveled back by
unknown means
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5. Click on this event frame, and from the Tools menu, select Duplicate to create 
a copy of it. Notice that this time the event frame has the correct label.

There are now three copies of the event frame Traveled back by unknown 
means on the chart.

6. Using a General link type, link each of the event frames to a theme line and 
place them just after the Seen in a hotel in the US event frame:

7. You also want to show the information that the three suspects traveled back to 
the UK is vague on the individual theme lines. Edit the theme line segments 
immediately before and after the Traveled back by unknown means event 
frames to be red and unconfirmed.

Note: For further information on how to edit theme line segments, refer to 
Varying the Style of a Theme Line Segment on page 213.

KENT

SHARP

STEELE

Attendee

Attendee

Attendee

General

General

General

General

General

General

Traveled back
by unknown

means

Traveled back
by unknown

means

Traveled back
by unknown

means

A 1 5

26 Nov 2006
In the morning.

UC 789/01Officer

STEELE left his home
address and drove to

collect SHARP.

Left UK home

A 1 5

26 Nov 2006 09:30

UC 889/01Officer

KENT left home and walked
to a local travel agent.

Left home

A 1 5

20 Nov 2006 22:48

CS 634/01Officer

STEELE, SHARP and KENT were seen
together in a hotel in the US. At one

point they were all looking at a
navigational map on which STEELE

made some markings.

Seen in a hotel in the US

Monday 20th November 2006 Sund
19:00 20:00 22:0021:00 12:0000:00 12:0022nd 12:0023rd 12:0024th 12:00 10:00 11:00 1200:0025th
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

STEELE

KENT

SHARP

Attendee

Attendee

Attendee

General

General

General

General

General

General

Traveled back
by unknown

means

Traveled back
by unknown

means

Traveled back
by unknown

means

A 1 5

20 Nov 2006 22:48

CS 634/01Officer

STEELE, SHARP and KENT were seen
together in a hotel in the US. At one

point they were all looking at a
navigational map on which STEELE

made some markings.

Seen in a hotel in the US

A 1 5

26 Nov 2006
In the morning.

UC 789/01Officer

STEELE left his home
address and drove to

collect SHARP.

Left UK home

A 1 5

26 Nov 2006 09:30

UC 889/01Officer

KENT left home and walked
to a local travel agent.

Left home

Monday 20th November 2006 Sund
19:00 20:00 22:0021:00 12:0000:00 12:0022nd 12:0023rd 12:0024th 12:00 10:00 11:00 1200:0025th
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Ordering Items Using Pins 8.4

A chart item can have four different behaviors depending on the type of information 
you are adding to the chart.

• It can have no date and time or order on the chart.

This is used most often when you create a chart showing relationships between 
chart items.

• It can have no date or time but a specific order.

This may be used when you create charts where happenings occur in a 
particular order but do not have a date and time specified. An item that is 
constrained by order but not by date and time is known as ordered.

An ordered item is displayed on the chart with its pin turned on, however, if the 
time bar is displayed, the item is not placed at any particular point on the chart 
as it has no date and time specified. An example of a chart containing ordered 
items is shown below:

Address Address

Relative

John

Cambridge

Mary

Kevin DUPLEASE

evening rush
hour

Returns from
work.

Comes home

morning rush hour

Leaves home for
work.

Goes to work

dawn

All is quiet.

Fast asleep

early morning

Has breakfast.

Breakfast

Sunday 1st January 2006 Sunday 1st January 2006 Sunday 1st January 2006 Sunday 1st January 2
01:00 02:00 04:00 05:0003:00 07:00 08:00 10:00 11:0009:0006:00 12:0000:00
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• It can have a date and time with no specific order.

This is used when you create charts in which happenings have a date and 
time, but do not take place in any particular order. An item that has a date and 
time, but no order specified is known as unordered. Typically, this might be a 
timed chart item displayed in a chart showing associations. An unordered item 
is displayed on the chart with its pin turned off. An example of a chart 
containing unordered items is shown below:

Attendee Attendee Sighting Attendee Attendee SightingSighting

TAYLOR DUPLEASE KENTCORNEY

05 Jan 2006 10:30

TAYLOR and
DUPLEASE met

in a hotel in
London.

Meeting

03 Jan 2006 20:30

DUPLEASE was
seen drinking
alone in the
Ritzy bar.

Ritzy Bar

01 Jan 2006 13:00

DUPLEASE and
CORNEY met
in a hotel in

town.

Meeting

02 Jan 2006 19:30

KENT and
CORNEY were
seen drinking
in Jokers Bar.

Jokers Bar
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• It can have both date and time and order.

This is used when you create a chart in which happenings take place in a 
particular order and date and time. An item that has both date and time and 
order is known as a controlling item. Controlling items are useful in sequence 
of event charts when you know both the date and the sequence in which the 
happenings occurred.

If the time bar is displayed, the item is placed at the correct position on the 
chart relative to its date and time. If you move a controlling item on the chart, 
the time bar display will change so that it is still placed at the correct date and 
time on the chart. You cannot move a controlling item out of sequence as this 
will affect both the date and time and the order in the chart.

If an item is controlling, a marker symbol will appear in the time bar indicating 
the date and time of the event. An example of a chart containing controlling 
items is shown below:

Order and time can apply to all chart items.

Order applies to:

• entities

• links between theme lines

Note: The only items that order and time do not apply to are links that connect entities 
other than theme lines.

Kevin DUPLEASE

05 Jan 2006 19:45

DUPLEASE flies
to London
from New

York.

Return flight

03 Jan 2006 09:30

DUPLEASE (a known
drugs importer)

meets with CORNEY
(a known dealer).

Meeting with CORNEY

01 Jan 2006 03:30

DUPLEASE
flew from

London to New
York.

Flight to New York

1--5th January 2006 Thursday 5th January 20
01:00 02:00 03:00 12:00 12:002nd 12:003rd 12:004th 20:00 22:0021:0012:0000:00:00
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You can mix all of the four behaviors described above in your charts. The example 
below contains ordered, unordered and controlling items in the same chart:

DUPLEASE

CORNEY

Attendee

Attendee

Address

Address

15 Jan 2006 17:30
Telephone Call

15 Jan 2006
20:30

Drinks

Traveled home
by unknown

means

15 Jan 2006
19:00

Left work

Arcacia Investments

Sunday 15th January 2006 Sunday 15th January 2006 Sunday 15th January 2006 Sunday 15th January 2006
13:00 14:00 16:00 17:0015:00 19:15 19:4519:3019:00 20:2020:00 22:21:0018:0012:00
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On 26 November 2006, after KENT went to the travel agents he was seen going 
into various shops in the town. Shortly after this, at 11:30 all three suspects were 
seen meeting in a coffee shop. Add this information to your chart. To do this:

1. Click the drop-down arrow on the Insert Event Frame toolbar button and select 
Standard ➧ Event to select the Event type from the Standard palette.

Note: Refer to page 102, if you cannot see the Event type in the Standard 
palette.

2. Place this event frame so that it is positioned after the Left home event frame 
below the KENT theme line, and add the following information to it:

Note: You will have to set the display properties on the event frame so that you 
can see the description of the date and time. How to do this is described 
in How do I add a description of the time? on page 273.

3. From the Standard palette, add a link of type General, between the above 
event frame and the KENT theme line.

How do I order items on a chart?

Identity Shopping

Date & Time 26 Nov 2006

Description of Date & Time 26 Nov 2006 
After going to the travel agents.

Description KENT went into various shops in town.

Grades A 1 5

Source Type Officer

Source Reference DS 467/10
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4. At 11:30 on 26 November 2006, the three suspects met in a coffee shop in 
London.

Add an event frame of type Meeting, from the Standard palette. Place it so that 
it is positioned after the Shopping event frame, between the three theme lines 
and add the following information to it:

5. Using Attendee link types, from the Individuals palette, link the event frame 
Meeting in coffee shop to all of the theme lines.

6. Two days later on 28 November 2006, at about 11 o’clock, an officer observed 
SHARP and KENT meeting in a bar in London. 

Add another event frame of type Meeting, place it to the right of the Meeting in 
coffee shop event frame, between the KENT and SHARP theme lines and add 
the following information to it:

7. Using an Attendee link type, link this event frame to both the SHARP and 
KENT theme lines.

Identity Meeting in coffee shop

Date & Time 26 Nov 2006 11:30

Description All three suspects met in a London coffee 
shop. SHARP and STEELE arrived in 
STEELE’s car, KENT arrived on foot. At 
one point they were seen studying a map.

Grades A 1 5

Source Type Officer

Source Reference DS 467/11

Identity Meeting in bar

Date & Time 28 Nov 2006

Description of Date & Time 28 Nov 2006
About 11 o’clock.

Description A meeting took place involving SHARP and 
KENT in a bar in London.

Grades A 1 5

Source Type Officer

Source Reference DS 889/01
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Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

Now that you have added this extra information to your chart you will explore how 
the chart behaves as you move event frames.

1. Drag the event frame Meeting in bar to the right on the chart.

As you drag the event frame to the right all of the theme lines extend. As you 
drag the event frame look at the time bar; this event frame has an order on the 
chart but no date and time, so the time bar remains unchanged.

2. Now drag the Meeting in bar event frame to the left on the chart.

As you attempt to move the event frame to the left of the Meeting in coffee shop 
event frame a warning sign is displayed and you will be unable to move the 
event frame any further to the left. This is because the event frame is ordered. 
You cannot move it before the Meeting in coffee shop event frame as this would 
change the order in the chart.

3. Click the pin on the Meeting in bar event frame. It switches from being a filled 
circle to an empty circle. This indicates that the event frame is no longer pinned 
to the chart and therefore has no order and is free. 

STEELE
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SHARP

Attendee

Attendee

Attendee

General

General

General

General

General

General

General

Attendee

Attendee

Attendee

Attendee

Attendee

Traveled back
by unknown

means

Traveled back
by unknown

means

Traveled back
by unknown

means

A 1 5

20 Nov 2006 22:48

CS 634/01Officer

STEELE, SHARP and KENT were seen
together in a hotel in the US. At one

point they were all looking at a
navigational map on which STEELE

made some markings.

Seen in a hotel in the US

A 1 5

28 Nov 2006
About 11 o'clock.

DS 889/01Officer

A meeting took place
involving SHARP and KENT in

a bar in London.

Meeting in bar

A 1 5

26 Nov 2006
In the morning.

UC 789/01Officer

STEELE left his home
address and drove to

collect SHARP.

Left UK home

A 1 5

26 Nov 2006
After going to the travel agents.

DS 467/10Officer

KENT went into various
shops in town.

Shopping

A 1 5

26 Nov 2006 09:30

UC 889/01Officer

KENT left home and walked
to a local travel agent.

Left home

A 1 5

26 Nov 2006 11:30

DS 467/11Officer

All three suspects met in a London
coffee shop. SHARP and STEELE

arrived in STEELE's car, KENT arrived
on foot. At one point they were seen

studying a map.

Meeting in coffee shop

Monday 20th November 2006 Sunday 26th November 2006 Sunday 26th November 2006 Sunday 26th November 2006 Sunday 26th November 2006 Sunday 26th November 2006 Sunday 26th November 2006 Sunday 2
19:00 20:00 22:0021:00 12:0000:00 12:0022nd 12:0023rd 12:0024th 12:00 09:40 09:50 10:10 10:20 10:40 10:5010:3010:00 11:10 11:2011:00 13:00 14:00 16:00 17:0015:00 19:00 20:0018:0012:0026th25th

How do I move an event frame that is pinned to a chart?
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4. Drag the Meeting in bar event frame and place it before the Meeting in coffee 
shop event frame. Notice that the time bar is unchanged because the Meeting 
in bar event frame is free.

5. Click the pin on the Meeting in bar event frame.

The Meeting in bar event frame remains where you placed it, this is because 
you have now specified a new order in the chart.

6. Turn off the pin on the Meeting in bar event frame and move it so that it is 
positioned to the right of the Meeting in coffee shop event frame again. Turn on 
the pin so that the event frame is ordered again.

You will now look at what happens when you move a controlling item on the chart.

1. Drag the Meeting in coffee shop event frame to the right. Notice that the event 
frames to the right of this event frame also move. This is because the Meeting 
in coffee shop has order, anything that happens after this event will also move.

2. As you drag the Meeting in coffee shop to the right look at the time bar, the 
number of interval markers on the time bar chart increases so that the event 
frame is still placed at the correct time on the chart.

3. Move the Meeting in coffee shop to the left and look at the time bar again, this 
time the number of interval markers decreases so that the event frame is still 
placed on at the correct time on the chart.

4. Click the pin on the Meeting in coffee shop event frame. This will turn off the 
pin. The pin is turned off and the event frame is unordered.

5. Move the Meeting in coffee shop event frame to the left, so that it is positioned 
to the right of the Seen in a hotel in the US event frame.

Note: Notice that the time bar does not change. This is because the item is 
unordered.

6. Turn on the pin on the Meeting in coffee shop event frame again. 

The event frame is automatically relocated to its correct position on the chart, 
dictated by its date and time.

How do I move a controlling item?
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Timed Links 8.5

In previous examples you have added links between items on the chart. You can 
also add timed links to the chart. This is particularly useful if you are analyzing, for 
example, telephone information and need to know the time that a call took place.

You can add a date and time to all entity types.

Shortly after the meeting in the coffee shop several telephone calls took place 
between the three suspects. At 10:05 STEELE called SHARP, SHARP then called 
KENT at 10:13. At 12:10, shortly after the meeting in the bar SHARP called 
STEELE. Add this information to the chart as three timed links. To do this:

1. Drag the Meeting in bar event frame to the right so that you can add the three 
telephone calls to the chart.

2. Add a link of type Telephone Call, from the Telecoms palette, between the 
STEELE and SHARP theme lines.

How do I add a timed link?
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The telephone call between STEELE and SHARP took place at 10:05. Edit the 
link so that the date and time are displayed on the chart with an arrow to 
indicate that the call was from STEELE to SHARP. To do this:

3. Right-click on the Telephone Call link between STEELE and SHARP, and from 
the shortcut menu, select Edit Item Properties to display the Edit Link dialog 
and select Data\Date & Time.

4. Edit the date and time to be 28 Nov 2006 10:05.

5. You want the links to be controlling. Select Controlling (Ordered with Date & 
Time) in the Order and Control of Date & Time area.

Do not close the Edit Link dialog.
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6. Select Style\Type to display the Type page:

7. In the Arrows area choose the line with an arrow pointing to the right.

8. Select Display to display the Display page.

9. In the Display area turn on the Date & Time check box.

10. Click OK to close the Edit Link dialog.

11. The link is now displayed on the chart with a date and time and an arrowhead 
indicating that STEELE called SHARP.

12. Add a further Telephone Call link from the SHARP theme line to the KENT 
theme line, just before the Meeting in bar event frame. Edit its date and time to 
be 28 Nov 2006 10:13. Make this link controlling.

13. Add a third Telephone Call link from the SHARP theme line to the STEELE 
theme line, just after the Meeting in bar event frame. Edit its date to be 28 Nov 
2006 12:10. Make this link controlling.

14. Edit the display properties of all of the links so that the date and time is 
displayed on the chart and add an arrowhead to show the direction of the calls.
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The three telephone calls are now displayed at their appropriate places on the 
chart: 

Click the Save toolbar button to save your chart.
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SHARP

Attendee

Attendee

Attendee

General

General

General

General

General

General

General

Attendee
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Attendee
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A 1 5
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CS 634/01Officer

STEELE, SHARP and KENT were seen
together in a hotel in the US. At one

point they were all looking at a
navigational map on which STEELE

made some markings.

Seen in a hotel in the US

A 1 5

28 Nov 2006
About 11 o'clock.

DS 889/01Officer

A meeting took place
involving SHARP and KENT in

a bar in London.

Meeting in bar

A 1 5

26 Nov 2006
In the morning.

UC 789/01Officer

STEELE left his home
address and drove to

collect SHARP.

Left UK home

A 1 5

26 Nov 2006
After going to the travel agents.

DS 467/10Officer

KENT went into various
shops in town.

Shopping

A 1 5

26 Nov 2006 09:30

UC 889/01Officer

KENT left home and walked
to a local travel agent.

Left home

A 1 5

26 Nov 2006 11:30

DS 467/11Officer

All three suspects met in a London
coffee shop. SHARP and STEELE

arrived in STEELE's car, KENT arrived
on foot. At one point they were seen

studying a map.

Meeting in coffee shop

Monday 20th November 2006 Sunday 26th November 2006 Tuesday 28th November 2006 Tuesday 28th Novem
19:00 20:00 22:0021:00 12:0000:00 12:0022nd 12:0023rd 12:0024th 12:00 09:40 09:50 10:10 10:20 10:40 10:5010:3010:00 11:10 11:2011:00 12:0026th 12:0027th 10:05 10:10 10:20 11:00 13:00 14:00 16:0015:0012:0000:0025th
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In the same way that you can display the pin on event frames you can also display 
the pin on timed links. To do this: right-click on the Telephone Call link between 
SHARP and KENT, and from the shortcut menu, select Display ➧ Pin.

The Telephone Call link between SHARP and KENT is now displayed on the chart 
with a pin in addition to its label:

Click the Save toolbar button to save your chart.

You have already explored how event frames move around the chart, you are now 
going to look at the way that timed links move around the chart.

1. Drag the link between SHARP and KENT to the left and right on the chart.

In the same way that you cannot drag ordered event frames to be in any other 
order than the defined order you will be unable to move this Telephone Call link 
out of sequence on the chart.

As you move the link, notice that the time bar display changes to display the 
correct date and time.

How do I display the pin on timed links?

28 Nov 2006 10:13
Telephone Call

How can I rearrange timed links?
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Adding Unordered Chart Items 8.6

In this example you have added ordered and controlling items to your chart, 
however you can also add items to your chart that have no order.

These items do not affect the time bar when you move them around on the chart.

Before KENT made his way to the meeting in the coffee shop he paid for a previous 
flight booking. Two witness statements obtained from Tanya OLCOTT and Steve 
DESOUZA both observed KENT shopping in the high street just before he met in 
the coffee shop with STEELE and SHARP.

Add these witness statements and the information about KENT paying for his 
previous flight to the chart. To do this:

1. Click on the drop-down arrow on the Insert Icon toolbar button and select 
Documents ➧ Document to select the Document type from the Documents 
palette.

2. Add two Document icons to the chart. Place them so that they are below the 
Shopping event frame.

3. Edit the name of these icons to be Statement of Tanya OLCOTT and 
Statement of Steve DESOUZA.

4. Add an event frame of type Credit, from the Financial palette and place it to the 
right of the Shopping event frame.

5. Add the following information to this event frame:

6. Turn off the pin on the above event frame so that it is not controlling.

7. Link each of the two document icons and the Payment event frame to the 
Shopping event frame with General link types.

How do I add an unordered chart item?

Identity Payment

Date & Time 26 Nov 2006 10:14

Description Payment made by KENT for a previous flight 
booking.

Grades A 1 5

Source Type Record

Source Reference CC3501/02
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8. Click the Save toolbar button to save your chart.

9. Move the Shopping event frame to the right. 

Notice that the Tanya OLCOTT icon remains where it is and the Payment event 
frame and Steve DESOUZA move with the Shopping event frame. The time bar 
changes so that the Shopping event frame is still shown at the correct time in 
the time bar.

10. Your chart should now look similar to that below (Example 8 
finished.anb):

Close your chart.
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Attendee

General

General

General

General

General

General

General

Attendee

Attendee

Attendee
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20 Nov 2006 22:48

CS 634/01Officer

STEELE, SHARP and KENT were seen
together in a hotel in the US. At one

point they were all looking at a
navigational map on which STEELE

made some markings.

Seen in a hotel in the US

A 1 5

28 Nov 2006
About 11 o'clock.

DS 889/01Officer

A meeting took place
involving SHARP and KENT in

a bar in London.

Meeting in bar

A 1 5

26 Nov 2006
In the morning.

UC 789/01Officer

STEELE left his home
address and drove to

collect SHARP.

Left UK home

A 1 5

26 Nov 2006
After going to the travel agents.

DS 467/10Officer

KENT went into various
shops in town.

Shopping

A 1 5

26 Nov 2006 09:30

UC 889/01Officer

KENT left home and walked
to a local travel agent.

Left home

A 1 5

26 Nov 2006 10:14

CC3501/02Record

Payment made by KENT for
a previous flight booking.

Payment

Statement of Tanya OLCOTT Statement of Steve DESOUZA

A 1 5

26 Nov 2006 11:30

DS 467/11Officer

All three suspects met in a London
coffee shop. SHARP and STEELE

arrived in STEELE's car, KENT arrived
on foot. At one point they were seen

studying a map.

Meeting in coffee shop

Monday 20th November 2006 Sunday 26th November 2006 Tuesday 28th November 2006 Tuesday 28th Novem
19:00 20:00 22:0021:00 12:0000:00 12:0022nd 12:0023rd 12:0024th 12:00 09:40 09:50 10:10 10:20 10:40 10:5010:3010:00 11:10 11:2011:00 12:0026th 12:0027th 10:05 10:10 10:20 11:00 13:00 14:00 16:0015:0012:0000:0025th
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Summary 8.7

In this example you will have learned how to:

• use the time bar

• duplicate items

• order items using pins

• add timed links
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9
Changing the Emphasis of a Chart

This chapter explains how you can change the emphasis of a chart so that the way 
in which the information is represented is appropriate to the focus of your 
investigation.
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Introduction 9.1

The features covered in detail in this example are:

• changing the emphasis of items on an event based chart

• changing the emphasis of items on an association chart

• merging multiple links on a chart

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished charts (Example 9 finished 1.anb, Example 9 
finished 2a.anb, Example 9 finished 2b.anb) at any time while you 
are working through this example. To access the folder in which these charts are 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.

Scenario

On 20 November 2006, three suspects, KENT, SHARP and STEELE were seen 
meeting in a US hotel. 

Subsequently, on 26 November 2006 at 09:30, the man named KENT was 
observed leaving his home in the UK. He walked to a local travel agent to book a 
flight and then spent some time visiting various other shops. At 10:30 he was seen 
meeting with two other men SHARP and STEELE in a local coffee shop. SHARP 
and STEELE were observed arriving together at this meeting in STEELE’s car. 

Two days later, 28 November 2006 at approximately 11:00, SHARP and KENT 
were seen meeting for a second time in the same coffee shop, before which two 
telephone calls took place within a few minutes of each other. A further telephone 
call took place shortly after this meeting.

The happenings and the order in which they took place have already been charted 
for you. The focus of the investigation has changed to study the association 
between the people involved and the meetings that were held, rather than the time 
that these happenings took place. 

Telephone data involving telephones for which KENT, SHARP and STEELE are 
subscribers has also been charted for you as an association chart. You now want 
to look at when the telephone calls took place. 
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Changing the Emphasis of a Timeline Chart 9.2

When you create a chart you generally chart the information using a 
representation that is relevant to the focus of the investigation, for example a 
timeline chart for event-based charts containing theme lines and event frames, and 
an association chart for those containing icons and the links between them. There 
may be times, however, when you need to look at the information on the chart from 
a different perspective, and change the emphasis on the information that you are 
interested in so that it is represented in a different way.

In Analyst’s Notebook you can use the change representation tool to quickly 
change the way that the information is represented on a chart so that it is more 
appropriate to the type of investigation you are performing. For example, you may 
have charted items on your chart as a timeline chart containing event frames and 
theme lines, to show when happenings occurred; you can change the focus of your 
investigation to look at the associations between the chart items rather than the 
time they took place.

You can change the representation of chart items to the following:

• Icon

• Box

• Circle

• Text Block

• Theme Line

• Event Frame

You can also choose the order in which the items on the chart are displayed after 
you have changed their representation. This is particularly useful if you are 
changing between a timeline chart and an association chart.
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Information that describes the order in which the meetings took place between the 
three suspects, KENT, SHARP and STEELE has already been charted. You now 
need to perform some analysis on this chart to investigate the relationships 
between the three suspects, rather than the time at which the meetings took place. 
Change the representation of any theme lines on the chart to be displayed as 
icons. To do this:

1. Open the chart Example 9 initial 1.anb. To access the folder in which 
this chart is stored, double-click on the User Guide Example Material shortcut 
in the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-
click on the Creating Charts folder.

2. Save this chart; from the File menu, select Save As. Click OK on the Cover 
Sheet dialog to display the Save As dialog. Select the folder you created to 
save your charts in. Type Example 9 change representation 1.anb in 
the File Name box and click Save.

How do I change the representation of an item?
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Monday 20th November 2006 Sunday 26th November 2006 Tuesday 28th November 2006 Tuesday 28th Novem
19:00 20:00 22:0021:00 12:0000:00 12:0022nd 12:0023rd 12:0024th 12:00 09:40 09:50 10:10 10:20 10:40 10:5010:3010:00 11:10 11:2011:00 12:0026th 12:0027th 10:05 10:10 10:20 11:00 13:00 14:00 16:0015:0012:0000:0025th
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3. You are only interested in event frames that contain information about the 
meetings that took place between the three suspects, so delete the following 
event frames and icons from the chart:
— Traveled back by unknown means

Notice that each of the theme lines have this event frame, so select each of 
them and delete them.

— Left home
— Left UK home
— Shopping
— Payment
— Statement of Tanya OLCOTT
— Statement of Steve DESOUZA

Your chart should now look similar to that below:

4. Select all of the theme lines by selecting the first theme line (STEELE) and 
while holding down the Ctrl key select the two remaining theme lines (SHARP 
and KENT). Release the Ctrl key.
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navigational map on which STEELE
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A 1 5

28 Nov 2006
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DS 889/01Officer

A meeting took place
involving SHARP and KENT in
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A 1 5

26 Nov 2006 11:30

DS 467/11Officer

All three suspects met in a London
coffee shop. SHARP and STEELE

arrived in STEELE's car, KENT arrived
on foot. At one point they were seen

studying a map.

Meeting in coffee shop

Monday 20th November 2006 Tuesday 21st November 2006 22nd November 2006 Thursday 23rd November 2006 Friday 24th November 2006 Saturday 25th November 2006 26th November 2006 Tuesday 28th November 2006 Tuesday 28th Novem
19:00 20:00 22:0021:00 06:00 18:0012:0000:00 06:00 18:0012:0000:00 06:00 18:0012:0000:00 06:00 18:0012:0000:00 06:00 18:0012:00 06:00 12:0000:00 12:0000:00 10:05 10:10 10:20 11:00 13:00 14:00 16:0015:0012:0000:0000:00
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5. From the Tools menu, select Change Representation to display the Change 
Representation dialog.

6. In the Change Selected Entities To area, select Icon and in the Order area 
select Remove Order from All Chart Items. Click OK to close the Change 
Representation dialog.

All of the theme lines have had their representation changed to icon and are 
displayed on the left of the chart as Male icons:

Note: When you change the representation of a chart item it retains its 
position on the chart.

7. Change the representation of all of the event frames on the chart to be icons 
using the same method.

Note: Do not forget to remove the order from the chart items.
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01:00 02:00 04:00 05:0003:00 07:00 08:00 10:00 11:0009:0006:00 13:00 14:00 16:00 17:0015:00 19:00 20:00 22:00 23:0021:0018:0012:00 01:00 02:00 04:0003:0000:000:00
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The event frames are now displayed on the chart as Meeting icons:

8. Click the Save toolbar button to save your chart.

28 Nov 2006 10:13
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28 Nov 2006 12:10
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28 Nov 2006 10:05
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Seen in a hotel in the US
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When you changed the representation of the event frames to be Meeting icons 
they inherited their position on the chart and any other properties that were 
specified in the original chart. This has left the chart with many crossed links, and 
the associations between chart items are unclear. 

The Minimize Crossed Links layout rearranges your chart to reduce the number of 
crossed links between entities as far as possible. This layout is useful when you 
have many linked entities, enabling you to arrange the entities into the clearest 
layout possible.

1. You can now apply the layout. Click the Minimize Crossed Links Layout 
toolbar button. While the rearrangement is taking place, the Status Bar displays 
a progress indicator.

Your chart should now look similar to that shown below:

How do I automatically remove crossed links from my chart?
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 Chapter 9: Changing the Emphasis of a Chart

i2 Analyst’s Notebook 8 User Guide: Creating Charts 307

2. This layout is not particularly clear. You can adjust the layout setup for Minimize 
Crossed Links layout settings, for example, to change the orientation of the 
chart. To do this, click the Layout Setup toolbar button.

3. The Setup Layouts dialog is displayed. Select Minimize Crossed Links to 
display the Minimize Crossed Links page:

4. In the Orientation area, click the Rotate button until it matches that below:

5. Click the Align centered button:

6. Click OK to close the dialog.
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7. Click the Minimize Crossed Links Layout toolbar button to reapply the layout.

Your chart should now look similar to the one shown below:

Attendee

Attendee

Attendee

Attendee

Attendee

Attendee

Attendee

Attendee

28 Nov 2006 10:13
Telephone Call

28 Nov 2006 12:10
Telephone Call

28 Nov 2006 10:05
Telephone Call

KENT

SHARP

Meeting in bar

Seen in a hotel in the US

STEELEMeeting in coffee shop
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8. It is now easy to see the relationships between STEELE, SHARP and KENT. 
Move the items on the chart so that it looks similar to that below (Example 9 
finished 1.anb).

You will also need to add corners to some of the links and remove corners from 
others. Open the online help to find out how to do this. How to access the 
online help is described in Using the online help on page 15.

Click the Save toolbar button, and close the chart.

Attendee

Attendee

Attendee Attendee

Attendee

28 Nov 2006 10:05
Telephone Call

28 Nov 2006 12:10
Telephone Call

Attendee

Attendee

28 Nov 2006 10:13
Telephone Call

Attendee

KENT

SHARPMeeting in coffee shop

STEELE

Meeting in bar

Seen in a hotel in the US
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Changing the Emphasis of an Association Chart 9.3

You can change the emphasis on any type of chart. You can also merge multiple 
links.

You have received some data about the four telephones that are subscribed to by 
STEELE, SHARP and KENT. Each of the telephones are charted as icons and all 
of the calls that have taken place between the three telephones are displayed as 
Telephone Call links. To make it easier to see when the calls took place between 
the three suspects change the representation of the Telephone icons to be theme 
lines. To do this:

1. Open the chart Example 9 initial 2.anb. To access the folder in which 
this chart is stored, double-click on the User Guide Example Material shortcut 
in the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-
click on the Creating Charts folder.

2. Save this chart; from the File menu, click Save As. Click OK on the Cover 
Sheet dialog to display the Save As dialog. Select the folder you created to 
save your charts in. Type Example 9 change representation 2.anb in 
the File Name box and click Save.

3. Select all of the Telephone entities on the chart.

How do I change the representation of an entity type?

28 Nov 2006 08:31 25 Nov 2006 21:30

26 Nov 2006 21:48

28 Nov 2006 22:01

28 Nov 2006 18:30

26 Nov 2006 20:30

28 Nov 2006 09:10

349 589 0233

093 578 2389

01245 578 490

01894 676 453
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4. From the Tools menu, select Change Representation to display the Change 
Representation dialog:

5. In the Change Selected Entities area, select Theme Line and turn on the 
Align Icons check box.

6. In the Order area, select Add Order to All Chart Items with Date & Time.

7. Click OK to close the Change Representation dialog.

The Telephone entities are displayed on the chart as theme lines.

When you changed the representation of the Telephone entities you selected four 
entities, however, it looks like only three of those Telephone entities have changed 
their representation to be a theme line.

There are two theme lines at the top of the chart, one for telephone number  
349 589 0233 and one for 01245 578490. Click on the chart background to 
deselect any selected items and drag the theme line for telephone number 
349 589 0233 up, so that you can see the theme line for telephone number 
01245 578490.

How do I move a theme line and a theme line icon?
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Drag the theme line icons to the left and move the links between the theme lines 
so that your chart looks similar to that below (Example 9 finished 2a.anb):

Click the Save toolbar button, and close your chart.

The telephone data has been charted so that each of the telephone calls that took 
place between STEELE, SHARP and KENT is charted individually. You are not 
interested in how many or when the calls took place, you just want to demonstrate 
that there is a relationship between the telephones that are subscribed to by the 
three suspects.

To do this:

1. Open the chart Example 9 initial 2.anb again.

2. From the File menu, select Save As to save this chart. Click OK on the Cover 
Sheet dialog to display the Save As dialog. Select the folder you created to 
save your charts in. Type Example 9 change representation 3.anb in 
the File Name box and click Save.

3. Select all of the items on the chart (Telephone entities and links).

Note: Right-click on the chart background, and from the shortcut menu, select 
Select All.

4. From the Tools menu, select Merge Multiple Links.

01245 578 490

349 589 0233

093 578 2389

01894 676 453

28 Nov 2006 18:30

26 Nov 2006 21:48

28 Nov 2006 08:31

28 Nov 2006 09:10

26 Nov 2006 20:30 28 Nov 2006 22:01

25 Nov 2006 21:30

How do I merge multiple links?
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All of the Telephone Call links on the chart are displayed as single links. 

Your chart should look similar to that below (Example 9 finished 2b.anb):

Note: If you were to change the representation of this chart to a timeline chart the links 
will still be merged; Analyst’s Notebook will not unmerge them as you change the 
representation.

Click the Save toolbar button, and close the chart.

28 Nov 2006 09:10 25 Nov 2006 21:30

28 Nov 2006 22:01

28 Nov 2006 18:30

349 589 0233

093 578 2389

01245 578 490

01894 676 453



Summary

314 i2 Analyst’s Notebook 8 User Guide: Creating Charts

Summary 9.4

In this example you will have learned:

• how to change the emphasis of items on an event based chart

• how to change the emphasis of items on an association chart

• how to merge multiple links on a chart
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10
Working with Time Zones

This chapter describes time zones and how you can use different time zones when 
creating charts.
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Introduction 10.1

The features covered in detail in this example are:

• adding items with different time zones and displaying time zone information

• finding the time zone of a chart

• merging charts in different time zones

• sharing charts with users in different time zones

If you need more information or help with using a specific feature, refer to the 
online help. How to access the online help is described in Using the online help on 
page 15.

Finished chart

You can see the finished chart (Example 10 finished.anb) at any time while 
you are working through this example. To access the folder in which this chart is 
stored, double-click on the User Guide Example Material shortcut in the My 
Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-click on the 
Creating Charts folder.

Scenario

You have already charted the results of an undercover drugs operation regarding 
the whereabouts of the cruiser MOONSHADOW and several suspects Sam 
STEELE, Paul SHARP and Danny KENT. A report has been received that 
MOONSHADOW was seen at the mouth of Marigot Bay, early in the evening of 26 
February 2006, at 18:25.
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Adding Chart Items with Different Time Zones 10.2

If you are creating charts that contain happenings that took place in different time 
zones, you can specify in which time zone the happenings took place. Analyst’s 
Notebook contains many predefined time zones.

The chart's time zone will usually be your local time, that is, the time where you are 
working. The local time zone is the time zone specified in your Windows settings. 
In Analyst’s Notebook, you can specify that a chart uses a different time zone to 
that of your computer. Daylight saving rules are handled automatically by Analyst’s 
Notebook.

The following items all have time zones:

• charts

• chart items

• cards

Chart items with a date and time always have a time zone. When you set the date 
and time on cards, the time zone is the same as the chart item’s time zone.

Each item on a chart can have a date and time in a time zone different to that of the 
chart.

The chart's time zone is used:

• in the time bar

• as the time zone when you set the date and time of an item

• for dates and times specified when using Analyst’s Notebook analysis tools

For further information on how to use the analysis tools that are part of 
Analyst’s Notebook, refer to Analyst’s Notebook 8 User Guide: Customizing 
and Analyzing.

Note: Date and time attribute values do not have a time zone.
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An item's date and time is displayed on the chart with its own time zone. However, 
if this item is in a different time zone to that of the chart, it will be placed on the 
chart according to the chart's time zone. 

For example, in the chart below, an event frame with a time zone of Pacific 
Standard Time (GMT - 8 hours) is placed on a chart with a chart time zone of 
Greenwich Mean Time (GMT). The time bar marker shows the time of the event 
frame in the chart’s time zone and the event frame is displayed with its correct time 
zone (PST).

Therefore, an event frame with a time of 10:00 PST, is placed on a chart with a time 
zone of GMT, at 18:00:
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A chart already exists that contains information surrounding the happenings 
relating to MOONSHADOW and the three suspects Sam STEELE, Paul SHARP 
and Danny KENT. Find the time zone of this chart. To do this:

1. Open the chart Example 10 initial 1.anb. To access the folder in which 
this chart is stored, double-click on the User Guide Example Material shortcut 
in the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-
click on the Creating Charts folder.

2. Save this chart; from the File menu, select Save As. Click OK on the Cover 
Sheet dialog to display the Save As dialog. Select the folder you created to 
save your charts in. Type Example 10 time zones.anb in the File Name 
box and click Save.

How do I find the time zone of a chart?

Paul SHARP

Danny KENT

Sam STEELE

MOONSHADOW

Sighting

Sighting

Sighting

Traveled

A 1 5

26 Feb 2006 08:30

FM AB165Record

KENT boarded a flight to St
Lucia. He traveled on a cash

paid, open return ticket.

Departure

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow
A 1 5

23 Feb 2006 12:30

FM AB164Record

SHARP returned from St
Lucia to Heathrow.

Return

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

A 1 5

27 Feb 2006 17:30

DS 487/01Officer

Both met in a hotel bar.
Agenda unknown.

Meeting in hotel

A 1 5

25 Feb 2006 18:20

WS 472Witness

All three were seen walking in the harbor.
They seemed very nervous, constantly

checking around them as if to ensure that
they were not being followed.

Seen in harbor

Danny KENT : Sighting

Paul SHARP : Sighting

Sam STEELE : Sighting

Themes
Operation C rest

A chart showing segments and a legend.
V 0.1

7 Jun 2006
Analyst Fitzwilliams

onday 20th February 2006 Friday 24th February 2006 Saturday 25th February 2006 Saturday 25th February 2006 Saturday 25th February 2006 Sunday 26th February 2006 Monday 27th February 2006
3:00 14:00 16:00 17:0015:00 18:00 12:0021st 12:0022nd 23rd 15:00 21:0018:0000:00 03:00 09:0006:00 14:00 16:00 17:0015:00 19:00 21:0018:0012:00 03:00 06:00 18:0012:0000:00 06:00 16:00 19:00 20:00 21:18:0012:0000:0000:00
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3. Click the Edit Chart Properties toolbar button and select Defaults\Date & 
Time to display the Date & Time page:

In the Time Zone area, notice that the time zone is (GMT+00:00) Greenwich 
Mean Time: Edinburgh, London. This is the time zone of this chart.

4. Click Cancel to close the Chart Properties dialog.

There have been reports that MOONSHADOW was seen at the mouth of Marigot 
Bay in the early evening, at 18:25. The time zone of this chart is Greenwich Mean 
Time (GMT). However, St Lucia is in a different time zone, GMT -04:00: Caracas, 
La Paz. Add a new event frame to the chart to show this information, using the 
associated time zone. To do this:

1. Add an event frame of type Surveillance, from the Crime palette, and link it 
automatically to the MOONSHADOW theme line using a General link type, 
from the Standard palette. Place it between the Moored in Port and In port 
event frames.

How do I add a chart item with a specific time zone?
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2. Add the following information to this event frame, but do not close the Edit 
Event Frame dialog:

3. Select Data\Date & Time to display the Date & Time page:

4. Set the date and time to be 26 Feb 2006 18:25.

Do not close the Edit Event Frame dialog.

Identity Sighting

Description The vessel was seen at the mouth of Marigot Bay in 
the early evening.

Grades A 1 5
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5. From the Time Zone drop-down list, select (GMT -04:00) Caracas, La Paz.

The time zone displayed above the Time Zone drop-down list shows that this 
time zone is, SA Western Standard Time:

6. In the Order and Control of Date & Time area, select Controlling (Ordered 
with date & time).

7. Select Style\Display to change the date and time format display in the Display 
page:

8. In the Displayed Date & Time area, from the Format drop-down list, select  
dd MMM yyyy HH:mm Z.

Note: The time zone name, together with any daylight saving information, is 
displayed in the Preview area.

9. Click OK to close the Edit Event Frame dialog.
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The event frame is displayed on your chart at 22:25. This is because the time 
difference between the time zone of the chart and the time zone of this event 
frame is 4 hours. Notice that it has the time zone displayed:

Your chart should now look similar to that below:

Click the Save toolbar button to save your chart.

A 1 5

26 Feb 2006 18:25 SA Western

The vessel was seen at the
mouth of Marigot Bay in the

early evening.

Sighting

Paul SHARP

Danny KENT

Sam STEELE

MOONSHADOW

Sighting

Sighting

Sighting

Traveled

General

A 1 5

27 Feb 2006 17:30

DS 487/01Officer

Both met in a hotel bar.
Agenda unknown.

Meeting in hotel

A 1 5

26 Feb 2006 08:30

FM AB165Record

KENT boarded a flight to St
Lucia. He traveled on a cash

paid, open return ticket.

Departure

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow
A 1 5

23 Feb 2006 12:30

FM AB164Record

SHARP returned from St
Lucia to Heathrow.

Return

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

A 1 5

26 Feb 2006 18:25 SA Western

The vessel was seen at the
mouth of Marigot Bay in the

early evening.

Sighting

A 1 5

25 Feb 2006 18:20

WS 472Witness

All three were seen walking in the harbor.
They seemed very nervous, constantly

checking around them as if to ensure that
they were not being followed.

Seen in harbor

Danny KENT : Sighting

Paul SHARP : Sighting

Sam STEELE : Sighting

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

Themes
Operation Crest

A chart showing segments and a legend.
V 0.1

7 Jun 2006
Analyst Fitzwilliams

onday 20th February 2006 Friday 24th February 2006 Saturday 25th February 2006 Saturday 25th February 2006 Saturday 25th February 2006 Sunday 26th February 2006 Monday 27th February 2006 Monday 27th February 2006 Monday 27t
3:00 14:00 16:00 17:0015:00 18:00 12:0021st 12:0022nd 23rd 13:00 15:00 21:0018:0024th 03:00 09:0006:00 14:00 16:00 17:0015:00 19:00 21:0018:0012:00 03:00 06:00 12:0000:00 03:00 09:0006:00 15:00 19:00 20:00 21:18:0012:0000:0000:00
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Merging Charts with Different Time Zones 10.3

Analyst’s Notebook synchronizes controlling chart items that have dates and times 
in different time zones so that they are positioned correctly relative to each other. It 
does this by representing dates and times internally using Universal Standard 
Time (UTC).

When you merge the contents of two charts that are in different time zones, the 
merged items are placed at the correct time relative to the time zone of the chart 
into which the items are merged.

The time zone of an item is only displayed if the time zone is included in the date 
and time format of that item. You can choose not to display the time zone of an 
item if it is the same as the time zone of the chart when you define the formats. For 
more information on defining date and time formats, refer to i2 Analyst’s Notebook 
7 User Guide: Customizing and Analyzing.

For example, chart 1, below, is in Greenwich Mean Time (GMT) and contains 
happenings observed in the UK: 

However, chart 2, below, is in Pacific Standard Time (PST) and contains 
happenings observed in the US:

When the contents of chart 2 are pasted into chart 1, a combined chart is created. 
The items that you copied into chart 1 are displayed with Pacific Standard Time 
(PST) as their time zone. This is because the time zone of these items is different 
to the time zone of the chart.

Kevin DUPLEASE

12 Dec 2006
10:00

Left Heathrow

19 Dec 2006
02:00

Arrived Home

18 Dec 2006 23:00

Landed at
Heathrow

Tuesday 19th December 2006
00 16:00 17:0015:00 13th 14th 16th 17th 23:3021:0018th 00:30 01:3001:00 02:00 04:0003:0000:0015th

Kevin DUPLEASE

18 Dec 2006
02:00

Boarded Flight

16 Dec 2006 09:00

Business Meeting

13 Dec 2006
05:30

Landed

esday 13th December 2006 Mond
10:00 11:00 13:0012:00 14th 16th 12:0017th 10:00 11:00 12:0000:0015th
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For example, the Business Meeting event frame has a date of 16 December 2006 
and a time of 09:00. This event frame has a time zone of Pacific Standard Time 
(GMT -08:00). It is displayed with a time of 09:00 PST but is positioned on the 
chart at 17:00 GMT, in accordance with the time zone of the chart. 

A further chart exists, Example 10 initial 2.anb, containing information 
about telephone calls that took place in St Lucia. This chart has a time zone of 
Pacific Standard Time (PST). Copy the contents of this chart into the example 10 
initial 1 chart. To do this:

1. Open the chart Example 10 initial 2.anb. To access the folder in which 
this chart is stored, double-click on the User Guide Example Material shortcut 
in the My Documents\i 2\i 2 Analyst’s Notebook 8 folder, and double-
click on the Creating Charts folder.

How do I merge two charts with different time zones?

759 837 2349
St Lucia

094 485 4902
St Lucia

956 457 0293
USA

24 Feb 2006 11:55 PST

25 Feb 2006 06:10 PST24 Feb 2006 11:50 PST

25 Feb 2006 06:00 PST

Friday 24th February 2006
10:00 11:40 11:5211:0009:00 18:0012:00 06:10 07:00 0806:0000:00
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2. From the Window menu, select Tile Horizontal to tile the two charts.

3. In each of the windows, click the Fit Chart in Window toolbar button so that 
you can see the entire chart:

4. Make Example 10 initial 2 the active chart and press Ctrl+A to select all of the 
chart items, then press Ctrl+C to copy them.

5. Make Example 10 time zones the active chart and press Ctrl+V to paste the 
contents of the Example 10 initial 2 chart into this chart. 

6. With the items that you have just pasted into the chart still selected, drag the 
telephone theme lines until they are above the MOONSHADOW theme line.

7. Close the Example 10 initial 2 chart, and click the Maximize button to fit the 
Example 10 time zones chart in the application window.

8. Click the Fit Chart in Window toolbar button to fit the Example 10 time zones 
chart in the window.
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The items that you copied from the Example 10 initial 2 chart are displayed on the 
chart with their time zone (PST). A marker has also been placed in the time bar to 
show the time of the items in accordance with the time zone of the chart.

To tidy up your chart, drag the theme line icons for the telephone information that 
you have just added to the beginning of the theme lines. Your chart should now 
look similar to that below (Example 10 finished.anb):

Click the Save toolbar button, and close your chart.

Paul SHARP

Danny KENT

Sam STEELE

MOONSHADOW

759 837 2349
St Lucia

956 457 0293
USA

094 485 4902
St Lucia

Sighting

Sighting

Sighting

Traveled

General

24 Feb 2006 11:55 PST 25 Feb 2006 06:00 PST

25 Feb 2006 06:10 PST24 Feb 2006 11:50 PST

A 1 5

27 Feb 2006 17:30

DS 487/01Officer

Both met in a hotel bar.
Agenda unknown.

Meeting in hotel

A 1 5

26 Feb 2006 08:30

FM AB165Record

KENT boarded a flight to St
Lucia. He traveled on a cash

paid, open return ticket.

Departure

A 1 5

26 Feb 2006 11:30

FM AB163Record

SHARP flew to St Lucia on
the 11:30 flight from

Heathrow.

Heathrow
A 1 5

23 Feb 2006 12:30

FM AB164Record

SHARP returned from St
Lucia to Heathrow.

Return

A 1 5

24 Feb 2006 13:15

WS 250Witness

Sam STEELE was seen on
board MOONSHADOW as it

sailed into the harbor at
Castries.

Observed

A 1 5

20 Feb 2006 18:10

DS 685/01Officer

Sam STEELE and Paul SHARPE were
observed drinking together in
Tricksters Bar in London. They
seemed to be having a heated
discussion about something.

Tricksters Bar

A 1 5

27 Feb 2006 18:30

WS 254Witness

MOONSHADOW was seen
moored in a different location to
its previous sighting in Castries

harbor.

In port

A 1 5

25 Feb 2006 19:00

WS 252Witness

MOONSHADOW was seen
moored in the harbor at

Castries.

Moored in port

A 1 5

26 Feb 2006 18:25 SA Western

The vessel was seen at the
mouth of Marigot Bay in the

early evening.

Sighting

A 1 5

25 Feb 2006 18:20

WS 472Witness

All three were seen walking in the harbor.
They seemed very nervous, constantly

checking around them as if to ensure that
they were not being followed.

Seen in harbor

Danny KENT : Sighting

Paul SHARP : Sighting

Sam STEELE : Sighting

A 1 5

25 Feb 2006 13:30

DS 682/01Officer

Sam STEELE was seen in 'Liquide X',
a bar in the harbor. He appeared to
be on his own and was looking out

at the boats moored on the
pontoons.

Seen in bar

Themes
Operation Crest

A chart showing segments and a legend.
V 0.1

7 Jun 2006
Analyst Fitzwilliams

onday 20th February 2006 Friday 24th February 2006 Saturday 25th February 2006 Sunday 26th February 2006 Monday 27th February 2006 Monday 27th February 2006 Monday 27t
3:00 14:00 16:00 17:0015:00 18:00 12:0021st 12:0022nd 23rd 13:00 14:00 16:00 17:0015:00 19:5019:00 20:0018:0024th 06:00 14:1014:00 16:00 17:0015:00 21:0018:0012:00 03:00 06:00 12:0000:00 03:00 09:0006:00 15:00 19:00 20:00 21:18:0012:0000:0000:00
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Sharing Charts with Users in Different Time Zones 10.4

When you create a chart, you can specify a particular time zone for that chart. If 
you share this chart with other users, in a different time zone, it will always be 
opened in the time zone that you specified. 

If you do not specify a time zone Analyst’s Notebook will use the local time zone 
when the chart is opened. The local time zone is the time zone in your Windows 
settings. When another user, in a different time zone, opens this chart it will use 
their local time zone to display the information.

Chart Time Zone
(EDT)

User’s Time Zone
(EDT)

User’s Time Zone
(PST)

Chart Time Zone
(EDT)

Local Time Zone
(BST)

User’s Time Zone
(BST)

User’s Time Zone
(SA Western)

Local Time Zone
(SA Western)
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Summary 10.5

In this example you will have learned how to:

• add items with different time zones and display time zone information

• find the time zone of a chart

• merge charts in different time zones

• share charts with users in different time zones
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A
Features used in the Examples

This appendix contains tables showing where the Analyst’s Notebook features are 
demonstrated in the examples.

It is possible to use these tables as a way of finding the examples which best 
illustrate specific features.

Contents

Analyst’s Notebook Features 332
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Analyst’s Notebook Features 10.6
The ■ symbol indicates in which example the feature is first used and explained. 
The ● symbol indicates the feature is also used in the example.

User Guide - Creating Charts
User Guide - Customizing and 
Analyzing

Feature 1 2 3 4 5 6 7 8 9 10 1 2 3 4 5 6 7 8 9 10 11 12

Attributes

adding attribute entries to 
palettes

■

analysis attributes ■

attribute instances ■

combining attribute classes ■

defining attribute classes ■

merge and paste rules ■

showing attributes ■

the Attribute Bar ■

Background items ■

Cards

adding information to cards ■

copying a card to another 
Windows application

■

copying cards ■

deleting cards ■

Change representation

of a timeline chart ■

of an association chart ■

Charts

combining charts ■ ●

creating a chart ■

creating a chart from a 
template

■
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Feature 1 2 3 4 5 6 7 8 9 10 1 2 3 4 5 6 7 8 9 10 11 12

merging charts ■ ●

opening a chart ■

printing a chart ■ ● ●

saving a chart ■

Chart Properties

default styles ■ ●

Cover Sheet ■ ●

Date and Time formats

choosing a date and time 
format

■

defining a date and time 
format

■

Entity types ■

default styles ■

defining entity types ■

Entity Representations

box ■

event frame ■

icon ■

labeling and uniquely 
identifying chart items

■

OLE Object ■

text block ■

theme line ■

Event frames

adding event frames ■

background text color ■

display properties ■

User Guide - Creating Charts
User Guide - Customizing and 
Analyzing
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Feature 1 2 3 4 5 6 7 8 9 10 1 2 3 4 5 6 7 8 9 10 11 12

duplicating event frames

fill color ■

Find Text ■ ●

Find Path

between two chart items ■

in chronological sequence ■

Find Linked ■ ●

Find Matching Entities ■

Grades

about grades ■

defining grades ■

Grid

displaying ■

grid settings ■

Icon

enlarging icons ■

Label

merge and paste rules ■

Layouts

grouped by time layout ■

grouped layout ■

minimize crossed links ■

ordered layout ■

peacock layout ■

print layout ■

proportional layout ■

theme line layout ■

User Guide - Creating Charts
User Guide - Customizing and 
Analyzing
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Feature 1 2 3 4 5 6 7 8 9 10 1 2 3 4 5 6 7 8 9 10 11 12

Legend

editing the legend ■

populating the legend ■

Line strengths ■ ●

Links

adding links between items ■ ●

automatically linking theme 
lines and event frames

■ ●

connection styles ■ ●

default styles ■

defining link types ■

duplicating links ■

timed links ■

List Items ■

Navigating charts ■ ●

OLE objects

embedded OLE objects ■

linked OLE objects ■

opening an OLE object ■

Ordering chart items ■

Palettes ■

adding chart items from 
palettes

■

Print

preparing a chart for 
printing

■ ●

printing the time bar and 
theme line names

■

Report ■

User Guide - Creating Charts
User Guide - Customizing and 
Analyzing
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Note: A few Analyst’s Notebook features are not used in the examples. Please refer to 
the online help for more information about these items.

Feature 1 2 3 4 5 6 7 8 9 10 1 2 3 4 5 6 7 8 9 10 11 12

Show and Hide ■ ●

Selection Sets

adding to selection sets ■

defining ■

intersecting and deleting ■

restoring ■

Snapshots ■

Spelling checker ■

Summary information ■

Templates

creating a new template ■

creating a template from an 
existing chart

■

customizing a template ■

merging templates ■

sharing templates ■

Theme lines

theme line segments ■

theme line styles ■

theme line wiring height ■

Time bar ■ ● ● ●

Time zones ■

Visual Search

for a single entity ■

for linked entities ■

for links with date and time ■

User Guide - Creating Charts
User Guide - Customizing and 
Analyzing
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Glossary

Abstract Semantic Type

A notional semantic type associated with the real world meaning of the data. 
For example, an Abstract Number semantic type refers to a property that is 
reasoned about as a number.

See also: i2 Semantic Type, Data Type, Semantic Type.

Active Chart

The chart on which you are currently working.

Active Window

The window which is currently displayed. It is identified by a check mark on 
the Window menu. When windows are tiled or cascaded, it is the window 
with the highlighted title bar.

Alignment

The positioning of text or objects with respect to each other or to a reference 
point, line, or object. For example, the alignment of lines of text can be:

• left

• right

• center

Analysis Attribute

An attribute that is never displayed on a chart and is used solely to obtain 
information about chart items and their relationships to other items, for 
example, the number of links on an entity. Analysis attributes are created by 
Analyst's Notebook. They do not display on the chart but are useful for 
analysis.
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Ancestor

An item at a higher level in a hierarchy that is the basis for the next level 
below in a hierarchy.

In the example below, Property is the ancestor of Transport and Motor 
Vehicle. However, Transport is a child of Property because it is one level 
below.

See also: Child, Descendent, Parent.

Association Chart

Chart showing relationships between entities to illustrate how they are 
interconnected, rather than describing a chronology of events. For example: 
associations between individuals; transactions between accounts; calls 
between telephone numbers.

See also: Timeline Chart.

Assumed Semantic Type

The default semantic type that is used for an entity in the absence of a 
specific semantic type having been assigned. The assumed semantic type 
is based on the icon. For example, the icon Arson may have the assumed 
semantic type Crime.

See also: i2 Semantic Type, Semantic Type.
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Attribute

A piece of information that is associated with a chart item, such as date of 
birth or account number. It is represented by a symbol and/or value 
displayed with the chart item.

Attribute Bar

A special type of toolbar that allows you to add attributes to chart items and 
find chart items with a specific attribute value assigned to them.

Attribute Class

Characteristics of a specific attribute, including the type of its value, how it is 
displayed and the treatment of values when merged or pasted.

Attribute Entry

An attribute class together with a value. Attribute entries appear in palettes.

Attribute Instance

A single use of an attribute on a chart item. For an individual chart item there 
can be only one value for a particular attribute class. The display 
characteristics are controlled by the attribute class.

Attribute Type

An indication of the type of value which can be represented by an attribute. 
The four available types are Flag, Text, Number, and Time.

Auto Save

The ability of the application to save automatically a copy of your work on a 
regular basis. In the event of a power failure or abnormal closure of the 
application, the last automatically saved copy of your work is recovered 
when you restart the application.

Auto Scroll

The automatic vertical or horizontal movement across a window that occurs 
when you move or add a chart item close to the edge of the window.

Automatic (or Auto) Attribute

An attribute automatically created and assigned to chart items by the 
application. These attributes appear in the Attribute Classes page of the 
Chart Properties dialog with a yellow background.

Back Up

To copy data for safe keeping. For example, to copy a file onto a CD.
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Background

A frozen layer of a chart behind other chart items forming a backdrop. In 
general, you cannot perform chart operations on chart items in the 
background.

See also: Foreground.

Background Item

An item placed in the background of a chart. In general, you cannot perform 
chart operations on chart items in the background.

Bitmap

A graphic composed of dots or pixels. A chart copied in this format can be 
pasted into a drawing program such as Microsoft Paint.

Box

An entity typically representing organizations or groups on the chart. It is 
often used to enclose other entities.

Card

A record of information attached to a chart item.

A chart item can have zero, one or many cards.

Case

Descriptive text used to categorize a particular investigation. Case is one of 
the custom properties.

Chart

A visual representation of real-world objects, such as organizations, people, 
events, or locations, and the relationships between them.

Chart Item

The representation of an entity or association between entities.

Chart Item Label

The text associated with a chart item.

Chart Properties

The chart definition of properties such as document summary, time zone, 
grid size, background color, and merge & paste rules. These properties are 
saved with the chart.
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Child

An item that derives from the next level above in a hierarchy. A child is more 
specific than its parent. For example, the Cell Phone semantic type is a child 
of the Phone semantic type.

See also: Ancestor, Descendent, Parent.

Circle

An entity that is used as an alternative to an icon to represent information on 
the chart.

Clash

The name given to a link and attribute to signify that an entity charted from a 
database conflicts with another entity already on the chart.

Classification

The text used to describe the confidentiality of the content of a chart or 
document. Classification is one of the custom properties.

Clipboard

A Microsoft Windows temporary store for data you have copied or cut from a 
Windows application. It is used to transfer information between charts or 
between applications.

Cluster

A group of entities that is more interconnected within the group than to other 
entities.
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Cluster Members

The entities in a cluster and the links between entities in the same cluster.

Column Separator

A character that separates a column of data in a file or clipboard read by the 
Import Editor. This may be a tab, a space, or any specified character.

Comment

A record that you want the Importer to ignore.

Connection

The association between a pair of entities on the chart, represented by one 
or more links.

Connection Style

The way in which the number of links is represented in a connection. There 
are three connection styles: single directed multiple 

See also: Single Connection, Directed Connection, Multiple 
Connection.

Controlling Item

A chart item that defines the position of its date and time on the chart. A 
controlling item has a fully specified date and time and is also ordered.

See also: Ordered Item, Dated and Timed Item, Free Item.

Corner

A small dot placed on a link to divide the link into straight-line segments. A 
corner allows you to bend a link to improve your chart appearance and 
prevent overlapping of items.

Cover Sheet

A page that allows you to view and edit the summary properties of a chart, 
such as title, subject and author, and custom properties, such as case or 
classification.

See also: Custom Properties, Summary Properties.
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Custom Properties

User-defined information about a chart and its contents, which is not 
covered in the summary properties. Custom Properties can be viewed and 
edited using the Cover Sheet, and printed in the header and footer of your 
chart.

See also: Cover Sheet, Summary Properties, Case, Classification.

Custom Semantic Type

A semantic type that has been created in addition to those types in the i2 
Semantic Type Library.

See also: Semantic Type, i2 Semantic Type.

Custom Semantic Type Library

A collection of semantic types that are not in the i2 Semantic Type Library, 
typically defined by someone in your organization. Custom semantic types 
are stored in an .mtc file.

See also: i2 Semantic Type Library.

Data Column

A basic item of data manipulated by the Import Editor. The treatment of each 
column in a data file is defined by an Import Specification.

Data Provider

An organization providing or owning one or more data sources.

See also: Data Source.

Data Record

A record that is attached to a chart item that contains information from a data 
source.

Data Source

A source of data accessible using an i2 product. It can come from a 
database, files or any software route that can deliver data.

See also: Data Provider.

Data Type

A classification of a property semantic type to identify the particular kind of 
data the semantic type represents, such as a Number, Text, Date & Time, 
and Flag (Yes/No) value.

See also: Abstract Semantic Type.
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Database Identity

An identity, used by the application, to identify whether or not two entities on 
a chart that originate from the same database should be regarded as the 
same.

Date and Time Attribute

An attribute that can have a value of a date and time.

Date Format

The way that a date is represented for input and display.

Dated and Timed Item

A chart item with both a date and time.

See also: Free Item, Ordered Item, Controlling Item.

Default Style

The style used for new items as they are added to the chart.
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Descendent

An item at a lower level in a hierarchy that inherits its properties from 
something at a higher level.

In the example below, Transport and Motor Vehicle are both descendents of 
Property. However, Transport is also a child of Property because it is one 
level below.

See also: Ancestor, Child, Parent.

Description

A property of a chart item, providing a detailed explanation of the 
information represented by the chart item.

Directed Connection

A connection in which all links in the same direction are represented as one 
on the chart. The possible directions for the link lines are: 

• No direction

• Entity A to Entity B

• Entity B to Entity A

• Both directions

See also: Connection Style.
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Diverted Theme Line

A theme line attached to an event frame such that when the event frame is 
moved, it maintains its vertical position with the event frame.

Diverting Event Frame

An event frame linked to a theme line that causes the theme line to change 
its vertical position.

Docked [Window]

A window, such as a toolbar, that is fixed in position relative to the 
application window.

See also: Floating [Window].

Drag Handle

A small square that appears at the edge or corner of an event frame, box, 
OLE object, circle or text block when you select it. A filled handle may be 
dragged to resize the item.

Drop-down List

A list accessed from a dialog, from which you can select one or more items.

Entity

A set of details held in the application about a real-world object such as a 
person, location, or bank account.

Entity Semantic Type

A semantic type that can be assigned only to an entity or entity type.

See also: Semantic Type, i2 Semantic Type, Link Semantic Type, 
Property Semantic Type.

Entity Type

A category of like entities, for example organization, car, document, person 
or telephone.

Event Frame

A chart item representing a happening.



Glossary

i2 Analyst’s Notebook 8 User Guide: Creating Charts 347

External Data

Information that has been retrieved via a connection to a data source.

See also: Data Provider, Data Source.

Fan Size

The angle at which several links between two entities emerge from and 
travel into those entities.

Flag Attribute

An attribute that can have a value of YES or NO.

Flat Look Mode

A mode that affects the appearance of the toolbars when the application is 
run on earlier versions of Windows, such as Windows 2000. Flat look mode 
gives toolbars the appearance of being flat rather than raised.

Floating [Window]

A window, such as a toolbar, that can be freely moved within the application 
window.

See also: Docked [Window].

Foreground

The active part of a chart. You can perform all chart operations on items in 
the foreground.

See also: Background.

Free Item

A chart item that has no order. You can move free items anywhere on the 
chart.

See also: Dated and Timed Item, Ordered Item, Controlling Item.

Grade

A rating (typically a letter or number, for example A1) that can be used to 
indicate the accuracy of a piece of information and the reliability of the 
intelligence source.

Grading System

The use of a scale of code ratings for classifying the probability and 
reliability of intelligence for a document mark up, data or chart item; for 
example, the 4 x 4, or the 5 x 5 x 5 grading systems.

See also: Grade.
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Grid

A feature that allows you to align chart items more easily on a chart. A grid 
can be displayed as rows and columns of dots.

i2 Semantic Type

A semantic type that is included in the i2 Semantic Type Library.

See also: Custom Semantic Type, Semantic Type, Semantic Type 
Library.

i2 Semantic Type Library

A collection of entity, link, and property semantic types. The purpose is to 
share these semantic types. There are two kinds of semantic type library: 
the i2 Semantic Type Library, and a Custom Semantic Type Library.

See also: Semantic Type Library, Semantic Type, Custom Semantic 
Type.

Icon

A pictorial representation of an entity.

Icon Shading

The ability to adjust the coloring of chart items and entity types that use icon 
representations.

Identity

A short textual description of an entity used to uniquely identify it in a chart.

Import

To incorporate information from a text file or the clipboard into a chart using 
the Import Editor or Import Manager.

Import Design

The blueprint that forms the basis on which data items are imported into a 
chart using the Import Editor.

See also: Import, Import Editor, Import Specification.

Import Editor

The tool used to create and edit an Import Specification.

See also: Import, Import Manager, Import Specification. 
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Import Manager

The tool used to run and maintain Import Specifications.

See also: Import, Import Editor, Import Specification. 

Import Specification

A definition of how Analyst's Notebook interprets a data file or data in the 
clipboard.

Label

(1) A chart item, displayed as text, typically used for annotation.

(2) The textual name of a chart item, which appears on the chart.

Layout

The automatic arrangement of chart items.

Legend

A key to the content of a chart.

Legend Entry

An item within a legend, for example an icon type and its description.

Line Strength

The display of a line represented by solid, dashed or dotted lines on the 
chart. Line strength is typically an indication of the quality of the information 
for a particular chart item.

Line Style

A combination of the strength, color and width of a line. This may apply to 
the border of an entity, a theme line or a link.

Link

An association between two entities. For example, an owner link between a 
person and a vehicle.

Link Area

The display area of an event frame that provides access to the links to 
diverted theme lines.
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Link Semantic Type

A semantic type that can be assigned only to a link or link type.

See also: Semantic Type, i2 Semantic Type, Entity Semantic Type, 
Property Semantic Type.

Link Separation

The distance between adjacent links in a connection.

Link Type

A category of similar links, for example Account Owner or Transaction.

Local Template

A template that is stored in your local template folder, typically on your 
computer's hard disk.

See also: Template, Workgroup Template, Standard Template.

Marker

A small triangle placed in the time bar to indicate a controlling item.

See also: Controlling Item.

Menu Bar

The horizontal bar across the top of the window which displays the menu 
headings.

Mergable

The name given to links to signify that an entity charted from a database 
could merge with two or more existing entities on the chart.

Merge

To combine two or more items into a single item. The merged item has 
properties (for example attributes and data records), which are an 
assemblage of the items that have merged.

Metafile

A picture file which may contain both bitmap and vector data. A chart may be 
pasted into another application as an OLE object or as a simple picture, 
depending on the settings in your Options dialog.

Multiple Connection

A connection in which individual links are represented as separate links.

See also: Connection Style, Directed Connection, Single Connection.
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Multiple Undo

The ability to reverse a sequence of user operations. 

See also: Redo, Undo.

Number Attribute

An attribute containing a numeric value.

OLE

The Microsoft Windows mechanism for transferring and sharing information 
between Windows-based applications. OLE stands for Object Linking and 
Embedding.

OLE Embedding

The incorporation of a copy of an OLE object within the chart. An embedded 
object is contained in the chart rather than referenced from it.

See also: OLE Linking.

OLE Linking

A reference to an external source representing the content of an OLE object.

See also: OLE Embedding.

OLE Object

An entity that has been created using another Windows-based application.

Online Help

Information about the program you are running, displayed in an extra 
window on your screen or as a pop-up window over the item you want help 
on.

Option

A setting that controls the behavior of the application. There are three types 
of option: application, chart and command. Application options apply 
throughout the application, for example which toolbars are displayed. Chart 
options are specific to a chart, for example grid spacing.
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Option [Button]

One of a set of alternative settings on a dialog that can be selected. Its 
selection status may depend on the status of other options within the dialog.

Ordered Item

A chart item whose position is maintained within a sequence. The 
movement of an ordered item is restricted such that it cannot be dragged 
beyond neighboring ordered items.

See also: Dated and Timed Item, Free Item, Controlling Item.

Palette

A container for entity types, link types, attribute classes and attribute entries.

Palette Bar

A window that displays the contents of a palette.

Palette Pane

A single portion of a palette bar that can contain entity types or attribute 
entries.

Pan

The vertical and horizontal movement across a window.

Parameter

A placeholder in a report specification, which is substituted for a specific 
value from the chart as the report is generated.
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Parent

Something that is the basis for the next level below in a hierarchy. A parent is 
more specific than its child.

For example, the Phone semantic type is a parent of the Cell Phone 
semantic type.

See also: Ancestor, Child, Descendent.

Paste Special

To copy information from the Clipboard into a chart, while maintaining data 
such as OLE information.

Path

Specific route between two entities on a chart, which may include 
intermediate entities.

Path Name

The full name of a file, including the hierarchy of folders in which it is located.

Pin

A small circle attached to a chart item that is used to indicate whether an 
item is Ordered (filled circle) or Free (unfilled circle). The visibility of a pin is 
part of a chart item's style.

Pixel

A single point on the screen. Pixel is short for picture element.
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Plug-in

An external software component that extends the functionality of the 
application.

Property Semantic Type

A semantic type that can be assigned only to an attribute class or to a 
property in a data record.

See also: Semantic Type, i2 Semantic Type, Entity Semantic Type, Link 
Semantic Type.

Proportional

A description of an area of chart in which the horizontal distances between 
items is in the same proportion to the time differences between them.

Rank

The relative position of results in a list, arranged in order of how closely they 
match the search criteria.

See also: Score.

Record

The text between record separators consisting of one or more fields in a text 
file to be read by the Importer. A record typically represents two entities and 
a connecting link.

Redo

To restore the last Undo operation performed by the application.

See also: Undo.

Reference Grid

A grid that appears on a printed chart, allowing references to be made to the 
location of items.

Regional Options

A Windows control panel that controls how numbers and dates and times 
are displayed on your computer.

Regular Expression

A syntax that describes a pattern of characters. For example: address[0-9]*

A regular expression provides an advanced method for searching for text 
patterns, such as optional characters, using the Find Text facility.
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Report

A textual description, generated by the application, containing information 
about entities, links, attributes and cards on a chart.

Reporter

The facility in the application used to generate pre-defined reports.

Representation

The form in which an entity is represented on a chart; for example, icon, 
event frame or theme line.

Reveal Hidden

A viewing mode that makes hidden chart items visible.

Score

An absolute value, used in Smart Matching, to indicate the probability of two 
entities being the same real-world object. The values range from 1 to 9, 
where 1 indicates a weak probability, and 9 indicates a strong probability.

See also: Rank.

Scroll Bar

A bar along the bottom or side of a window which allows you to move 
horizontally or vertically across that window.

Segment

Section of theme line. Segments can be Wiring Segments or Style 
Segments.

See also: Wiring Segment, Style Segment.

Selection Set

A set of chart items that were originally identified by being selected, and 
which can be selected again easily.

Semantic Matching

The capability to compare two entities or links to determine the extent to 
which they may be related, or refer to the same object in the real world.

Semantic matching applies various rules in making the comparisons. For 
example, it takes into account whether two items are of the same semantic 
type (such as Person) and that there can be spelling variations, for example 
Jim, James and Jimmy. Semantic matching can take these factors into 
account and provide a ranking for the similarity of items.
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Semantic Path

The position of a semantic type in the i2 Semantic Type Library hierarchy. 
For example the path for the HTML Extract semantic type would be 
Entity\Annotation\HTML Extract as it includes the full path from the root 
semantic type down through the library hierarchy to the semantic type:

See also: i2 Semantic Type Library.

Semantic Type

A category that defines the real-world meaning of the data and therefore 
how applications should interpret that data.

For example, Person is a semantic type that could be assigned to entity 
types such as Male, Victim, and Witness. The semantic type allows the 
application to understand that each of those entity types are a different way 
of depicting people in the real world.

The semantic types are organized into three hierarchies: 

• Entity semantic type

• Link semantic type

• Property semantic type
See also: i2 Semantic Type, Entity Semantic Type, Link Semantic Type, 
Property Semantic Type, Semantic Matching.

Semantic Type Library

A collection of entity, link, and property semantic types. The purpose is to 
share these semantic types. There are two kinds of semantic type library: 
the i2 Semantic Type Library, and a Custom Semantic Type Library.

See also: i2 Semantic Type Library, Custom Semantic Type Library.
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Semantics

The way in which i2 products can analyze and manipulate data according to 
its real-world meaning.

Single Connection

A connection in which all the links are represented as a single link, 
preserving the direction.

See also: Connection Style.

Smart Matching

To compare the information content of a pair of entities to determine if they 
are likely to represent the same real world item. The comparison uses 
semantic types to:

• gauge how much reliance to place on a piece of information for the 
purposes of identifying the entity

• ensure like information is processed appropriately 

• handle issues such as variants of names, spellings and phonetics
The results of a comparison is a score as to how closely the information 
content matches. For example Person Name: John SMITH, e-mail address: 
j.smith@somewhere.net, matches Name: Jack, Last Name: SMITH and e-
mail address: j.smith@.

Snapshot

A view of a chart, preserving the position of chart items and display scale.

Source Reference

An identifier indicating the origin of the information such as a document 
reference number.

Source Type

A description of the information supplier such as Officer, Witness or Record.

Standard Template

The template used by the application when creating new charts.

See also: Template, Workgroup Template, Local Template.

Status Bar

The bar at the base of the application window, which displays information 
such as the current action, or the status of a tool.
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Style

Visual properties of a chart item.

Style Segment

A portion of a theme line between adjacent items associated with the theme 
line to which you can apply color and strength.

See also: Wiring Segment.

Summary Properties

Standard information about a chart and its contents, which includes the title, 
subject, author, keywords and comments. Summary Properties can be 
viewed and edited using the Cover Sheet, and printed in the header and 
footer of your chart.

See also: Cover Sheet, Custom Properties.

Symbol

A small image that can be used as part of the attribute display.

Template

A container for all the properties that are required to produce a new chart or 
workspace by the application.

See also: Local Template, Workgroup Template, Standard Template.

Terminator

See Theme Line Terminator.

Text Attribute

An attribute containing a textual value.

Text Block

An entity represented on the chart as a rectangle with rounded corners 
within which the label is contained.

Text Box

An area of a dialog in which you can enter or edit text.
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Text File

Any file containing unformatted text. A text file can be edited using Windows 
Notepad, or referenced within an Import Specification in order to visualize its 
contents.

Theme Line

An entity represented as a line with terminating symbols and an icon. Theme 
lines are often used to provide a common thread to events.

See also: Timeline Chart.

Theme Line Extent

The distance between the beginning and end of a theme line.

Theme Line Icon

An image displayed on a theme line used to represent that theme line.

Theme Line Terminator

The symbol that is used at the beginning or end of a theme line.

Theme Line Wiring

The display of the way in which a theme line diverts from the horizontal to 
pass through event frames and travel between event frames.

Tick

A mark on the time bar indicating a specific time.

Ticking Rate

The frequency of ticks that appear on the time bar, which show the rate of 
time across a chart.

Time Bar

The display, using ticks and labels, of the time flow from left to right across 
the chart.

Time Format

The way that a time is represented for input and display.
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Timeline Chart

A chart or portion of a chart showing a chronology of events over a period of 
time. For example, a series of meetings occurring over several days, a set of 
transactions occurring over a period of time.

See also: Association Chart, Theme Line.

Toolbar

A set of buttons that allow you to carry out operations within the application. 
They provide shortcut ways of selecting commands.

Toolbar Area

The area below the menu bar in which toolbars can be docked.

Type

A means of classifying entities and links, for example account, car, and 
person. All entities and links have a type, which influences their appearance.

Type Icon

The icon used to represent an entity type. Type icons appear in many 
representations of an entity, for example theme line, event frame, icon.

Undo

To reverse the last operation performed by the application.

User Palette

A user defined palette containing entity types, link types, attribute classes 
and attribute entries.

Vector

Graphical data represented using lines.

Visual Search

A graphical search facility within Analyst's Notebook, which allows you to 
find entities and links according to their properties such as labels, types, 
attributes and interconnectivity.

Watch

An option to display how the Importer reads each record in the input as it 
updates the chart.
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Wiring Segment

The length of theme line between adjacent diverting event frames linked to a 
theme line for which you can control the height of the theme line.

See also: Style Segment.

Workgroup Template

A template which is stored in your workgroup template folder, typically 
somewhere on a network.

See also: Template, Workgroup Template, Standard Template.
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A

Activating hyperlinks  170

Adding
attributes  141
cards  122
custom chart properties  234
entities  22

when label is different to 
identity  88

event frames  24,  30
hyperlinks  169
icons  53

from a palette  54
legends  221,  222
links  51

corners to  115
direction to  49

OLE objects
embedded  165
linked  162

summary information  230,  231
text blocks  109
theme lines  204,  205
timed links  291
unordered chart items  296

Aligning
chart items  37,  38

Annotating a chart

labels  112
legends  221,  222

Arrowheads

adding to links  49,  98
reversing on links  50

Attribute Bar  142

Attribute classes  140
types

flag  140
number  140
text  140
time  140

Attribute entries  140

Attribute instances  140

changing the value  145
editing  146

Attributes
See also Attribute classes, 

Attribute entries, Attribute 
instances

adding  141
multiple  144
using the Attribute Bar  142

B

Borders  70

Boxes

adding to charts  101
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C

Cards  121

adding  122
card list  129
cards page  123
copying  129

text  132
to another application  138

list cards  134
report  135

moving to another item  131
properties

date & time  121
description of  121

description  121
grades  121
source reference  121
source type  121
summary  121

removing  131

Change representation  301

of a link type  312
of an association chart  310
theme line to icon  302

Changing display properties of 
multiple links  97

Changing the emphasis of a chart 
 301,  310

Chart items

aligning  38
controlling  285
free  283
highlighting  194
linking  48,  49
ordered  283
representation  304
spacing  38
unordered  284,  296

Charts
adding

boxes  101
cards  122
event frames  24

date & time  26
description  27
grades  28
identity  25

hyperlinks  169
icons  53
legends  221
links  48
multiple entities of the same 

type  79
OLE objects

embedded  165
linked  162

summary information  231
text blocks  109
text labels  112
theme lines  205

aligning chart items  37,  38
cards

copying text  132
list cards  134
removing  131
report  135

changing representation  304, 
 311

closing  71
copy chart command  151
copying cards  129
creating  20

based on a template  20
custom properties  33,  34
entities

changing the entity type  81
layouts  306

minimize crossed links  306
merging with different time zones 

 324,  325
navigating  43
new window  188
OLE objects

opening  168,  169,  170
opening

windows  189
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printing  65,  66
background colors  70
borders  70
choosing a printer  65
page boundaries  65,  68
page setup  65
theme line names  65
time bar  65

saving  32
after changes  34,  36
for the first time  33

sharing
in different time zones  328

spacing chart items  37
splitting windows  195
summary information  231
summary properties  33
tidying

adding corners to a link  115
minimize crossed links  306
moving theme lines  258

tiling  182
horizontally  182,  183
vertically  182

time zones  319
local  328

zooming  43
actual size  43
fit chart to window  43
fit height in window  43
fit selection in window  43
zoom in  43
zoom out  43
zoom to area  43

Closing

charts  71

Color

event frames
background text  156,  158
fill color  156,  157

Combined properties  97

Controlling chart items  285

Conventions

for identifying event frames  87
naming conventions  87

Copying

cards  129
text on  132
to another application  138

entire charts  151

Corners

adding to links  115,  309

Cover Sheet  32,  33,  34

Creating charts  20
based on a template  20
from a user template  20
from an empty template  20
from the Standard template  20

Custom chart properties  233,  234

Custom properties  34

D

Date & time

choosing a format  29
default style  29
description  48,  273
event frames  23,  26
formatted  48
time bar  203
time zones  317

Default styles

date & time  29
links

line strengths  107

Description
event frames  23

Description of date & time  273

Direction

links
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adding arrowheads  98
reversing arrowheads  50

Display

event frames  45
links  97

Displaying
time bar  268

Diverting

theme lines  250

Duplicating  276

entities  276

E

Editing

attribute instances  145,  146

Entities

adding  22
labels  112
when label is different to 

identity  88
duplicating  276
label different to identity  280
labeling  86
labeling and identifying  86
labels

font size  113
linking  82
representations  101

box  101
circle  101
event frame  22,  101
icon  101
OLE object  101
theme line  101

text blocks
adding to a chart  109
resizing  111

Event frames  22

adding  24,  30
date & time  26
description  27
grades  28

choosing
date & time formats  29
link types  246

color
background text  156,  158
fill  156,  157

display  45
editing labels  186
identity  25

conventions for  87
link area  259
linking  49

to icons  56
to theme lines  206,  244

linking automatically
to a theme line  244
to multiple theme lines  255

properties
date & time  23
description  23
grades  23
label  23
source reference  23
source type  23
type icon  23
type name  23

Extents

theme lines  217

F

Fill color

event frames  157

Finding

charts
using summary information 

 235
labels when zoomed out  220
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Index

Fonts
text labels  113

Free chart items  283

G

Grades  76

adding  76
to a link  48,  84
to an entity  76
to an event frame  23
to an icon  78

source reference  76
source type  76

H

Happenings  22
See also Event Frames

Help

what’s this?  125

Highlight  194

turn off  197

Hyperlinks

about  169
activating  170
creating  169

I

Icons

adding from a palette  54
adding to charts  53
linking

to event frames  56

L

Labels

adding to a chart  112
changing the font size  113
conventions

for identifying event frames  87
event frames  23

editing  186
is different to identity  280

Layouts

minimize crossed links  306

Leftmost

theme lines
extents  217

Legends  221

adding  222
moving  224
positioning  224

Link area

displaying  259

Link Bar  56

Link types
changing  246

Linking
automatically

event frames to theme lines 
 244

to a theme line  244
to multiple theme lines  255

entities  82
event frames to theme lines  206, 

 244
icons to event frames  56

Links  94

adding  48,  49,  51
multiple  95

adding corners to  115
arranging link labels  99
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changing the link type  246
connection styles

directed  94
multiple  95
single  94

direction
adding arrowheads  49,  98
reversing arrowheads  50

display
pin  295

display properties  97
multiple links  97
removing link labels  50

line strengths  107
link area  259
minimize crossed links  306
properties

combined properties  97
date & time

description  48
formatted  48

description  48
grades  48
label  48
source reference  48
source type  48

rearranging  116
minimize crossed links  306

timed  291
adding  291

Local time zone  328

Locating

report specifications  172

M

Marker symbols  267

Markers

overlap  267
symbol  267

Merging  179

automatically  180
charts with different time zones 

 324,  325
items from different charts  180
manually  185

Moving

timed links  295

N

Navigating  43,  190

See also Zooming
highlight tool  194
large charts  187
opening windows  189
viewing part of a chart  189

O

OLE objects  160
embedded  161,  165
linked  160,  162
linked versus embedded  162
opening  168,  169,  170

Opening
OLE objects  168,  169,  170
windows  189

Ordered chart items  283

Ordering  283

adding
unordered chart items  296

controlling  285
date and time and order  285
free  283
items on a chart  287
moving

timed links  295
moving controlling items  290
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no date and time, with order  283
no date, time or order  283
ordered  283
pins

displaying on links  295
unordered  284,  296
with date & time, no order  284

Overlap markers  267

P

Palettes  52
adding icons from a palette  54
choosing a type  52

from the palette bar  53
from the toolbar  52

Standard  52

Paths

report specifications  172

Pins  283

displaying on links  295
moving pinned items  289

Positioning legends  224

print  65

Printing  65,  66,  71

annotation  228
background colors  70
borders  70
choosing a printer  65,  67,  226
orientation  227
page boundaries  65,  68,  229
page setup  65,  69,  226
scaling  227
theme line names  65,  226,  228
time bar  65,  226,  228

Properties

cards
date & time  121

description of  121

description  121
grades  121
source reference  121
source type  121
summary  121

custom  33,  34
event frames

date & time  23
description  23
grades  23
label  23
source reference  23
source type  23
type icon  23
type name  23

links
date & time

description  48
formatted  48

description  48
grades  48
label  48
source reference  48
source type  48

summary  34

R

Rearranging links  116

Removing

cards  131
link labels  50
splits  199

Report  135

Report specifications

locating  172
running  174

Reporting  172

textual  174
viewing a report

in Microsoft Word  174
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Representations
change representation  301
entities  101

box  101
circle  101
event frame  22,  101
icon  101
OLE object  101
theme line  101

event frames  22
theme lines

adding  204

Rightmost

theme lines
extents  217

Running
report specifications  174

S

Saving charts  32

after changes  34,  36
for the first time  33

Search Bar

results  193
selecting  193

Segments
styles  213,  254

Source reference
cards  121
event frames  23
grades  76

Source type

cards  121
event frames  23
grades  76

Spacing

chart items  37

Specifications
report  172

Splitting windows  195
removing splits  199

Standard palette  52

Styles

theme lines  217
segments  213,  254
terminators  217,  218

Summary information

adding  230,  231
viewing  238

Summary properties  33

T

Templates

empty templates  20
Standard template  20
user templates  20

Terminators
theme line styles  217

Text blocks
adding to a chart  109
resizing  111

Text labels

adding to a chart  112
font  113

Theme lines

adding  204,  205
diverting  250
extent  217
linking

to event frames  206,  244
linking automatically

to event frames  244
reordering  258
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segment styles  213
segments  254
styles  217

terminators  217,  218
left  219

wiring height  249,  251
next event  249
previous event  249
theme line icon  250

Tidying
adding corners to a link  115,  309
aligning and spacing chart items 

 38
minimize crossed links  306
moving theme lines  258
rearranging links  116

Tiling charts  182

horizontally  182,  183
vertically  182

Time bar  203,  266
displaying  203,  268
interval band  266
marker band  267
marker symbols  267
overlap markers  267
tick band  267

Time zones  317
local time zone  328
merging charts  324,  325
of a chart  319
of chart items  320
sharing charts  328

Timed links  291

adding  291
moving  295

Toolbars

attribute bar  142
link bar  56

Tooltips  220

Type icon

event frames  23

Type name

event frames  23

Types

attribute classes
flag  140
number  140
text  140
time  140

U

Unordered chart items  284,  296

V

Version information

See also Summary Information

Viewing

cards
in Microsoft Word  139

labels when zoomed out  220
part of a chart  189
reports

in Microsoft Word  174
summary information  238

W

What’s this? help  125

Windows

splitting  195
removing splits  199

Wiring height  249,  251
next event  249
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previous event  249
theme line icon  250

Word, Microsoft

copying cards to  138
viewing reports in  174

Z

Zooming  43,  190

See also Navigating
actual size  43
fit chart to window  43
fit height in window  43
fit selection in window  43
viewing part of a chart  189
zoom in  43
zoom out  43
zoom to area  43
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